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Workflows

This guide concerns designing, using, and monitoring STEP Workflows in the STEP Workbench. Workflows are
managed within the workbench, though end users can access them via both workbench and Web Ul. For
information on configuring and working with workflows in Web Ul, see the Workflows in Web Ul section of the
Web User Interfaces documentation.

Workflows may be considered as a view or representation of real work within a company, allowing businesses to
manage and streamline the flow of tasks among varying groups, users, and system activities. A workflow definition
consists of a number of states that an object or task can be in at a given time, the legal transitions between these
states, and the events via which the transitions can be triggered. The flow being described may refer to an asset,
service, person, product, or other element that is being transferred from one state to another. For example,
introduction of a new product may involve work from a variety of business groups, such as Product Management,
Marketing, Creative, and Legal. Each group needs to interact with the product in some way, and likely have
differing sets of data required for this interaction. Some groups may not be able to do their work until another group
has completed theirs, while other groups may be able to act on the product in parallel.

The same principles apply for any other data types and any type of data maintenance. Regardless of the type of
data or process being handled, an object in a state represents a task that requires work. For instance, a user could
be required to populate a set of attributes, and when completed, manually trigger a transition from one state to the
next. Alternatively, an object could be in a state waiting for data from an external system, waiting for a background
process to complete, or waiting for a specific event elsewhere in the workflow or in STEP in general, and thus not
require any direct human interaction.

STEP Workflows are data-centric workflows, meaning that a workflow instance is defined as the relation between
a workflow definition and an object in the STEP database. An object can be in multiple workflows simultaneously,
and each instance will have no impact on the others (unless the workflow definitions include business rules to
create a relationship between various workflows).

On top of the basic STEP Workflow functionality, a number of additional features are available that make
workflows powerful tools for streamlining processes and ensuring data quality. These include, but are not limited
to, options to:

« Configure business rules to validate data, assign tasks, move tasks through workflows, integrate workflows
with other processes such as imports and exports, and more

« Configure data views specific for each workflow state, allowing each actor in the flow to focus only on the data
most relevant for their tasks

« Support both static and dynamic task assignment and ownership, ensuring that the right actor sees the right
task at the right time

« Design for sequential and parallel execution of tasks, streamlining work processes for maximum efficiency
« Setdeadlines and escalation actions, ensuring that tasks are completed in a timely manner

« Configure dashboards for snapshot monitoring and KPI reporting, allowing administrators to quickly view and
assess key data points across the entire workflow
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The supported workflow enabled object types are:

o Assets
« Attributes
o Classifications
« Entities
« Lists of Values (LOVs)
« Planned pages
o Products
« Publications
« Publication sections
While workflows can become quite complex, the basics are really simple, and it is possible to get a small functional

workflow up and running in a matter of minutes. This guide will begin with the basic material and work up to more
advanced topics.
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Getting Started with STEP Workflows

This portion of the material introduces the user to basic STEP Workflow functionality, including creating a simple
workflow and accessing tasks within it. More advanced material can be found in the Advanced Workflow Topics
section of the Workflows documentation, but it is recommended that users be well-versed in the introductory
topics before beginning advanced functions.

If you are new to workflows, it is recommended that you read the material in the suggested order, as topics build
upon one another.

However, if you are concerned only with the end user functionality (working with tasks in a workflow), as opposed
to designing and configuring a workflow, you may wish to skip directly to the Working with Tasks in Workflows
section of the material.

Suggested Reading Order:

Workflow Terminology

Workflow Privileges

Initial Setup for Workflows
Creating a Workflow

STEP Workflow Designer

Views and Mappings for Workflows
Working with Tasks in Workflows
Managing Workflows

© N bk wd -~
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Workflow Terminology
This defines a list of commonly used terms in regards to workflows.

Action Type of business rule that can be executed on arrival in a new state (on-entry), on exit from a

state (on-exit), or on the transition between two states (on-transition). Actions may modify data.

Assignee The user or group to which a task is assigned for work to be performed. User states can be
assigned directly to a named user or to a user group. When a state is assigned to a user group
the task is ‘offered’ to all members of that group. To perform the task associated with the state,
a member of the group has to claim the task. Once a task is claimed it is no longer visible in the
group task list; only the person who claimed the task is able to see it. A user may subsequently
release a task back to the group.

e ELCR I State in which the STEP system performs the required work and automatically progresses the
State workflow when the automated work is complete. Typically requires the use of at least one
business rule.

Business Automated activity that may implement customer-defined rules, such as validations, automatic
Rule updates, notifications, data-driven workflow routing, etc. Also see Condition and Action.

Condition Type of business rule that can prevent a transition from being taken when an event is
attempted. Within a workflow, conditions may only be executed on attempted transitions (e.g.,
before 'Proceed’ event is allowed, validate that all required data has been populated). A
condition may not change data.

Deadline Optional setting for time allowed for a task to be completed. If a deadline expires on a task it is
possible to perform an escalation.

=SB The action(s) to be taken when a deadline expires. Escalations require at least one business
rule to be configured, which is triggered by the escalation.

The name associated with a transition between two states, such as Proceed, Reject, or Accept.
When a task is completed an event is triggered to transition an object to the next state(s) in the
workflow. In most cases where there is just a single event, this is called 'Proceed’ but in some
cases there is a need to support different routing via different events (e.g., 'Accept’ or 'Reject’)
or a different name is chosen to add clarity (e.g., ’Approve’).

SHEIRS EIEEE The state within a workflow or a parallel cluster that is the last step of this workflow or parallel
cluster. A final state cannot have any outbound events as there are no available transitions from
the state. Note that for parallel clusters, final states are used to auto-progress the workflow
when all concurrent parallel clusters have reached their final state.
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LIHEIRSEIEE The first state that is activated within a workflow or within a parallel cluster of a workflow.

Task The work and/or action that must be completed within a specific workflow state (whether by a
user or via automation).

1SS HEEE Fields (attribute, reference, workflow variable) that are available within a specific state for the
system or a user to access (view and/or populate). Task fields may or may not be included in
the view.

Parallel A set of states that form a sequential branch of dependent states which may run parallel to
cluster other independent branches within the same workflow.

State A step within a workflow to which a specific user, user group, or system can be assigned to
complete the task(s) associated with the state. Also see User State and Automated State.

Transition The change of tasks from one state to another.

UEET S E1EE State that requires a user to complete a task before marking the state complete. May include
some automation that happens on entry or exit of the state, but requires a user to trigger the exit
from the state (indicating completion of the associated task).

The set of specific data points that are presented to the user in the STEP Workbench when a
task is selected. Views are configurable by state and are only applicable for user states that will
be accessed directly from the STEP Workbench. Views are not applicable for automated
states, and states accessed via a Web Ul have interfaces defined via the Web Ul configuration.
Within the STEP Workbench, users can still choose to use the full set of workbench data and
tabs to work on workflow tasks if desired (and permitted via privilege configurations). However,
a view can streamline work processes so that only a small subset of fields that are directly
relevant to the task / state are displayed.

Workflow Business process(es) modeled as a series of states and tasks that can be executed by users
and/or automatic processes within the STEP system. Workflows prompt the next step of a
process to be started, by either creating a task for a user, or sending an alert. Workflows may
contain a number of process steps or tasks, as well as business logic.

Workflow A temporary asset attached to a task, that does not exist outside of the workflow.
Attachment

Workflow A temporary data point (similar to an attribute value) attached to a task, that does not exist
Variable outside of the workflow.
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Workflow Privileges

There are a number of Setup Actions (privileges) directly related to STEP Workflows, both in terms of allowing
users to configure workflows and to work with tasks within workflows. In addition to workflow-specific privileges,
workflows also take into account general privileges. For example, if a user does not have access to a specific set of
objects or data points, they will not have access to them within a workflow either, unless specific access is granted
within the workflow.

For complete information on privileges related specifically to workflows, see the Workflows section of the Setup
Actions topic in the System Setup / Super User Guide documentation.

For information on editing general privileges to provide access to data or objects specifically within a particular
workflow state, see the Editing Privilege Rules section of the System Setup / Super User Guide
documentation.
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Initial Setup for Workflows

In order to create workflows in STEP, some basic configuration must first be completed. Specifically, the STEP
Workflow Type basic object type must have a Setup Group parent assigned, and a System Setup object of the
proper type must have been created to hold the workflows.

In most cases, this setup will already be complete on a system and is only required if a Workflows folder (or other
setup node enabled to workflow children) is not present on the System Setup tab, as shown in step 7 below.

The setup described below is only required to be completed once on any system, but may be carried out multiple
times if it is desired to separate workflows for organizational purposes.

Enabling a Setup Group for Workflows

1. Go to System Setup and select Object Types and Structures > Basic Object Types and verify that STEP
Workflow Type exists. If not, contact your system administrator for assistance.

(M) [ Object Types & Structures

rj Alternate Classifications

‘-.!:?J Assets

- [ﬁ’ Basic Object Types

EEI--%’ Attribute Group

EEI--{E’ Attribute Transformation
{E’ Business Action Type

{7 Business Condition Type
@ Business Library Type
{E’ Change Package

iﬁ‘ Setup Entity user-type root
- status flag type

~{Z STEP Workflow Profile Type

- {;# BTEP Workflow Type|

System Setup

Bookmarks

2. Right-click on Setup Group type root under Object Types & Structures to create a new New Object
Type from the context menu.

System Setup

Iﬁ‘ Publication group types
Iﬁ Publication section types
[+ Publication types
E}IE’ Setup Group :
{Eﬂ Change Pa (& MNew Object Type
{ﬂ’ Completenes
{ﬁ’ Ewvent Proces
%’ Gateway Enc
- Global Busine
{E’ Inbound Inte Paste
{ﬁ’ Integration E
{E‘ Match Codes # Delete

Update Object Type From

Copy

3. EnteranID and a Name, and click Create.
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=I-{z& Object Types & Structures
lﬁ' Publication types

=& Setup Group type root
i \ A
o E] Create Object Type ﬁ

B Workflows
Mame Workflows
Dimension Dependency [ Country

[] Language

I Create I Cancel

.

4. Returntothe STEP Workflow Type node in Object Types & Structures > Basic Object Types. In the
corresponding editor, select the References tab and select Add Parent to link this to the folder created for
workflows under Setup Group type root. This enables workflow objects to be created as children to the
Workflows setup group root.
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System Setup
= bict Type | (XL | Lo |

=-{Z Object Types & Structures
rj Alternate Classifications
-- Assets

= Basic Object Types

- Attribute Group

-G Attribute Transformation

& Objects of this Object Type

?
L2

* | Add Parent i

{72 Business Action Type
{72 Business Condition Type
~{72¥ Business Library Type

’
E] Select Mew Parent

Cronse |2

{E‘ Change Padkage
[#-{Z3 Collection Group
{7 Completeness Metric
{7 Context

-7 CP-Link-Type

{7 Event Processor
@‘ Gateway Integration Endpoint Tyg
-2 GD5N Data Pool Publisher

(-2 GDSN Data Pool Receiver

{7 GOSN Recpient

@‘ Inbound Integration Endpaoint Typ
- InDesign Document

.@‘ Key

-7 List O Values Group Type
{7 Match Code

%‘ Matching Algorithm

EI--{%‘ Setup Group type root i
[+-[;& Change Packages

- Completeness Metrics

lﬂ’ Event Processors

lﬂ’ Outbound Integration Endpoint:
=& Portals

Iﬁ‘ Status Flags

[ﬂ’ Uncategorized Setup Group Typ
[ Workflow Profiles

2

Select Cancel

~{7¥ Outbound Integration Endpoint T
{7 Planned Page

n 21 STEP Workflow Type

[-{zz Table Column Type Group
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5. To create the parent node for workflow instances to be created under, go to the Maintain menu, navigate to

Insert, and select Setup Group Root.
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=10

Link
Merge

¥ | Delete
Force Delete & Purge
Unlink Object Type

B Duplicate
@a DuplicateRecursively

Make Revision

Approval

Enable group for workflows

Revive

Revive Recursively

Truncate log...

Ctrl+]

tup Group Type

e —

HBEEEEScc-HBSw

o

Mew Publication...

Mew Publication Group

Mew Publication Section...

Mew Page Template ...
Orphan Attribute
Asset

Attribute

Attribute Group

List of Values
Dirnension
Dirnension Point
Workspace

Action Set

Mew Image Conversion Configuration...

Create Transformation Lookup Table

Mew Event Queue

Mew AssetPush Event Queue

Mew Business Condition
Mew Business Action

Mew Business Library

I[f‘.'i Setup Group Root... I

Ctrl+5Shift+0
Ctrl+Shift+4
Ctrl+Shift+T
Ctrl+Shift+I
Ctrl+Shift+L
Ctrl+Shift+D
Ctrl+Shift+M
Ctrl+Shift+W
Ctrl+5Shift+5
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6. Selection of Setup Group Root opens the 'Create Setup Group Root' dialog. Select the workflow object type

that was created in Step 3, enter an ID and Name, and click Create.
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Object Type

(71 Match Codes and Matching Algerithms
(71 Event Processors

(") Gateway Endpoint

(7 Global Business Rules

(7 Inbound Integration Endpoints

(7 Integration Endpeint

D Warkflows

Mame |Workflows

[ Create ] [ Cancel ]

b
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7. This creates a folder in System Setup that a user can then create individual workflows under by right-clicking

[ STEP Workflow ” Bookmarks ]w

and selecting Create STEP Workflow.

[1-[F5] Match Codes and Matching Algorithms
-5 Outbound Integration Endpaints

E Status Flags

5 Uncategorized Setup Group

(5] Web Uls

-5 Workflow Profiles

Warkfgme

..... [Z| Derived| Mew Setup Group...
EHE‘ Object | Mew Business Action

Mew Business Condition

E}[E' Bas Create STEP Workflowl

{E’ % Cut
%’ Copy
2B pase
o
iy

¥ Delete

m

#-C&| |3 StartBa ckground Process to Monitor Deadlines  Ctrl+5Shift+D

Ctrl+X
Ctrl+C
Ctrl+W
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Creating a Workflow

This topic describes how to create a basic workflow, which requires the following steps:

Create a new workflow

Create states in a workflow
Create transitions between states
Add events to transitions

Set assignees

Set validity

7. Setworkflow options

L

Each of the steps is described in detail below, guiding users through the creation of a simple workflow, as shown
below.

Sample Workflow [SarﬁpleWurkﬂnwEstate] B

Start
Proceed Reject

Do Waork (&

y

Progeed

Finish

H{

In addition, a new workflow can be created via duplication of an existing workflow, so that topic is also covered in
this section.

Prerequisites

In order to create a workflow, the system must first have a place established to house the workflow. This setup
only needs to be completed once on any system, and is likely to have already been completed. However, if the
System Setup tab does not have a folder that allows workflow children (as shown in the Step 1: Create a New
Workflow section below), then this initial configuration needs to be completed before any workflows can be
created. The steps for the configuration are detailed in the Initial Setup for Workflows topic.

Preconsiderations

Steps 1 - 3, and step 5, of workflow creation must all be completed in a single session in order to save the workflow
configuration. Therefore, care should be taken during initial configuration to ensure that the steps can be
completed and work is not lost.

Each of the items below must be true in order to save a workflow configuration:
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« A unique ID must be specified for the workflow
« There must be an Initial and a Final state on the outer level
« All states must be reachable (e.g., there must be at least one incoming transition for each state)
« State IDs must be unique within the workflow
« All states must have an associated assignee, or a default assignee must be assigned to the workflow

Step 1: Create a New Workflow

1. Right-click the folder established to house all workflows, and select Create STEP Workflow.

I'i"'l Match Codes and Matching Algorithms

I'i"'l Cutbound Integration Endpoints =
-7 status Flags

-[£5] Uncategorized Setup Group

(2] Web Uls

-(5] Workflow Profiles

+-[75] Workflowe

..... | Derived | (21 Mew Setup Group...
E‘%’ Object Mew Business Action

Mew Business Condition
El[ﬁ' Basl B Create STEP Workflowl
- 3| Start Background Process to Monitor Deadlines  Cirl+Shift+D

& Cut Chrl+X
Copy Ctrl+C
Paste Ctrl+V

[ STEP Workflow ” Bookmarks ]

X

Delete

LRRRER

Xl
H [ ) H

2. The STEP Workflow Designer will open. Additional information about the designer can be found in the STEP
Workflow Designer topic. For now, enter an ID and Name for the workflow.

E! STEP Workflow Designer - SampleWorkflow

File| Edit View
Warkflow Properties

D SampleWorkflow

Mame | Sample Workflow|

At this point, a 'container' has been created, to which states and transitions must be added to build the actual
workflow.
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Step 2: Create States in a Workflow

A state represents an assignment to be completed, whether by a human or a system. When a new workflow is
created, it must have a single initial state at the outermost level, which is where any task entering the workflow will
begin. In addition, a single final state must be present at the outermost level to indicate completion of the workflow.
The indication of 'initial' or 'final’ for a state is considered a characteristic of the state. States can also have 'parallel'
or 'cluster' characteristics, which are required when workflows have parallel states and/or when a set of states
should be grouped together within a workflow (comparable to a mini-workflow within the overall flow).

For this example, we will create a basic workflow using three states: an initial state, a standard state, and a final
state. However, further descriptions of state characteristics, including more complex examples using parallel and
cluster states can be found in the State Characteristics in Workflows topic of the Advanced Workflow
Topics documentation.

1. Tocreate the Initial State, right-click the canvas area and select Add > Initial State from the menu. The
Initial State is the first state that any object started in the workflow is placed into.

E] STEP Workflow Designer - SampleWorkflow®

File Edit View
Workflow Properties =
1D sampleWorkflow
3
Mame |Sample Workflow [ Add State
] Initial State
Workflow Variables/&tachments %] Edit Workflow _
Final State
Recursive Auto-Layout Cluster State
Auto-Layout Parallel State

2. Inthe State Editor that appears, type the desired ID and Name of the state. Make sure that Initial under
Characteristics is checked, and close the dialog box by clicking the X" in the top right corner.

E] State Editor lﬁ

Edit

State |Dr1 Entryll:ln ExitlAssigneeIDeadIinefEsmlaﬁunlCummentslPurEl Screen Mapping Mandatory Attribute.ei

ID Start
Mame |Start]

rCharacteristics
Initial
[ Final

[ Cluster

[ Parallel
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Note that IDs can be revised as needed before the workflow is saved. However, because workflow business rules
are tied to state IDs, all state IDs are locked upon saving of the workflow.

State names are editable at any time, and can also be localized, allowing users to see differing names for the same
state based on locale. More information on this can be found in the Localizing Workflow State Names and
Events section of the Workflows documentation.

3. Create a second state by right-clicking the canvas and selecting Add > State.

I [ Add L4 State
] Initial 5tate
% Edit Workflow
Final State
Recursive Auto-Layout Cluster State
Auto-Layout Parallel State

No Characteristics need to be checked in the State Editor dialog box for states in between the Initial and Final
States.

Sample Workflow (SampleWorkflow)

Start
______ .D e _g
] Do Work =
o - F*] state Editor
Edit
on |
State

ID DoWork
Mame |Do 'l."'.n'c-rk|

- Characteristics
Initial

Final
Cluster

Parallel

4. Forthe last state, right-click the canvas area and select Add > Final State. In the State Editor box, fill in the ID
and Name accordingly, making sure that Final is checked under Characteristics. Close the dialog. The
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workflow should now appear as pictured below.
Sample Workflow (SampleWorkflow)

Do Woark

Finish

You have now created a basic workflow with three states. However, in order for tasks to be able to move through
the workflow, transitions must be added between the states.

Step 3: Create Transitions Between States

Transitions are needed between states in order for the workflow to be valid. Each state (with the exception of final
states in the outer level) should have at least one transition to allow tasks to proceed through the workflow. States
may have more than one transition, meaning there are multiple options for exiting the state. For example, users
may need the option to move a task to a subsequent state in the workflow, as well as returning it to a previous state
(e.g., to proceed or reject).

1. Hover over the center of the Initial State so that the cursor changes into a hand icon and a green box appears
around the state. Click and drag to the center of the next desired state until a green box encircles that state.

Release the mouse click to create the transition, which is then displayed as an arrow between the states.

2. Repeat step 1, but going in the opposite direction (e.g., click the second state and drag to the first).
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Now there are two transitions going in opposite directions in the workflow. This allows objects to progress
forward in the workflow if approved or to be rejected and sent back to a previous state if needed.

3. Though they appear as a single arrow at this point, each transition is actually unique, which can be seen by
adding corners to each transition. To do this, right-click on the arrow and select Add Corner.

%] Edit Transition

¥ Delete

Add Corner

A green box will appear on the transition.

Click and drag the box to the right or left.

4. Repeatthe above steps to add a corner to the other existing transition, and to add a new transition between the
second and third states. When complete, your workflow should appear as shown below.
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Sample Workflow (SampleWorkflow)

"
"
"

Do Wark

Finish

&
il
T
",
%,
%,

Step 4: Add Events to Transitions

While not strictly necessary, adding events to transitions can increase usability of workflows as the event names

are displayed to the end users. When a meaningful event name is applied, it provides an indication to the user of

what is occurring when they select to Submit a task in the workflow. When multiple transitions are present from a
single state, it is especially useful to have events applied so that a user can choose which selection to make (e.g.,
Proceed vs. Reject).

Events also enable advanced workflow options, such as applying business rules and logic to specific events. More
information on advanced functions is available in the Advanced Workflow Topics section of the documentation.

To add an event to a transition, follow the below steps.

1.

Double-click the transition, select the Events tab in the Transition Editor dialog that appears, and then click the
Add Event icon button. Name the event accordingly and click OK.

. .
-~

E] Transiticn Editor

o
[—D‘u@ Edit
| Events |Cur1ditiur1|Dr1 TransiﬁunlMandatgry nth'ibutesl .
! Add New Events E] Add Event @ -
Finish Event | proceed
o 34
> [ oK ] [ Cancel ]

Note that if a space is put in the event name, the Designer will automatically replace the space with an
underscore within the editor. However, when the event is displayed to end users in the workbench or Web Ul,
the underscores will render as spaces.
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2. Additional events can be added to the same transition, which can be useful when adding business rules to a
workflow. However, for this simple example, we will use only one event per transition so the Transition Editor
should be closed by clicking the X in the upper right corner. Once closed, event names can be dragged on the
canvas to improve visibility if needed.

3. Repeat the above steps to add an event to each remaining transition, resulting in a workflow comparable to the
one shown below.

Sample Workflow (SampleWorkflow)

Start

Proceed Reject

H

Do Work

Progeed

Finish

Hﬁ

Note that multiple events within the workflow may have the same name.

You have now created a basic workflow, but in order to make it valid (which is required to enable saving of your
work), an assignee must also be specified for the workflow.

Step 5: Set Assignees

Each state in a workflow requires an assignee to be set, regardless of whether the state represents a human task
or not. The object-in-state relation must always be assigned to a STEP user or user group. This can be done one
of two ways: individual assignees to each state or a single assignee to the overall workflow. If states do not have
an assignee defined locally, they will by default always inherit the assignee defined by the workflow.

As the primary purpose of workflows is to assign tasks to varying actors in a controlled manner, each workflow
state that requires human interaction will generally have a different assignee (rather than using the workflow
default). In contrast, states that represent a system action or an automated state will often use the workflow
default, which can be set to an administrator user group.

Note: Users that do not have the STEP Workflow Administrator privilege will only be allowed to see tasks
assigned to themselves or a group they are member of.

There are several options for setting assignees in a workflow, including to set assignee dynamically based on
information on the object or previous actions taken in the workflow. For this example, the basic functions of
specifying a user or group assignee are described. More advanced assignee options are described in the
Assignees in Workflows section of the Advanced Workflow Topics documentation.

Once assignees have been set, the workflow should be saved:
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£+ STEP Workflow Designer - ¢
Edit View

i Export..

Save

Save and Bt
Exit achments

aw

oW

Set an Assignee for a State

All states with user interaction should have an assignee specified. To set the assignee locally for a state, double-
click the state, select the Assignee tab in the State Editor dialog that appears, click the Select User / Group
radio button, click the ellipsis button (-..]) to open the Assignee Selection dialog, select a user or user group, click

Select to close the selection dialog, then click the X in the upper right corner to close the State Editor dialog.

I !

Procéed Reject
3 e

s

cflossa e ea—siate Fo

E] State Editor E|

Edit

Comments I Web UI Screen Mapoi Mandatory Attributes
State | OnEntry | OnExit Assignee Deadiine/Escalation
() Workflow Default
Assign Task to the default Assignee spedfied for the Workflow

e i@ Select User /Group E] Q%E
Assign Task to selected User or Group p i

Finish

(™) Fetch from Variable £] Assignee Selection @
Assign Task to User or Group read from W Search |

(7 Executing User [#-<% Brand

-~
Assign Task to the User performing the Tra @ 6 |i|

[+-<% Buyer Group
I < AP S .
1| 1] [ 3

- Details

GSelect H Cancel

When a user group is selected, all users in that group can access tasks in the state. When a specific user is
selected, only that user (or a workflow administrator) can access tasks in the state. It is most common to assign
states to user groups rather than to individual users so that tasks can continue to be processed even if a specific
user is unavailable, for example when sick or on holiday.
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When a state has an assignee, the letter 'A’ with a circle around it will appear in the state:

If the assignee indicator does not appear, go to the View menu in the STEP Workflow Designer and check the
View Content Indicators option.

E] STEP Workflow Designer - SampleWork
File Edit

Workfiow | v View Content Indicators

The above actions can be repeated until an assignee has been designated for each state in the workflow.
Alternatively, an assignee can be set for the complete workflow. When each state has an assignee (via individual
assignment or the workflow default), the workflow can be saved via the Save option on the File menu.

Set an Assignee for the Workflow

In order to save a workflow, all states must have an assignee specified. All states that do not have an assignee
explicitly specified will inherit the workflow assignee. Therefore, it is often helpful to have a default assignee
specified to ensure that the workflow can be saved at any point. In addition, it is common to use the workflow
assignee for states that are automated and/or the work occurring in the state is done by the system rather than a
user as in these cases the assignee is not a meaningful designation. Typically the default workflow assignee will be
an administrator user or group.

To set the default assignee for a workﬂow, double-click the title bar of the workflow, click the Select User / Group
radio button, click the ellipsis button (|...) to open the Assignee Selection dialog, select a user or user group, click

Select to close the selection dialog, then click the X in the upper right corner to close the State Editor dialog.
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»

aal

T
Sample Workflow (SampleWorkflow) o

r e
3 Workflow Editar @ Create
i prippet
— Brippet
Assignee | Status Flags [r—
Workflow Default
Assign Task to the default Assignee spedified for the Workflow 3 -
9& Select User/Group E] 91
Assign Task to selected User or Group
Fetch from Variable
Assign Task to User or Group read from Workfl E] Assignee Selection @
(") Executing User Search |
Assign Task to the User performing the Transit] @ o
-- Suppliers
o % s i
[+-<%h User Group E
[ Show Edited State @ Warehouse Group S
a8 Wik 1T Rroain a
1| 1] | 3
== Details
e Select ] [ Cancel ]

When each state has an assignee (via individual assignment or the workflow default), the workflow can be saved
via File > Save.

Step 6: Set Validity

Before a workflow is fully functional, it must be made valid for the object type(s) that will use it. For example, if a
workflow was made specifically to review and approve packaging objects and data, it might be made valid for
Each, Box, Carton, and Case.

To set validity, select the workflow from the System Setup tab, click the Validity tab, and check the appropriate
object type(s). Any number of object types can be selected within the same flipper.
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System Setup
P Normal » ||| ster workflow Editor | [EELLLaN | Loa || Status
EE}-- Order Process & valid for e T
Paage Planner Flow - —
Pen Workflow Valid for Classification Types
Pen Waorkflow Two = valid for Entity Types
Product Awaiting Asset = valid for List of Values Types
13| Publications - Valid for Asset Types
. Publication Sections & Valid for Product T
|13 . Sales Item Creation
|13 . Sales Item Creation - ariginal [] AN
EE}-- Sample Workflow Box
[+ 12| Sample Workflow(Z il
Saﬂem{{;shm] [ Business Unit Root
EE}-- Shipment COrder Process 3 [C] Buy Side
test — Carton
[ WF_Adding_Logic
(] WF1 Case
Workflaw3 il [] Discontinued Products
=TT
a4 m | P Each

Note: Workflows can be made valid for several object types, but only types of the same 'super type.' As an
example, you could make a workflow valid for the object types 'Shipping Address' and 'Main Address' of the super
type 'Entities’, but not also for 'Building Photo' of the super type 'Assets.'

Step 7: Set Workflow Options

The final step in creating a workflow is to set the options available on the STEP Workflow Editor tab. These
settings are not required to be changed, but they provide valuable options for governing the behavior of the
workflow and should be considered as part of any workflow design.
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System Setup < Sample Workflo
[+-[33] Item Creation i Valicity || Log || Status

[+-[$3] Lead Pipe Plumbing Check Mame | » alue
-] Lead Pipe Plumbing Check 3
o ﬁIL m g > ID SampleWorkflow3state
0 Low
[ MultiLineMsg Workflow > Name Sample Workfiow
[+ ] My Workflow > Revision 0.5 Last edited by USERE on Mon Jul 18 11:14:34 EOT 2016
E,] Nermal » [nitiate automatically
[#-| 3] Order Process _ -
B Page Planner Flow » Listen on updates from import [
E Product Awaiting Asset > Use executing user's write privileges [
5 Publications » Disable transitions on terminated Workspaces [
--[13] Publication Sections £ > Etart Condit
= rt Condition
[+ 3] Sales Item Creation

[]--El Sales Item Creation - original T Used Local Business Rules
[]--E Sample Workflow Title > |5tate » STEP Workflow Compon... » [Description »
B e o e e

5 Fonpl vioro] . .
[+ 3] Sample Workflow(2) " orkf _—

— > » W » >
- 1’3|Shi|:|ment Order Process i Title State STEP Workflow Compon... * |Description

1 I 3 4

Initiate automatically - If checked, objects of the specified validity for the workflow are automatically initiated into
the workflow upon creation. This option is only applicable for object types for which instances of the objects can
exist in the Tree (e.g., products, classifications, assets, entities, publications, publication sections, or planned
pages, but not for attributes or lists of values). This is useful for onboarding / creation workflows that are intended
to process new objects as the objects are automatically placed in the workflow upon creation, without any manual
initiation required.

Listen on updates from Import - If checked, the system will listen for updates on objects of the type specified by
the validity of the workflow and take action as needed. Specifically, an object can be transitioned from one state to
another upon update of the object via import. This is especially useful when completion of a workflow requires
information from another source system. As soon as that information is received, the task can be automatically
sent to the next state in the workflow. This function is only available for assets, classifications, entities, and
products and requires additional configuration to enable. Complete configuration is described in the Triggering
Workflow Events from Imports section of the Advanced Workflows Topics documentation.

Use executing user's write privileges - Option related to the execution of business rules in the workflow. If
selected, a user triggering the execution of a business rule will be prevented from making any changes or
accessing any data in the system via the business rule that he / she is not normally privileged to. For example, if the
user is not privileged to change a certain attribute value on an object, and the business action is configured to
make such a change, a privilege exception will be thrown and the action will not be carried out. Caution should be
used with this option as it can prevent desired business rules from being carried out and/or result in errors that the
business rule should be written to handle gracefully. If the option is not checked, business rule are run with full
access to carry out all indicated rules.

Disable transitions on terminated Workspaces - If selected, it will not be possible to perform transitions in
terminated workspaces (e.g., the Approved workspace). Typically this option should be checked as it will prevent a
user from submitting objects while in the Approved workspace. This is important as data cannot be modified in the
Approved workspace, submission of a task to a state often involves business actions, and workflow actions are
executed from the current workspace. Therefore, if a user is viewing data in the Approved workspace and
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attempts to submit an object from a state where submission involves the use of a business action, the user will
receive an error. Checking this option makes the submission unavailable, and therefore prevents the user from
receiving an unnecessary error.

Start Condition - Option available to specify a business condition that needs to be fulfilled before the workflow
can start. For example, if some basic data is required to be populated prior to initiation, a condition can be selected
to ensure that the required data is present. If the condition is not met (e.g., does not evaluate to true), the object will
not be allowed to enter the workflow.

Important: If users will be working with tasks within the workbench (rather than Web Ul), views and mappings
should also be configured following creation of the workflow. Instructions for this configuration are available in the
Views and Mappings section of the Getting Started with STEP Workflows material.

Duplicate a Workflow

Another way to create a workflow is to duplicate an already existing workflow. While there may be a number of
reasons for duplicating an already existing workflow, some of the reasons may include:

« The need to make changes to a workflow already in use. In duplicating the workflow, it is possible to make
changes to the new workflow and test these changes while still leaving the old workflow intact.

« The need to create a new workflow similar to an existing workflow.
Duplicating a workflow will result in the basic workflow structure and associated business rules being copied.

However, the global workflow options (Step 7 in the previous material) will not be copied and should be set
manually on the duplicated workflow. In addition, workflow-specific privileges are not carried over in a duplication.

To duplicate an existing workflow, go to System Setup and right-click on the desired workflow for duplication.
Select Duplicate. In the dialog that appears, populate the ID and Name, and click the OK button. The 'Duplicate
references' option is not applicable for workflows and can be left checked or unchecked.
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ID Workflow4Copy

-

& B8] Flatplanner Name |workflow 4 Copy
(3] wr1
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- Object Types % cut -
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STEP Workflow Designer

This topic provides an overview of the STEP Workflow Designer, including descriptions of the various sub-editors
and visual indicators within the designer. It is intended to orient you with the interface and provide general
information for where to accomplish things in the designer, rather than to complete any specific task itself. When
applicable, links to more detailed task-oriented materials are provided.

Prerequisites

It is expected that the reader is familiar with the Creating a Workflow topic.

Overview
The STEP Workflow Designer has the following primary areas:

Properties panel for setting ID and Name

Area for defining Workflow Variables/Attachments
Area for displaying Validation errors and warnings
Overview / zoom area

o s~ b=

Canvas where States and Transitions are defined
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33 STEP Workflow Designer - ltemEnrich

File Edit View
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StatusFlagFinish! e —
StatusFlagStart’ abe '|
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Dialogs within STEP Workflow Designer

There are a number of dialogs that have many additional options and features that aid users in editing workflows.
Each dialog and the general functions of the included tabs are described below.

Workflow Editor

To edit in the Workflow Editor, double click the canvas region. The workflow editor is used to make changes that
are global for the workflow, including setting the default assignee for the workflow and enabling status flags for the
workflow.
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33 Workflow Editor

{ Assignee | Status Flags

Waorkflow Default

Assign Task to the default Assignee spedfied for the Workflow

(®) Select User /Group Super Users (Super user)
Assign Task to selected User or Group

Fetch from Variable

Assign Task to User or Group read from Waorkflow Variahle.
(") Executing User
Assign Task to the User performing the Transition into the current State
Advanced

Show Edited State

Tab Available Functions

Assignee Tab Modify the assignee for the entire workflow. See Workflow State Editor Assignee Tab
Options.

Status Flags Status Flags can be added and removed. See Status Flags.
Tab

State Editor

The State Editor is launched when the user right-clicks on the canvas to add a state, or when a user double-clicks
on an existing state. This editor enables users to make changes specific to a particular state.
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32 State Editor

Edit
Deadline Escalation Comments Web UI Screen Mapping Mandatory Data
State On Entry On Exit Assignes

ID State-2

Mame |Enrich
-Characteristics

] Initial

[]Final

[] Cluster

[ ]Parallel

Show Edited State
Tab Description
Assignee Assignees can be added / removed / modified per state. See Assignees in
Workflows.

Comments Comments can be added / removed / modified. Comments have no explicit function and

are not viewable outside of the designer. However, they can be useful to make notes for
designers regarding a particular state (e.g., intended function, considerations when
modifying, etc).

Deadline/Escalation | Setdeadlines and add / modify / delete associated escalation business rules. See
Deadlines and Escalations.

Mandatory Datatab | Set attributes, attribute groups, and/or references that are required to be populated
before a task can leave the state. See Mandatory Attributes and References in
Workflows.

On Entry Add/ modify / delete business actions that are run on entry to the state. See Business
Rules in Workflows.

On Exit Add / modify / delete business actions that are run on exit from the state. See Business
Rules and Workflows.
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State Change the name or characteristics of the state. See State Characteristics in
Workflows.

Web Ul Screen Provides a link to the Web Ul to map the state to a specific Web Ul screen. From the

Mapping dropdown, select the Web Ul that should have access to the workflow, and click the Edit

button. This will launch the login page of the Web Ul. The user must have privileges to
edit Web Ul configurations and if so, logging in will open the designer to the Screen
Mapping properties with conditions to map to the workflow state pre-populated. The
user can then select an existing screen to map the state to. More information on
mapping Web Ul screens can be found in the Main Properties topic of the Web User
Interfaces documentation.

Transition Editor

The Transition Editor is launched when the user double-clicks on an existing transition. This editor enables users
to make changes specific to a particular transition.

32 Transition Editor

Add MNew Events
Submit
B | %] &
Show Edited Transition
Tab Description

Condition | Add/remove / modify business conditions on the transition. See Business Rules and
Workflows.

Events Add/ remove / modify events on the transition. See Auto Routing Tasks in a Workflow.

Mandatory | Set attributes, attribute groups, and/or references that are required to be populated before a task
Data can take the transition. See Mandatory Attributes and References in Workflows.
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Description

On Add/ remove / modify business actions on the transition. See Business Rules and Workflows.
Transition

Visual Indicators in STEP Workflows

Several visual indicators are present to allow users to quickly gather information about the workflow without
having to open a particular state or transition.

Indicator Description

‘Al A assignee has been specified for the workflow or state. See Assignees in Workflows.

D’ A deadline has been selected for the state. See Deadlines and Escalations.

I' An'On Entry' action is present on the state. It may help to remember this as'l' for'In' (e.g.,
into the state). See Business Rules and Workflows.

‘o' An'On Exit' action is present on the state. It may help to remember this as 'O’ for 'Out'’ (e.g.,
out of the state). See Business Rules and Workflows.

'P' Specific user privileges have been granted for the state. See Editing Privilege Rules.

Dotted A condition has been placed on the transition. See Business Rules and Workflows.
transition line

Rounded end An action has been placed on the transition. See Business Rules and Workflows.
on transition

Blue color The state has the Final characteristic. See State Characteristics in Workflows.

Dark gray color | The state has the Initial characteristic. See State Characteristics in Workflows.

Light blue/ gray | The state has the Cluster characteristic, or no characteristics (e.g., standard state). See
color State Characteristics in Workflows.
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Views and Mappings for Workflows

While not strictly necessary, if users are going to work with workflows in the STEP Workbench, it is generally
recommended to create views and mappings for the workflow. This ensures that users have access to the right
information to complete their tasks and streamlines the work process. However, users can also use the standard
editors available on objects in the Tree if desired, using the Workflow navigator only to submit tasks rather than to
review and edit data.

When a workflow state is selected in the STEP Workflow navigator tab, the information that displays is called a
view. The act of applying that view to a particular state in a workflow is called mapping. When configuring a
workflow it is important to decide what data is visible for objects (views), and define which states to display
(mappings). Without views and mappings configured, all states in the workflow are displayed on the STEP
Workflow navigator tab (including parallels, clusters, and final states). Additionally, just the ID of the objects in the
selected state display in the STEP Workflow ltems editor or the Task tab on the object.

Upon mapping views to states, only the states for which a mapping exists will be displayed in the STEP Workflow
navigator tab. The configured views will be used in the STEP Workflow Items editor and on the object's Tasks tab.
This allows for customization, so if a user wanted to show only human-related tasks, they can leave out mappings
for any states, parallels, or clusters that are not human tasks. Additionally, the sequencing of mappings determines
the order in which the tasks are displayed in the STEP Workflow tab.

STEP Workflow < STEP Workflow Items
Profile Products || References || Referenced By
@ Product Awaiting Asset o * [Mame * |Description Source  * |Description Target > |E
&= psupplier Waorkflow E] View Editor
@ publications 207148 * (135828 207144 Edit
0y Publication Sections Editar WM
@= Sales Item Creation \

5 o EI View: Start

- 5ales Ttem Creation - original : .%Aspect id
- Sample Workflow 20714-D » |L35831 20714-D : EEI Aspect: name
@ Sample Workflow - ML Atiribute group: ItemDescriptionInformation
QDDD D."i'IEW Do Work

iﬁ Aspect: name
Filter by Collection MN714E » [135832 20714-E .. Attribute group: ItemPricngInformation
Start & =& view: Finish
;‘l{nrk 0 | ety EE| Aspect: name
- "‘--.____ - [E3 Attribute group: TtemDescriptionInformation
Finish il . -—-."‘m____ L2 Attribute group: ItemPricingInformation
@- Shipment Order Process TEE s —— || 5] Mapping : Start->Start
@ User Web UL Workfiow | IV (o e E Mapping : Do Work->Da Work
©=WF_Adding_Logic L& ' m | B E Mapping : Finish->Finish

Note that while views and mappings can be applied to a blank workflow canvas, it does not generally make sense
to do so. Therefore, it is expected that a workflow has been created prior to any views or mappings being applied.
See the Creating a Workflow topic for detailed instructions on workflow creation.

Before creating views or mappings, it is important to be aware of the following points:

« The views and mappings configured in the STEP Workflow Designer only apply to workbench and not Web
Ul. Views in Web Ul are defined by the configuration of the screen. If users will not be interacting with
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workflows in the workbench, it is not necessary to configure workbench views. Instead, see the Workflows
in Web Ul section of the Web User Interfaces documentation.

« A view can contain both object and workflow-specific data. This means that a view can contain attributes,
attribute groups, and aspects information specific to the object (such as name, ID, approval status, etc) as
well as elements like workflow assignee, deadline, workflow variables, and workflow attachments.

« Aview can be mapped to multiple states. For example, if a state is assigned to a particular user or group
early on in the workflow to edit data, and again later in the workflow to review data, it is possible that the
same data points should be available to them in each state. In this case, the view only needs to be configured
once, and that view can then be mapped to each applicable state.

« Once aview or mapping has been started for a workflow, even if they are then deleted to be completed at
another time, no states will show in the STEP Workflow tab until views and mapping are completed.

The details for configuring views and mappings are covered in the subsequent topics, Configuring Views for
Workflows and Configuring Mappings for Workflows topics.
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Configuring Views for Workflows

This topic details how to configure views for states. Without views configured, end users will only see the ID of
objects in a workflow when accessing tasks via the STEP Workflow navigator tab or the Tasks tab on the object.
Therefore, if users will be interacting with the workflow in the STEP Workbench, it is recommended to have views
in place so that the user can easily see the data points relevant for their tasks in that state.

Note: There is no need to configure views for workflows that will be accessed only in Web Ul. For information on
working with workflows in Web Ul, see the Workflows in Web Ul sectionof the Web User Interfaces
documentation.

The steps below describe how to create views for a workflow accessed in workbench, and provide reference
material for the various view options.

1. Tobegin creating views, select the desired workflow in System Setup, and open the STEP Workflow Designer
by going to Edit > Edit Workbench Views and Mappings.

-

£+ STEP Workflow Designer - 11123 ==
File View
Wor 15 Undo ipment Order Process (11123) & -
D Redo
Nam &2 cut | Initiste: Data
Wor Copy Procesd_1
Rest Paste = E
'stah wed 2 | Review Data () Error
Delet B :1
'51313‘}{ =ee e
=3 Select All Confirm data
g Select Mone Procesd 3
H'I'
Edit Workbench Views and Mappings | End State

Localize State Mames and Events

Edit Event Mandatory Settings

=

2. When the View Editor opens, it will be blank. Right-click on the left side of the panel and select Add View.
Provide an ID for the view.
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P 4

£+ View Editor =

Edit
Editor | KML

Add View

£+1 View Editor =

Edit

Editaor [xp
-[E] Miew: Iritial Data View

ID |Initial Data
Sorton |0

[7] Sort Columns Automatically

3. Once aview has been created, columns can be added by right-clicking on the view, selecting Add Column,
and choosing a type of data to add to the view. As many columns can be added as needed to provide all
necessary information to the user.

£+9 View Editor
Edit

Editor | ¥mL

. i'l'lew: Inlhl-‘l ImEN N ||.|:_...
Add Column * Attribute

Attribute Group
Aspect

Delete

Component

The Attribute, Attribute Group, and Aspect options are all for displaying object data, while the Component
option is for displaying data specific to the workflow task (e.g., a workflow variable, attachment, assignee, etc).

The below sections describe the various view options in more detail, as well as how to reorder columns within a
view.

Important: For views to take effect, each view must be mapped to one or more states. For details on mapping
views, see Configuring Mappings for Workflows.
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Attribute

The 'Attribute’ column type is used to insert a single attribute into the view. The validity of the attribute must match
the validity of the objects in the workflow, or else the attribute will not be displayed in the view. Additionally, if
working with specification attributes on products, the attribute must also be linked appropriately in the hierarchy to
be valid for the workflow objects.

An attribute can be configured as 'Read Only' and/or 'Mandatory'. Attributes marked as 'Read Only' are not
editable on the STEP Workflow Items or Tasks tabs. The 'Mandatory' setting will give a visual indication that the
attribute is required by showing an asterisk (*).

Note: The Mandatory checkbox in view configuration provides a visual indicator only—it does NOT enforce that
the attribute is populated. If the attribute must be populated prior to exiting the state, the attribute must be marked
as mandatory using the Mandatory Data tab of the state or transition editor. More information on this is available in
the Mandatory Attributes and References in Workflows topic.

To add an attribute to a view, right-click on the view > Add Column > Attribute. Click the ellipsis button (...]) to
select an attribute, and mark the Read Only and/or Mandatory options as needed.

£+1 view Editor =

Edit

Editor |y STEP Workflow Items |08 <00 W

B view: Initial Data - e=p| [Object ’
<& View: Inital Dat L Attribute Date (Date) ...
{ -El& Column:Object (DeDuplication) |E| * (120668)
-E]g Column:Who Approved? (WorkflowVariable] [] Read Only > |(181159)
{13 Attribute: Date
{LLUEE robiemncitincd Ao Dozdline AtardAnwnaadi Mandatory:
4 | 1 k

Itis worth noting that if a field is highlighted in red, this means that the value is mandatory for approval of the object,
independent of the workflow or state. This type of mandatory is set on the attribute by setting Mandatory = Yes. As
with the mandatory indicator in the view, this does not force the user to populate a value within the state.

‘ SR LT G DTR LN E | Products ||References || Referenced By
1D

¥ [Mame ¥ |Description, Web > ¥ [Multiplayer
30's Slasher Game » 131542 80's Slasher Game 1 1 Mo
Space Adventure Game * (131536 Space Adventure Game | |2—16 Players Mo

Attribute Group

The 'Attribute Group' column type is used to insert all attributes in a group into the view. The same considerations
apply as for a single attribute, described above.
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Aspect

Via the Aspect option, it is possible to insert columns for ID, name, object type, revision, and other basic data for
the object.

To add an aspect to a view right-click on the view > Add Column > Aspect. Click the appropriate radio button for
the desired aspect. A full description of what each aspect option is can be found in the table below.

E] View Editor @
Edit
EI-- View: Aspect
¢ o
(7 name
(7) object type
() revision
) path
(") approved
() translation
(") indesign_template
(7 quark template

Aspect Description

id Displays the ID of the object, which is not editable.

name Displays the STEP Name of the object, which is editable if privileges allow.

object type Displays the object type of the object. If privileges allow for editing, a dropdown
is present from which valid object types can be selected.

revision Displays the revision number, as well as when the object was last edited and by
whom. The field is not editable.

path Displays the path of where the object exists in STEP. The field is not editable.
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Aspect Description

approved Displays the approval status of the object and date / time of last approval if
applicable. The field is not editable.

translation Displays the translation status of the object, for example: Up to date, In
Progress, Not Translated, etc. (not editable). For more on translations, see the
Translations documentation.

indesign_ Displays the STEP Publisher product template being used for print. By clicking
template on the hyperlink, the user is brought to the template.

quark Legacy option that should not be used in current implementations.

template

Note that Unique Key is not a selection option. If it is required to display the key value of an object, the attribute(s)
driving the key should be selected using the Attribute or Attribute Group options.

Component

The Component option gives access to a list of data specifically related to workflows, including assignee, workflow
attachments, workflow variables, etc.

To add a component to a view right-click on the view > Add Column > Component.

Populate the Title (header for the column in the view), select Read Only or Mandatory as appropriate, and select
a component from the dropdown. Note that selection of a component may result in additional selection options.
For example, selection of Workflow Variable yields an additional dropdown to select the specific variable to be
used. Each component option is described in detail below.

E] View Editor @

Edit

Editor [xm

EI-- View: Component
- E# |Column:Reason for Rejection (WorkfowVariable) | Title |Reason for Rejection

[ Read Only

[ Mandatory
Component :Wnrkﬂuw'u'ariable -
Variable :ReasnnFurRejectiun v:
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Read Only and Mandatory fields are not applicable on all components and are disabled in that case. When
available, fields marked as 'Read Only' are not editable on the STEP Workflow ltems or Tasks tabs. Checking
'Mandatory' means that an asterisk (*) is shown with the Title to indicate to users that the field should be populated.
However, it does not enforce that the field is populated prior to the task exiting the state.

DeDuplication

Adding the DeDuplication component to a workflow view allows a user to see if there are any objects in the system
that have been flagged as potential duplicates by a matching algorithm.

£+1 View Editor ==

Edit

—-. View: Initial Data * | Component
- EJ§ Column:Object (DeDuplication)

- EJ§ Column:Who Approved? (WorkflowVariable =
-] Attribute: Date Read Only
- Ej& Column:Workflow Deadline (WorkflowDead

-

Title | DeDuplication

- EE Column:Attachment 1 (WorkflowAttachmer Mandatory
- EJ§ Column: (WorkflowAssignee) Component | DeDuplication =
- E# (Column:DeDuplication (DeDuplication) _ .
. View: Review Data 1N Mo Configuration Required
1‘ I I

If potential duplicates have been identified, a Duplicates button is present that the user can click to access a list of
possible duplicates for the selected object in the workflow. Clicking the Differences button opens a Compare
screen where the user can view differences and confirm or reject duplicates.
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STEP Workflow Items [ Products ” References ” Referenced By
Object » [Deduplication  » |Externa| Item Description > |ID ¥ [Name
1 1
1 EI00012 > [ EIOQ012 Duplicates
g Resolve possible duplicates. @
[ EI00024 » [ E100024 @ 1 EID0012 is possible duplicated by these objects. Please resolve manually.
1EI001S > [EID0O1S Duplicates |  [-E100014 1EI00014 a0 _/ Differences |
1E100025 > [EI00025 Duplicates | [E100013 1EI00013 90 /| Diferences
[EINO0S3 > [ EIO0OS3 Duplicates /
1EI00042 > [ EI00042 Duplicates £ Compare ’
: 3 Matching Algorithm Criteria Close
TEIO0002 > [EIO0002  |No Duplicates Name » lscore (%) >
1 EIO0AS55 > [ EIONOSS Duplicates 1 [*p0s 20
> Total 90
IEIODO12 IEIODO14
=71 [All Elements]
_j ID I-E100012 I-EI00014 Details. ..
71 Name T EI00012 I EIODO14 Details. ..
[+-£0 Attributes
[ Expand Al ] [ Collapse Al ]
[7] Hide Identical Rows
[ Confirm Duplicate ] [ Reject Duplicate ] [ Cancel

For additional information on deduplication workflows, see the Clerical Review topic in the Matching, Linking,
and Merging documentation.

DTP Task Info Provider

Component that can be used if a user wishes to show task data in the InDesign plugin tasks tab. It will not be
rendered in the workbench. The Variable ID will be used for value-name and the column Title will be description.
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P o)

£+1 View Editor =

Edit
Editar [xp
=] View: Initial Data * | Component
- Ej§ Column:Object (DeDuplication) Title |DTPTaskInfoProvider
- Ej§ Column:Who Approved? (WorkflowVariable]
~[If attribute: Date [| Read Only
- B& Column:Workflow Deadiine (WorkflowDeadl
- B Column:Attachment 1 (WorkfAowAttachmen| = 7] Mandatory
EE" Column: (WorkflowAssignee) Component CTPTaskInfoProvider -
- Ejg Column:CTPTaskInfoProvider : :
- B view: Review Data This column will not appear in the Workbench View, When
-2 view: Confirm data - applicable the Variable value wil be send as Task info to a OTP
Vi .: A Data gystem. The Variable ID will be used for value-name and the
8 FIE“ Itiprweckz 4 column Title will be description,
+-=| View: Items package
[-E] view: End State o :
E Mannina : Tnitiate Nata-=Tnitial Data i Variable | il
1 I P

Pluginable Cell Debug

Experimental debug option that generally should not be used.

Pluginable Cell Primary Image
Component for displaying the primary image of the object.

£+1 View Editor [
Edit
Editor [xm
=& view: Initial Data * | Component
+~[EJE Column:Object (DeDuplication) Title |PluginableCellPrimaryImage
- Ej Column:Wha Approved? l[';"l.n'vc:nrk.ﬂ-:nI.n'c'l.-'alrlal::nleJ -
~[]¥ Attribute: Date Read Only
- Column:Workflow Deadline {WorkflowDeadli _
- Column:Attachment 1 (WorkflowAttachmen Mandatory
-+ g Column: (WorkflowAssignee) Component :PIuginabIeCeIIPrimaryImage v:

- EJg Column:PluginableCellPrimaryImage
(e . View: Review Data

-/ View: Confirm data -
4 | 1} 3

Mo Configuration Required
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STEP Workflow Items

References || Referenced By |

Translation

STEP Workflow Items |0 s

Approved

o

W

Primary Image

b

Comfy Bed twin 3 Last Approved on Tue... Mot Translated I

W

Comfy Bed double 3€ Never Been Approved Mot Translated
Comfy Bed California King > € Mever Been Approved  Not Translated

The component displays a thumbnail of the primary image. Note that the image and reference are both not
editable (e.g., images cannot be added or removed using this component).

Note: If end users need to edit references (primary image or otherwise), this can be done using the standard
editor functionality on the References and Referenced By tabs.

The reference type used to identify the primary image is set in System Settings (System Setup > Users & Groups
> Primary Image Type). The STEP ID of the reference type that should be used must be entered in the Value field.

System Setup <
[+ Event Processors -~
ystem Settings Log

-[55] Gateway Endpoints
&)-[55] GDSN - Classification Hierarchy Settings
EEI--- Global Business Rules @~ jmage &Doament Setlings
=-[5] Inbound Integration Endpoints
(5] Match Codes and Matching Algorit = Asset push attribute macro keys
EEI--- Outbound Integration Endpoints O~ Callated Atrbute Seth
B-[55] Web Uls
[#-[£5] Workflow Profiles == Cryptographic Keys
-[5] Workflows .

EF Validation Templates

-[Z| Derived Events

[+ Object Types & Structures - Product Information Manager Default Settings
-0y Tags ranslation Settings

o
[HL o | nit= | L fien
Eﬂ--@lﬂﬂ'&&ﬁ'ﬂm 3 == Terms List Settings
[-=y, Reference Types

el & i

[H-+:++ Workspaces Web Services
- /! Table @ \Web UI Settings
e Keys _
EEI---_ﬁE Event Queues § Primary Image Type
EEI--- Component Models Mame > [Value
&% Recyde Bin i I * Primary Image ReferenceType rimaryProductimage
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Vendor is used to display the name of the vendor / supplier that the object is assigned to. This is typically used for
systems that have a Supplier hierarchy in place. More information on this setup is available in the Supplier Web
Ul Setup Guide in the Web User Interfaces / Web Ul Getting Started documentation.

-

E] View Editor
Edit

.

(=3

Editor | xmL

=R . View: Start * | Component

() Aspect: id Title |Vendor

in Aspect: name

-[E7] Attribute group: ItemDescriptionInformation Read Only

-3 Attribute group: Subscriber
= . : = Mandatory

- Column:Status Flag (WorkflowVariable) E

iEl Aspect: object type Component ‘Vendor

in Aspect: revision )

in Aspect: path

in Aspect: approved 3

&%) Aspect: translation

-8 Column:Primary Image (FluginableCellPrimar

- E IColumn:Vendor (Vendor)|

- l=| View: Do Work 57
1| 1] 3

Mo Configuration Required

STEP Workflow Items

S R UVET G DTV B | Producks || References || Referenced By |
Translation * |Primary Image endaor
Comfy Bed twin * Mot Translated I Croducts Galore
L
Comfy Bed double * Mot Translated
Comfy Bed California King * Mot Translated

The component displays the name of the supplier classification folder that the object is linked to (object will be in
the Products sub-folder), using the reference type indicated in the 'Link type for vendor classification to product

link' system setting.
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/ L 4 System Settings
my=y—— (System setngs [

£ Aurute Tarsfomats oCusfmtendysewes
Action Sets

Contexts @ Image &Document Settngs
e “ InDesin Queue @ Assetpushattribute macrokeys
- Lists of Values /LOVs

- Change Packages @ Calculated Attribute Settngs
& (2 Completeness Metics @ Cryptographickeys
(5] Event Processors

f#)-(5] Gateway Endpoints ®Validation Templates
o8 o Coodctmanvansge et setngs
[+ Global Business Rules

4 £8 nhound Itegrton Endpans Orensotenses

-5 Match Codes and Matching Algorithms

oremsissewes
(+1-(Z5] Outbound Integration Endpaints
o2 web Ui cwoseis

-5 Workflow Profiles

-2 Workflows @ Webursettngs

Derived Events Mame > [Value
[+-{ZZ Object Types & Structures > Default context Contextl
% Tags » Default workspace Main
é&' Unitz i . . :
@ » |Wv.=_'b I supplier dassification object type SuppliersRoot
.’h Reference Types » hﬂl'Eb I supplier products dassification object type SuppliersProducts
+4 Workspaces > |Assets dassification object type suppliersAssets
g :;:?: » Batches dassification object type
Ii Event Queues * Batch dassification object type
---E Component Models > Excel-template asset QuickSheetTemplate
-7 Recyde Bin * Proof view stylesheet attribute
* Step-users Web UI batches folder SuppliersBatches
» Step-users Web UI assets folder SuppliersAssets
* Context Help metadata attribute Attribute Description
» Link type for vendor dassifiction to product link SupplierLink
* Enable all-view for users that are a member of multiple mpdierﬂﬁ’
Workflow Assignee

Used for displaying the current assignee and/or letting users with the STEP Workflow Administrator privilege re-
assign the current task to another user / group.

If to be used for re-assigning, either the User Groups or Users parameter (or both) must be populated.
Selections will be the available assignees.
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If the Expand User Groups checkbox is selected, all users in the selected user groups will be available for

selection / assignment (as well as the user group itself). Note that when a privileged user selects a user / group to
re-assign the task to (in the STEP Workflow ltems editor or on the object Tasks tab), the re-assignment will occur
immediately, and the task might disappear upon refresh.

The Output Var parameter can be used to select a workflow variable to write the public ID of an assignee. If a
selection is made, when an end user populates the cell, no reassignment takes place and no special privileges are
required. The use for this is that a user is able to select a 'future’ assignee - the actual assignment must be done
later by a business action that looks up the assignee using GroupHome / UserHome. If the same ID is used on
both a group and a user, the component will use the group, as it's found first.

F

Edit

£+9 View Editor

Editor [xm

=

E|"

=-E
=-E
=-E
=-E
=-E

View: Initial Data

- Bl Column:Cbject (DeDuplication)
- E& Column:Wha Approved? (WorkflowVariable)
(13 Attribute: Date
- Column:Workflow Deadline {WorkflowDeadling]
- E Column:Attachment 1 (Workflowattachment)

- EJg Column: (WorkflowAssignee)

- B2 [Column:WorkflowAssignee (WorkflowAssignee

View: Review Data
View: Confirm data
View: Approve Data
View: Items packaged
View: End State

----- E Mapping : Initiate Data-=Initial Data
E Mapping : Review Data-=Review Data

Mapping : Confirm data->Confirm data

E Mapping : Approve Data->=Approve Data
E Mapping : Items packaged->Items packaged

Mapping : End State-=End State

I

Component

Title |WorkflowAssignee
[] Read Only
[ Mandatory
Component :Wurkﬂuw.ﬁ.ssignee
Output Var

[] Expand User Groups

User Groups

X E)

Users

X E)

-

© Stibo Systems - Confidential - Release 10.0-MP3 (October 2020)

52



StiboSystems

MASTER DATA MANAGEMENT
STEP Workflow Items [ Products ” References " Referenced By
ary Image * Vendor > |Assignee >
Comfy Bed twin Products Galore Group : Super Users -
Comfy Bed double » I ser : user -
Comfy Bed California King » Lser : USER
ser @ User 2
IJger : User 3 |.E |
User @ User 4 —
ser @ User 5
ser @ User &
User @ User 7 57

For more on Assignees and the description of the various options for the Workflow Assignee component, see the
Assignees in Workflows topic in the Workflows documentation.

Workflow Attachment

A component that lets users add, open, download, and delete Workflow Attachments. Use of this requires thata
Workflow Attachment has been previously set up in the STEP Workflow Designer (and saved) so that it can be
selected in the Attachment dropdown.

o

File Edit View
Workflow Properties

D sampleWWorkflow3state

Workflow Variables/attachments

Mame | Sample Workflow (3 states)

Attachment’

StatusFlagDoWark'

abi:

StatusFlagFinish'

abe:

StatusFlagstart’

abi:

Validation errors:

e

E] STEP Workflow Designer - SampleWorkflow3state®

E] View Editor @

Edit

Editar [xp

EI-- View: Start Compaonent

&2 Aspect: id Title |Attachment
in Aspect: name
-[23] Attribute group: ItemDescriptionInformation [ Read Only
[0 Attribute group: Subscriber
- EE Column:Status Flag (WorkflowVariable) [ Mandatory
&%) Aspect: object type Component | WorkflowAttachment =
iﬁ Aspect: revision - .
&%) Aspect: path Attachment |Attachment vI
iﬁ Aspect: approved

W% Aspect: translation

- B& Column:Primary Image (PluginableCellPrimaryIn
- Ej Column:Vendor (Vendor)

- Column:Assignee (WorkflowAssignee)

-Eg Column:Attachment (WorkflowAttachment)

© Stibo Systems - Confidential - Release 10.0-MP3 (October 2020) 53



StiboSystems

MASTER DATA MANAGEMENT

STEP Workflow Items ~pm
SRR LT G TR LS B | Products || References || Referenced By
¥ |Vendor * |Assignes » Bttachment »
Comfy Bed twin » Products Galore Group : Super Users
Comfy Bed double » Group : Super Users / E]
Comfy Bed California King » Group : Super Users E]
<) Open 55
Lookin: | | Checkiists - T -

(] Maintenance Patch Notes Checklistadsx

EE' Mew Hire Checklist.dsx

(] Mew Release Project Checklistdsx
(=] OLH Topic Checklist.xlsx

(] Release Notes Topic Checklistadsx

Cancel

File name: Mew Hire Cheddist, xsx

Files of type: | All Files -

Note: If marked as 'Read Only', the add and delete options will be disabled, but users will still be able to open and
download attachments.

For more information on Workflow Attachments and the features in this component, see Workflow Attachments
in the Workflows documentation.

Workflow Deadline
Users with the STEP Workflow Administrator privilege will be able to set, edit, and delete task deadlines. Users
without the privilege will see different icons depending on whether the deadline is reached or not. Deadlines will be

displayed when a user hovers over the icons.

Note that the editability of the deadline field is determined solely by privileges, and therefore the Read Only setting
is not applicable for this component.
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E! View Editor @
Edit
Editar [xp
=& view: Initial Data * | Component
- Ej§ Column:Object (DeDuplication) Title |WorkflowDeadline
- Ej§ Column:Who Approved? (WorkflowVariable| =
[ Attribute: Date [] Read Only
- Ej& Column:Workflow Deadline (WorkflowDead
= . [] Mandatory
- Ej& Column:Attachment 1 (WorkflowAttachmer
€ Column: (WorkflowAssignee) Companent | WorkflowDeadline -
- B Column:WorkAowDeadine (WorkfowDeadli N Confiauration Feauired )
& . View: Review Data il o Configuration Require
1 | i [ b
STEP Workflow Items i
STEP Workflow Items R0 e | References || Referenced By
* |Assignee » |Attachment * Deadline »
Comfy Bed twin » | Group : Super Users E] ﬂ @
Comfy Bed double * | Group : Super Users [;]
Comfy Bed California King * | Group : Super Users i =
£+1 Date Picker
Year: Month:  Day:

Hours: Minutes: Seconds:

11 45 03

[ 0K H Cancel

For more on this see Deadlines and Escalations in Workflows in the Workflows documentation.

Workflow Linked Name

Component for displaying the object name as a link to the configured object editor. When the component is
selected, default values are populated, which takes the user to the standard editor for each super type of objects
(e.g., the Product tab in Tree view for "blue" objects in STEP). However, these default values can be edited so that
the user is directed to another tab when clicking the hyperlink in the view (e.g., to the References tab or Images &
Documents).
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E! Yiew Editor
Edit
Editar [xp
=& view: Initial Data * | Component
- EE Column:Object (DeDuplication) Title | WarkflowLinkedMame
- Ej§ Column:Who Approved? (WorkflowVariable
(] attribute: Date Read Only
- B Column:Workflow Deadline (WorkflowDead
- Ej& Column:Attachment 1 (WorkflowAttachmer Mandatory
- B Column: (WorkflowAssignee) = Component | WorkflowLinkedName |
- g [Column:WorkflowLinkedName (WorkflowLin : :
Bl . View: Review Data Product Editor |Product
-] view: Confirm data Classification ™ | Classification
[-=] View: Approve Data
(-] View: Ttems packaged Asset | Asset
[+-& view: End State H Entity ™ |Entity
----- E Mapping : Initiate Data-=Initial Data _ _
----- & Mapping : Review Data->Review Data Attribute ™ | Attribute
|1§| Mapping : Confirm data->Confirm daim ™ | Planned Page * |Plan
i i b

For example, to change the default landing page to be the References tab of the product editor, go to the desired
editor, choose the desired tab, and look at the STEP URL field. In this example, the tab is named
'ProductReferences'.

Context :English s - B3 6 (¥ URL | ct?editor =ProductReferencesficontextid=Context

—
El r_=| Primary Product Hierarchy (Prc = Product || Sub Products BUAEISE=1H= Referenced By || Images & Documents || Commercial [

= 2] Products (ProductsRoot) @ Index Words
H | |Inheriteu:| From > |Inu:|ex > |

Type 'ProductReferences' for the Product Editor parameter and save the changes to the workflow.

© Stibo Systems - Confidential - Release 10.0-MP3 (October 2020) 56



StiboSystems

MASTER DATA MANAGEMENT

r =

E! Wiew Editor @

Edit

=& view: Initial Data + | Component

+ El2 Column:Object (DeDuplication) Title |\ WorkflowLinkedMame
- Ej§ Column:Who Approved? (WorkflowVariable

[T Attribute: Date Read Only
- Eg Column:Workflow Deadline (WorkflowDead
- Eg Column:Attachment 1 (Workflowattachmer Mandatory

- Eg Column: (WorkflowAssignee)

- B Column:WorkAowLinkedName (WaorkfAowLin
& . View: Review Data Product Editor |ProductReferences
[#-[& view: Confirm data
[-=] View: Approve Data

m

Component :WorkﬁowUnkEdName -

Classification ™ |Classification

Display the STEP Workflow Items tab and click the name link to display the configured tab within the
STEP Workflows editor.

[ Products ” References ” Referenced By ]

>JLink >

Comfy Bed twin »

Comfy Bed double >
Comfy Bed California King

| STEP Wmld“low Items ” Product ” Sub Products ] References [ Referenced By ” Images & Documents ]
@= (DiscontinuedProductMaintenance) P
F (Display)

Reference Type v * [Target | »
» |Supplier Link + ol
* |Website Link + oy
= (DocumentReferences)

Workflow Note Column

Component for displaying the most recent Process Note or Transition Message. If not configured as Read Only, a
new note can be added, and will persist throughout the workflow. If the field is hovered over in the end user view,
the configured number of recent entries entered in the Max Entries field will display. Along with the message, the
user info and time-stamp will also show.
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$3 Vview Editor
Edit
Editor  wmL
- EJE Column:Vendor {Vendor) A | Component
Eg Column:Assignee (WorkflowAssignee) Title | WorkflowNoteColumn|
- E|g Column:Attachment (Workflowattachment)
- EJE Column:Deadine {WorkflowDeadline) [ Read Only
- EJE Column:Link {(WorkflowLinkedMame) Mandatory
- EJ& Column:WorkflowNoteColumn (WorkflowMo! s
- EE Column: (WorkflowPlannedPage) Component  WorkflowNoteColumn v
- E|g Caolumn: (WorkflowvariableUserList) _
- EJE Column: (WorkflowTaskColumn) Max Entries |3
Eg Column: {(WorkflowVariable) [] show Transition Messages
- E|g Column:Release Date (Workflowvariable)
- & Column:WFVarUserListWithoutGroup (Work v Show Process Notes
< >
WorkflowNoteColumn (... * |WorkflowPlannedPage » |WorkflowVariableUserLi,.. * |WorkflowTaskCalumn > WorkflowVariable (Varia...
Meed to chedk price
Pink & Blue Owl Party Hat > 293Nt quantty -sold | v (g2

as pack of 12 but price

seems to be for each

12:29:40 24 Oct 2016 USERG : Need to check price against quantity - sold as pack of 12 but price seems to be for each
12:28:57 24 Oct 2016 USERG : Primary colors listed are incorrect, please resolve

12:28:15 24 Oct 2016 USERG : Please review the image for whitespace

The Show Transition Messages and Show Process Notes parameters are used to define the types of notes
displayed. Care must be taken when making these selections as they significantly impact the user experience.
Typically, only one option will be selected, as appropriate for the intended use.

« Show Transition Messages: Check this if a message is provided at the time the task is submitted, and the
next user should see that message. If no message is provided at the time of transition, a transition is still
logged, though without a message (e.g., time, date, and user can be seen upon hover but no corresponding
message is displayed). The intent of this is for serial workstreams where one user will need to see a
message entered from the immediately preceding user, but is unlikely to need to see previously entered
messages from those further upstream. Therefore only the message entered by the last user is displayed in
the view.

« Show Process Notes: Check this if users will enter notes while working with tasks, and the notes should be
visible to the next user. The intent of this is that the current user needs to pass information to one or more
subsequent users, and they enter the message while working with the task (e.g., prior to submission). The
most recently entered note will always be available in the direct view, with additional notes available upon
hover.

« Both: Use caution when selecting both parameters in the same column. The most recent transition
message is always displayed in the view (if no message was entered, the view displays no value). Any notes
entered outside of the submit message are only available upon hover (even if a transition message was not
provided). If a transition message is always provided, this can be a valid setup. However, if transition
messages are not guaranteed, it can appear to the end user that no messages are present, when in fact
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process notes have been provided. If both process notes and transition messages need to be available, it is
recommended to add the column to the view twice with only one parameter checked in each so that both
process notes and transition messages are shown independently.

Workflow Planned Page

Component that can be used in workflows valid for Planned Pages. It will show a thumbnail of the plan, Sticker
book, or Mounted pages (as directed by the View choice parameter), and links directly to the selection when

clicked.

r

£+1 View Editor
Edit

-

==

=] View: Initial Data

- Ej§ Column:Object (DeDuplication)

- Ej§ Column:Who Approved? (WorkflowVariable
(] attribute: Date

- Eg Column:Workflow Deadline (WorkflowDead
- Eg Column:Attachment 1 (Workflowattachmer
- EJ§ Column: (WorkflowAssignee)

= k:ulumn WaorkflowPlannedPage ('l.ﬂ.l'urk'ﬁuwPI
B view: Review Data

B view: Confirm data

& view: Approve Data

View: Items packaged

- . View: End State

----- E Mapping : Initiate Data-=Initial Data

----- E Mapping : Review Data->Review Data

mmmmm

1§| Mapping : Confirm data-=Confirm data
4 1 P

-

Component

Title | WorkflowPlannedPage
[ Read Only
Mandatory
Component :WorkﬁowPlannedPage

View choice :P'Ian
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& STEP Workflow Items -

STEP Workflow Items |EMEIS[=3

Preview

Party Hats
Party Hats

Plastic Toppers

Party Hats - Plan

STEP Workflow Items m Planned Page || Plan Motes || References || Status || State Log || Tasks
Flatplanner

E B R EE | -Ef |Z={: ¥ |"."'.": H:
Party Hats
2 =)
[vellow & Pink ' [Purple & White [Pink & Green P [Cosmic Party |
1] 1]
|Politics Party F | [Pink & Green B [Christmas Pam, | [5: 5 - Py

Workflow Task Column

Component for letting users claim / release a task. Users will not be able to work on tasks not assigned directly to
them, so if a task is assigned to a user group they are a member of, they have to claim it in order to work with it.
When a task is claimed, it is possible to release it again, assigning it back to the latest group assignee. If the task
has never been assigned to a user group, the task is assigned to the default assignee for the state.

This component is especially useful for states where the assignee initially is a user group and the desire is to let
users in that group claim and complete tasks.
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r )

£+1 View Editor ==

Edit

El-- View: Initial Data | Component

El? Column:Object (DeDuplication) Title |wWorkflow Task Column
- Ej§ Column:Who Approved? (WorkflowVariable
-[]T Attribute: Date ("] Read Only
- Eg Column:Workflow Deadline (WorkflowDead
- Eg Column:Attachment 1 (Workflowattachmer
- B Column: (WorkflowAssignee)

- Eg Column:Workflow Task Column (WorkflowT
- & view: Review Data

-] view: Confirm data

=] View: Approve Data

H-{=] View: Ttems packaged

|- & view: End State in
----- E Mapping : Initiate Data-=Initial Data

----- E Mapping : Review Data->Review Data

----- 95 Mapping : Confirm data->Confirm data 5E
1 1 3

Mandatory

m

Component :w::rkﬁowTaskEolumn -

Mo Configuration Required

[ Producks ” References ” Referenced By
WorkflowTaskColumn

Comfy Bed California King » ‘;:]

Comfy Bed King > o)

Comfy Bed double » ﬂ:]

Comfy Bed twin » t‘.:]

For more on task ownership, see the Assignees in Workflows topic in the Workflows documentation.

Workflow Variable

Component for viewing and editing Workflow Variables, which requires selection of the Variable that should me
made available. If the selected variable is bound to an attribute and the component is configured to not be Read
Only, the cell editor matching the validation base type of the attribute will be used (e.g., a date picker for attributes
with a type=Date).
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£+1 view Editor ==

Edit

& view: Start # | Component

4] Aspect: id Title |Status Flag
-7 Aspect: name
- (201 Attribute group: ItemDescriptionInformatior Read Only
- 251 Attribute group: Subscriber

- B IColumn:Status Flag (WorkfowVariahle) |
8] Aspect: object type Component | WorkflowVariable -
-Z] Aspect: revision : .
-4 Aspect: path

[ Mandatory

Variable _SEtusFIagSErt -

STEP Workflow Items |z a8 | References || Referenced By

Status Flag >

Comfy Bed double »
Comfy Bed California King » |Critical

For more on variables, see the Workflow Variables topic in the Workflows documentation.

Workflow Variable User List

Component for letting the user select from a list of users. The typical use case for this component is one where a
user, as part of one task, selects who should handle a subsequent task. The ID of the selected user is then stored
in the workflow variable specified in the Output Var parameter. From there, it can be used to apply an assignee in
a subsequent state using the Fetch from Variable assignee option in the State Editor Assignee tab.

An existing workflow variable must be selected in the Output Var parameter. This is used to store the selection so
that it can be accessed later in the workflow (e.g., at the time of task assignment in a subsequent state).

One of the three selection parameters must be configured (Group, Group Var, Config Prop). The three properties
are evaluated in the order shown. Therefore, if Group is populated, it will be used, and Group Var and Config Prop
will not be evaluated.

An existing User Group may be selected in the Group parameter, and the users in that group will then be available
for selection by the end user. This is used when users will always choose a user from within the selected group. If
the user group that users need to select an assignee from can vary based on other factors, then the Group Var
parameter should be used. From this, an existing workflow variable must be selected, and it is expected that at
some point in the workflow (prior to the state for which the view is being configured), the variable has been
populated with the ID of a User Group. The system then reads the ID from the workflow variable on the task and
makes the users from the corresponding user group available for selection. A Config Prop option is also available
where the ID of a configuration property can be supplied and the user group will be read from there. This is
typically only used in conjunction with extensions.
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E! Wiew Editor

Edit

~ W] Aspect: omect type
iij Aspect: revision
ih Aspect: path Title
iij Aspect: approved
&%) Aspect: translation
-8 Column:Primary Image (PluginableCellPrimar [] Mandatary
-8 Column:Vendor (Vendor) W ‘ 7
- E Column:Assignee (WorkflowAssignee) Component _Workﬂow'u'ariableUserUst -
- Column:Attachment (WorkflowAttachment) Output Var | Assignee
- Column:Deadine (WorkflowDeadlineg) -
- Column:Link (WorkflowLinkedName) Group |Regulatery Group (RegulatoryGroup) E]
- Ej& Column: (WorkflowNoteColummn) Group Var |
- E& Column: (WarkflawPlannedPage) -
B [Eolumn: (WorkfowVariableUserList)] Canfig Prop
~ B Column: (WorkflowTaskColumn) Only one of the settings above will be used for determining
- & Column: (WarkflowVariable) assignee. The settings are evaluated in listed order, i.e. if
- B Column:Release Date (WorkflowVariable) Variable is empty and Group is supplied then Group var. and
- EE Column:WFVarUserListwithoutGroup (Wark Config prop. will be ignored.

- & Column: (WarkflowVariable)
[+-[& view: Do Work
[#-[=] View: Finish
----- 5 Mapping : Start->Start
----- E Mapping : Do Waork->Do Work
----- 5] Mapping : Finish->Finish
4| 1 | b

i~

-

| Component

[ Read Only

m

1

STEP Workflow

R R VAT G LRI B | Products || References || Referenced By
o > WarkflowVariablelUserLi,.. *
Sales Ttem Creation

Comfy Bed California King »
- Sales Item Creation - original : :
7 Sample Workflow (3 states) Comfy Bed double > |Regulatory User 2 P
o [ ] | | | | Comfy Bed King »

Regulatory User 1

Filter by Collection E] T —
Start 4
Do Work 1 Comfy Bed twin » Regulatory User 1
Finish 0]
@~ Sample Workflow (3 states)(2) 3
== Sample Workflow with Parallels A ‘
&= shipment Order Process i
= User Web UI Workflow 8 B
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For more on variables, see the Workflow Variables topic in the Workflows documentation.

For more on Assignees, see the Assignees in Workflows topic in the Workflows documentation.

View ‘Sort On' Option

The Sort On option allows tasks in the workflow to have a default sort order specified by a particular column. An
integer can be entered to indicate the column that should be used for sorting (1= first column, 2= second column,
etc.). An example is below.

With no sort order specified, the items are in no particular order in the STEP Workflow Items tab.

STEP Workflow

Profile

& Sales Ttem Creation - original
= Sample Workflow

@ Sample Workflow(2)

@ Shipment COrder Process

Eli

Filter by Collection
Initiate Data
Review Data
Confirm data
End State

STEP Workflow Items

Products || References || Referenced By
- Object =||Wh|:| Approved? > Date >
» Flashlight Bulbs 4 (SPO) | 03-mar-2016
> Flashlight Bulbs 5 (SPQ) Juser L 05-apr-2016
» Flashlight Bulbs 3 (SPO) Juserz 03-un-2016
» Flashlight Bulbs 1 (SPQ) JuserL 03-apr-2016
| l » Flashlight Bulbs 2 (SPQ) Juser 5 07-may-2016
51 view Editor =
3 Edit
Z|E
oL Editor | xML
o || | E lewmsdoes] v
- EE Column:Object (WorkflowLinkedMame) 10 |Tritial Data
; EE’ Column:Who Approved? (WorkflowVariable)
. [|F Attribute: Date Sorton |0

#-& view: Review Data
[-[&] view: Confirm data
#-[&] view: End State

----- E Mapping : Initiate Data-=Initial Data
----- E Mapping : Review Data-=Review Data
----- E Mapping : Confirm data-=Confirm data

Mapping : End State->End State

[ Sert Columns Automatically

However, when a number is put into the Sort On option to distinguish what column the view should be sorted by,
the items are sorted in ascending order. Notice that in the View Editor, in the first view the object name appears in
the first column. To sort by this, the user types in 1 to represent the first column in this view.
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E] View Editor @
Edit
Editor |x]'u'||
EI-- View
E Column:Object (WorkflowLinkedMame) | D | tnitial Data
i El& Column:Who Approved? (WorkflowVariable)
----[II Attribute: Date Serton |1
¥-5] View: Review Data [ Sort Columns Automatically
#-[& view: Confirm data
#-& view: End State
----- E Mapping : Initiate Data-=Initial Data
----- E Mapping : Review Data->Review Data
----- E Mapping : Confirm data-=Confirm data
----- 15 Mapping : End State->End State
All objects in the workflow in this particular view are now sorted according to object name.
STEP Workflow STEP Workflow Items e
Profile VR LG WYR LB | Products || References || Referenced By
2= Sales Itemn Creation - original * Object Who Approved? >
== Warkflow » [Flashlight Bulbs 1 (SPO) ger L U}may—zﬂlﬁ
= Workflow(Z) * [Flashlight Bulbs 2 (SPO) ser 5 07-may-2016
7 Shipment Order Process » [Flashlight Bulbs 3 (SPO) ger? 03-jun-2016
» Flashlight Bulbs 4 (SPQ) 03-apr-2016
. % [ l | | | | » [Flashlight Bulbs 5 (SPO) ger L 05-apr-2016
Filter by Collection E]

Initiate Data 5
Review Data 2|E
Confirm data £

End State 0 Proceed 1 v:

If the option Sort Columns Automatically is checked, the Title parameter for each element of the view is used
and columns are sorted in alphabetical order based on this value, excluding aspects. To clarify, all columns of the
'Aspect' type (e.g., ID, Name, Revision, etc) appear first in the view, followed by all other elements listed in
alphabetical order by Title.
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E] View Editor
Edit

=

-- View: Start
I_:_I View: Do Wark
ih Aspect: name
-2 Column:Note (WorkflowNoteColumn)
%) Aspect: id
~-[1T Attribute: ListPrice
[+-[=] view: Finish
----- 5] Mapping : Start->Start
----- E Mapping : Do Work-=Do Wark

5 Mapping : Finish->Finish

View

ID Do Waork

Sorton |0
I Sort Columns Automaticallyé

| el | |

STEP Workflow Items

Product “ Sub Products ” References ” Referenced By
iin] > |Name » |List Price > |Mote >
“omfy Bed > 22155 Comfy Bed 1299 & B

Ordering Columns in Views

It is possible to reorder the data selections in a view by right-clicking on any element of the view and selecting
either Move Up or Move Down, depending on what options are given according to the current position. The order
of columns in the View Editor determines the order in which they are displayed to the end user so care should be

taken in the ordering.

P

E] Wiew Editor
Edit

-

==

=] view: Initial Data

- Eg Column:Object (WorkflowLinkedN
“[]T Attribute: Date

Component
Mowve Down Title |Object
Read Cnly
Delete
Mandatary

Component :WorkﬂowUnkedName
Product Editor |Product
Classification * | Classification

Asset ™ |Asset
Entity " |Entity
Attribute * |Attribute

Planned Page ™ Plan
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Using the XML View Editor

In addition to the Editor tab on the View Editor dialog, there is also an XML tab. This tab shows an XML
representation of the defined views and mappings, allowing users to create and configure views via XML rather
than right-clicking. This can be especially useful when a number of similar views need to be configured and
workflow designers need to indicate only a few differences between them. In addition, the XML editor can be used
to copy views across workflows, which is helpful when multiple workflows use a similar view, but the workflow itself
differs and should not be copied (e.g., onboarding and maintenance workflows).

£ View Editor (23]

Edit

Editor [xm -

=B view:
i EE Column: .

[IT attribute: Da 5] view Editor —
ifj Aspect: id .

iij Aspect: name
- Ejg Column:Who Approved:
(-5 view: Review Data

(-] view: Confirm data

g Data Mapping

|<?:-crnl version="1.0" encoding="UTF-58" standalone="yes"2:>

lm | »

[].. View: End State <nsz2:workflowWiews xmlns:nsz="http://vyw.stibo.com™s>

-----Eh‘lapping:lniﬁateDab—blr‘li <wiew id="Initial Data"™ defaultiortColumm="0" automaticiort="false™:>

E Mapping : Review Data->Re <oolunn name="Chiect” readOnly="false" mandatory="false":>

E Mapping : Confirm data->Ce <plugin pluginID="VorkflowlinkedName">

E Mapping : End State->=End £ <parameter id="ClassificationEditor™ wvalue="Classification™/>

<paraweter id="FlannedFPageEditor™ walus="Flan™/>
<parameter id="AttributeEditor"™ walue="Attribute™/»
<paraweter id="AssetEditor”™ wvalus="hsset"/>
<parameter id="EntityEditor™ waluse="Entity"Sx
<parameter id="ProductEditor"™ wvalue="Product” />

</pluginz

< oo lumns
4 1l | »
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Configuring Mappings for Workflows

This topic details how to map a view to a workflow state (or states), as well as how to map views to specific users
or user groups. Without views and mappings configured, all states in the workflow are displayed on the STEP
Workflow navigator tab (including parallels, clusters, and final states). When a workflow includes automated,
system, parallel, and/or cluster states, and users will be interacting with the workflow in the STEP Workbench, it is
recommended to have mappings in place so that only the user states (e.g., states in which a human must interact)
are present on the STEP Workflow tab.

Prerequisites

A workflow has been created and one or more views have been created for the workflow. This is required because
the mapping task serves to connect any given view to a particular state or set of states. Therefore, for the exercise
to be meaningful, both the view(s) and the state(s) must already exist. Also note that the views must have an ID
assigned, else they will not be available for selection in the mapping. For more on creating views, see the
Configuring Views for Workflows topic.

Configuration

1. Toadd mapping to a view, right-click the editor panel on the left hand side anywhere, and select Add
Mapping.

£+1 View Editor =

Edit

Editor [xm

=& view: Initial Data
- B Column:Object (WorkflowLinkedName)
“-[|T attribute: Date

-

Add View
| AddMapping |
Add Mapping Group

2. Intheright-hand panel in the View Editor window that appears, select the state from the dropdown for which
you want to apply a view.
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£+1 View Editor
Edit

=& view: Initial Data

Eg Column:Cbiject (WorkflowLinkedMame)
- =[]I attribute: Date
- E Mapping : Initiate Data-=Initial Data

Mapping

State Initiate Data

view ||
Initiate Data
Review Data

Confirm data
End State
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3. Fromthe View dropdown, select the view that you would like to apply to the state.

P

£+9 View Editor
Edit

(3]

=& view: Initial Data

E Column:Cbject (WorkflowLinkedame)
- =[]T attribute: Date
- E Mapping : Initiate Data-=Initial Data

Mapping
State | Initiate Data |
View Initial Data v

Initial Data

-

4. Repeat the above steps as many times as needed so that each state requiring human interaction has a view
assigned to it. Note that the same view can be applied to multiple states.

5.

Sequence the mappings in the appropriate order by right-clicking on a mapping and selecting 'Move Up' or

'Move down'. Sequencing of views is important as this defines the order in which the views are presented to the
user on the STEP Workflow navigator tab. Mapping sequence is typically assigned alphabetically or
sequentially (e.g., the first state in the workflow is sequenced first).

41 view Editor
Edit

=-&] view: IDandName
... View: Review Data
----- View: Confirm Data
E Mapping : Initial-=IDandMame

E Mappinn * Review Data-=Review Data

Move Up

Mowve Down

Delete

firm Data
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6. Save the workflow, exit the STEP Workflow Designer, and go to the STEP Workflow navigator tab.

7. Select the workflow for which view and mapping is being created and expand the flipper. When the flipper is
open for the workflow, only the states for which a mapping was created are visible.

%' Order Process

e (sl

ollection E]

Initial 0
0

0

ter by ¢

Review Data
Confirm Data

Workflow User / Group Specific Mappings

Itis possible to create mappings that only apply to specific users or user groups. The mappings of a particular
workflow could be configured so that only users in a specific group can see a given state (e.g., only administrator
users have access to automated and system states to intervene in case of errors), or so that users in a specific
group could see tasks within the same state with different views (e.g., an end user may need to see different data

than an administrator).

1. Tocreate user/ user group specific mappings, right-click the left panel in the View Editor, and select Add

Mapping Group.

i

F+1 view Editor
Edit

Editor |x|u|i

-

[l

#-E view: Initial Data

-- View: Review Data

-- View: Confirm data

-] View: End State

----- E Mapping : Initiate Data-=Initial Data
----- E Mapping : Review Data-=Review Data
----- E Mapping : Confirm data->Confirm data
15 Mapping : End State->End State

Add View
Add Mapping
Add Mapping Group

2. Select the user(s) and/or group(s) you want the mapping to apply for. Note that there are separate fields for if a

group is added verses a single user.
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£33 view Editor
Edit

-] View: Initial Data Mappings
-] view: Review Data

- =] view: Confirm data

- =] view: End State

----- E Mapping : Initiate Data-=Initial Data E] Include all sub groups
----- E Mapping : Review Data-=Review Data

----- E Mapping : Confirm data-=Confirm data Search

..... ‘% Mapping :.I:_:nd 513}1:&—:=Er1d State - SDK and API users e
gs: (empty. rﬁ. Stibo Uszers

[+-<%h Super Users
[+-<% Suppliers

Users - Details

&

Groups [ Include all sub groups

[
[
[
[

i

X[

|

1

Select Cancel

X E)

If the Include all sub groups is checked, any subgroups within the group, as well as direct users in the group
will have access to the view.

Mappings
Groups I [+ include all sub groups: I

User Group E]

In the example below, if the Include all sub groups option was checked and User Group was selected, this
would include User Group 2, its child User 3, as well as User 1, and User 2.
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ra

E] Include all sub groups @
Search |

£
£

A [.m

[+ Web UI Group

& Details

[ Select ][ Cancel

If the Include all sub groups box is unchecked, only the top level users directly in the group have access to
the view. For example, with User Group selected, only User 1 and User 2 would have access to the view as

they are the only direct user children of the selected group.

.

ra

E] Include all sub groups @
Search |

(#1722 Super Users
[+-<#1) Suppliers

T

% Web UI Group

- Details

[ Select ” Cancel

3. When all users or groups are added, right-click on the Mappings: empty node and select Add Mapping from
the context menu.

© Stibo Systems - Confidential - Release 10.0-MP3 (October 2020) 72



P

F+1 view Editor
Edit

Editar |x|u|i

- & view: Initial Data

-] view: Review Data

- =] view: Confirm data

- & view: End State

----- E Mapping : Initiate Data->»Initial Da
----- E Mapping : Review Data-=Review [
----- E Mapping : Confirm data->Confirm
----- "I5] Mapping : End State->End State

..... E Mam,'nnn- Fermmda
Add Mapping

[
[
[
[

Move Up

Delete

4 T 3

Mappings

Groups

[ Include all =ub groups

Super Users

Users

L

X E)

[

StiboSystems

MASTER DATA MANAGEMENT

4. This will bring up the States and Views dropdown menus to choose from (as with configuring a standard
mapping). Select the appropriate state and view for the user or groups to have access to. Close the View
Editor and save the workflow.

P

£+1 View Editor
Edit

Editor | XML

.

(=3

=& view: Initial Data

(|3 Attribute: Date
%) Aspect: id
L] Aspect: name

EEI-- View: Review Data
#-& view: Confirm data
& view: End State

i EJ2 Column:Object (WorkflowLinkedMame)

B2 Column:Who Approved? (WorkflowVariable)

----- E Mapping :

----- E Mapping :
----- E Mapping :
----- E Mapping :

|';‘|1_§_| Mappings:
15 Mapping : Review Data->?

Initiate Data-=Initial Data
Review Data-=Review Data
Confirm data-=Confirm data
End State->End State

{1 state)

Mapping
State Review Data
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Itis important to note that when a state is mapped to a view both inside and outside a mapping group, and a user
logs in who is either directly specified on the mapping group, or member of a group that is specified, the mappings
will be evaluated from the top down and the first one that matches will be used. In other words, if the same user is
in two different groups with different privileges, but both groups are mapped to the same state, then whatever
group comes first in the mapping dictates the allowable privileges for that user. Thus, the order of mappings and
mapping groups is significant and mappings must be sequenced appropriately.
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Working with Tasks in Workflows

This set of topics focuses on the end user, e.g., the user working with tasks in a workflow in the workbench, rather
than the user configuring and/or designing a workflow. After reading these topics, a user should be able to access
workflow tasks, edit data on objects in a workflow, and submit tasks through the assigned states in a workflow.

Topics covered in this section are:

« Moving Tasks through a Workflow in Workbench
« The State Log Tab
« Workflow Search Criteria

While concepts remain the same across workbench and Web Ul, the interfaces differ. For information specific to
Web Ul, see the Workflows in Web Ul section of the Web User Interfaces documentation.
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Moving Tasks through a Workflow in Workbench

In order to move an object or task through a workflow in workbench, it first must be initiated into the workflow. This
then allows the task to be addressed accordingly through each state in the workflow.

Should a user wish to initiate a task in a workflow in Web Ul, see Moving Tasks through a Workflow in Web Ul
in the Web User Interface / Web Ul Setup and User Guide documentation.

Supplier Users

In a workflow, supplier users can only see objects that are directly linked to their supplier classification. Objects
that are children to blue folders within a classification folder are not available to supplier user workflow tasks. For
example, in the following image, the speaker products are not available for workflow tasks because they are child
objects to the 'Surround Speakers - Zeta' product folder. The 't-shirt' objects can be worked as tasks because they
have a direct link to a classification folder.

Tree

EIFj Suppliers
[+ T] Acme Compary

EH[T] Products Galore
rj Assets

For more information about a supplier item Web Ul, see the Supplier Web Ul topic and the Supplier Web Ul
Setup Guide topic, both in the Web User Interfaces / Web Ul Getting Started documentation.

Initiating the Object into the Workflow

The below process describes how to manually initiate an object into a workflow. However, it is important to note
that oftentimes workflows will be configured to automatically initiate objects of a certain type or types into the
workflow upon creation of the object. In addition, workflows can be initiated by a variety of other actions or
processes (both automated and manually initiated), such as business rules, imports, or bulk updates.

To manually initiate an object into a workflow:

1. Navigate to the Tree tab and select the desired object. Right-click and select Initiate in STEP Workflow.
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{13 Furniture Unlink product
-7 Bedroom

=1 Beds 8 Cut
El- Eledsc : Copy

o Paste

Paste Link

Delete
[+ ij.ﬁ.utomutl'ue Ea Duplicate

[ STEP Workflow ” Bookmarks ” System Setup ]E

& r—=| Building Products EE] DuplicateRecursively
= 7] Lumber
B r_=| Pressure T Add Children To Override
E} ‘ Pressy Remowe Child From Owverride
Approve Object
. [0 Press. Partial Approve...
[T Sealers/Fillers Check Approve

[+-{{7] Electrical & Electre _
&[] Food and Beverag Approve Recursively
=-[I7] Kitchen

- Wedding Search Below

[#-{17] Party Supplies ik Export Data Below

LIS Discontinued Products  lynitiate in STEP WaorkFlow

2. Inthe dialog that appears, select which workflow to initiate the object into. Note that only workflows that the
object is valid for appear, and any workflows that are disabled indicate that the object has already been initiated
into those particular workflows.

Ft] Initiate in STEP Waorkflow e

) Workflow

Sample Workflow (started) |

[, |

@
=
g
&
[=]
s
%
1

Process Mote

[ oK H Cancel

If desired, the user can enter a Process Note when starting the workflow. This note is posted to the object's State
Log.

See the State Log Tab section of the Workflows documentation for more information.
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Processing Tasks in a Workflow

Once an object is initiated in a workflow, it is available in one or more states of the workflow. Each instance of an
object in a state represents a task to be completed. Each state is assigned to a particular user or group who has
the responsibility of completing the tasks in that state. Because of this, tasks are most often accessed via the states
themselves, rather than via the objects in the states. The STEP Workflow tab allows users to see tasks in the
states to which they have privileges to access. The Tasks tab on an object allows users to see all tasks for a given
object, across multiple workflows. Both options are described below.

STEP Workflow Tasks Tab

STEP offers a task list in the workbench that shows all tasks assigned to the current user (either directly to the user
or to a group of which the user is a member). This is the primary interface for working with workflows in the
workbench and displays all workflows that the user has the 'View and use STEP Workflow' privilege for. When
any workflow flipper is expanded, a list of the configured states is displayed, with an object count displaying the
number of tasks in the state that the user has access to.

STEP Workflow

Profile

©- publication Sections o
== Sales Item Creation

%' Sample Workflow

]

Review Data
Review Images
Gather Data

Gather Images

m

Review
Start

mcﬁwGwEl

Note that only tasks that are available for the user are displayed. For example, a user who is not part of a group
that can process tasks in the Review Data state will see a count of zero (0) rather than three (3).

Note: A legacy 'Advanced' sub tab is available (in addition to the Tasks and Profiles tab shown in the above
screenshot). To see the tab, the user must have the 'View STEP Workflow Advanced tab' privilege and the
configuration property 'STEPWorkflowNavigationXMLConfigurator.File' must point to a valid configuration file.
Such afile is included in the STEP distribution and is unpacked to "STEP_HOME/config-
examples/workflow/workbench-navigation.xml" when the application is deployed. If enabled, this tab lets users
search for specific tasks based on workflow, state, assignee and a set of configurable search criteria. The tab
gives access to see tasks assigned to other users and thus primarily should be used by administrators. Similar
functions are available within the standard search functionality for workflow tasks, which honor privileges so it is
generally advised to use those instead. For more on using the Search tab see the Workflow Search Criteria
topic. In addition, the Profile tab is used for monitoring workflows and is described within the Monitoring
Workflows section of the Advanced Workflow Topics material.
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To work with tasks via the STEP Workflow tab:

1.

Navigate to the STEP Workflow tab, expand the flipper for the desired workflow, and select the appropriate
view. There are three options to choose from:

3 Sample Workflow

|§I_? | s)(s)

« Show All (triple user button): All tasks are displayed. This button is only available if the user has 'STEP
Workflow Administrator' privileges for the workflow.

o Show Group (double user button): Tasks assigned directly to the current user or to a User Group of
which he /she is a member are displayed.

« Show User (single user button): Only tasks assigned directly to the current user are displayed.

Note: By selecting the Show Group (double user button) icon, users that have the 'View task assigned to other
users in my group(s)' privilege are able to view their assigned tasks, as well as any tasks assigned to others and
any unclaimed tasks within any group in which they are a member. For more information about workflow
privileges, see the Workflows section of the Setup Actions topic in the Action Sets documentation.

Additionally, a user can further refine the task view by using the 'Filter by Collection’ option. If a collection has
been previously set up, click the ellipsis button (...|) to select that collection will filter the task list to display only

tasks for objects contained in the collection. For more on creating collections, see the Collections
documentation.

With the appropriate view selected, click the link for the state in which tasks should be accessed. This will
display the tasks in the state according to the view configured by the workflow administrator, allowing users to
review and/or edit data as needed. Cells in yellow are read-only, while white cells can be edited. Red cells may
be present and are considered mandatory and should be populated prior to submission, though the system
may or may not prevent transition of the task if they are not populated (based on how the designer has
configured the workflow).

Some workflows require tasks to be claimed before they can be updated by a user. This can be verified by the
presence / absence of a task claiming icon (| ] ). If this is present in one of the columns on the STEP

Workflow Items tab, see the Claiming and Releasing Tasks in Workflows section of the Advanced
Workflow Topics material for additional information.

Note: Ifitis preferred to see in the objects listed in columns instead of rows in the STEP Workflow ltems
editor, right-click the table header and select 'Rotate Table'.
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STEP Workflow L 4 STEP Workflow Items

Profile R R VAT A LIRS E | Products || References || Referenced By
] Z - D > |Name * [Description, Table  * |DescriptionLong = *
? L 30's Slasher Game » [131542 80's Slasher Game
@ i l Cosmic Harror Game * [131530 Cosmic Horror Game
Space Adventure Game  * (131536 Space Adventure Game
3 [Filter by Collection E] P pa
Review Data 3 4 1
Review Images ] .Approve -] m

b T

Note: The STEP Workflow Items editor will as a default show a maximum of 100 tasks / objects when you
select a state on the Tasks sub tab. This limit can however be changed by a system administrator via the config
property "STEPWorkflow.Assignee.TaskList.Max".

. Submitting a task to a subsequent state indicates that work on the task is complete. Unless the user has access
to a subsequent task for that object, it will no longer be accessible for them in the workflow. To submit a task,
select the task (multi-select is enabled using Ctrl + click), choose the appropriate selection from the dropdown
(if applicable) and click Submit. The available options for selection are configurable based on the design of the
workflow. In some cases only a single selection will be present and therefore it is not required for the user to
select a specific transition.

< STEP Workflow Items
Products || References | Referenced By
D

> IMame » |Description, Table * DescriptionLong *
80's Slasher Game » 131542 80's Slasher Game
Cosmic Horror Game * (131530 Cosmic Horror Game
Space Adventure Game * 131536 Space Adventure Game
1| i [

e ][ simi

pprove

. Adialog will appear, allowing the user to input a comment, which will be recorded in the Notes field on the State
Log tab of the object. Note that if multiple objects were selected, the same comment will be applied to all. From
the dialog, click the Submit Now button to complete the task, or click Cancel to return to the STEP Workflow

Items editor.
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E] Submit itemns

Submit message |

Description |5TEP' Workflow

submit Now |

Cancel |

5. Clicking the Refresh button in the Task pane will update the task list.

STEP Workflow

Profile

STEP Workflow Items

SRR TR L B | Producks || References || Referenced By

I—IL_.II-I

» |Mame ¥ |Description, Table >
20's Slasher Game > 131542 80's Slasher Game
Space Adventure Game * (131536 Space Adventure Game

Filter by Collection

Review Data

Review Images

Tasks Tab on an Object

From an objectin Tree, the Tasks tab displays all tasks across all workflows for that object, subject to the user's
privileges. Only tasks that the user has rights to address are visible.

Tree

[ | Haraware
{7 Displays

[H-{IZ] Furniture

Commercial || Tables || Category Profile || Proof Wiew || Status || State Log

Space Adventure Game rev.0.7 - Tasks

Product

|

Sub Products

References Referenced By

| |

-

-7 Automotive
r_=| Building Products
E|1“_=| Electrical and Electronics
i [I=) Electronic Accessories
t}-[[T] Wire & Cable
E||j Game Software

|“_=| ¥box One

Iél rj Playstation 4

= E Flaystation 4 Games

Cosmic Horror Game

Bloodbarne

Space Adventure Game
80's Slasher Game
Destiny

Until Dawn

Game A

m

Game C

Game 1

Game 2

Game 1
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The interface and interactions are comparable to that of the task list, with the only difference being that users can
expand or collapse flippers to access tasks in various states and workflows.
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State Log Tab

Any object type for which a workflow can be configured has an editor tab named State Log. This is useful for
tracking the recent history of an object across all workflows that include the object. Initiating an object into a new
workflow creates a flipper under which recent history is housed for that particular workflow.

All transitions, assignments, notes, and status flags are displayed with a row in the table. For each entry there is a
timestamp, a log type, and the name of the user causing the entry. Note that only the latest 50 entries per workflow
are displayed.

The following checkboxes filter the state log, allowing a user to view only the necessary information for the object
in the workflow indicated by the flipper. At least one checkbox must be checked for the workflow information to be
displayed.

Show transitions: when checked, the 'transition' log type entry is displayed, adding data for the 'To State'
column, in addition to the 'From State' column.

Show assignments: when checked, the 'assignment’ log type entry is displayed in the 'Assignee’ column,
showing the user to whom the task has been assigned.

Show notes: when checked, any notes entered while transitioning from one state to another are displayed in
the 'Note' column.

Show status flag changes: when checked, the 'statusflag’ log type entry is displayed, adding data for the
'Status Flag' column.

Hide Parallel and Cluster States: when checked, any states in a workflow which has Parallel or Cluster
states are displayed. Since entering and leaving parallels and clusters result in a lot of entries, this option allows
you to reduce the number of rows displayed for those types of workflows.

The log does not reset with every new workflow instance. Thus, if an object has been removed from a workflow
and then later initiated into the same workflow again, entries from the first instance continue to display.
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< State Log
Product || References || Referenced By || Images & Documents || Commercial || Tables || Category Profile || Proof View || Status |BELGLl By ﬁ

¢ leadPpePumbingCheck

[+#] Show transitions ~ [#] Show assignments ~ [/] Show notes  [+] Show status flag changes [] Hide parallel and duster states
mime * |User *» Event » |From State *> [To State * |Note » |Agsignee » [Status Flag »> |Log Type >

> | 2017-04-1909:23:27  LUSER)] Lead Free LUSER] assignment

> [2017-04-19 09:23:27  USERJ] Proceed Review Data Lead Free transition

» | 2017-04-1909:23:27  |JSER] Lead Free Law statusflag

> | 2017-04-19 09:23:09  SER] Review Data LUSER] assignment

» [2017-04-19 09:23:09  USER] Proceed Gather Data Review Data transition

> (2017-04-19 09:23:09  USER] Review Data Laow statusflag

> | 2017-04-19 09:23:03  LUSER] Gather Data USER] assignment

> | 2017-04-1909:23:03  USER] Proceed Start Gather Data transition

» | 2017-04-1909:23:03  |USERJ Gather Data Low statuszflag

¥ | 2017-04-1909:09:20  USER] Start LISER] assignment

> | 2017-04-19 09:09:20 USER] Start transition

¥ | 2017-04-1909:09:20  USER] Start Low statusflag

§Reassign

[] Show transitions ~ [#] Show assignments  [/] Show notes  [] Show status flag changes [ Hide parallel and duster states
Time * |User » |Ewvent * |From State * [To State » |Note » |Assignee  * |StatusFlag  * [Log Type *»

> | 2017-04-23 12:10:54 LUSER] Wark IUSER] assignment

> |2017-04-28 1:10:54  USER] Start Work mﬁx :3&?;:;?: added transition

» |2017-04-28 12:10:54  |JSERJ Work Low statusflag

» | 2017-04-23 12:10:29  USER] Start LSER] assignment

> | 2017-04-28 12:10:29  USER] Start transition

* | 2017-04-28 12:10:29  LUSER] Start Low statusflag
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Workflow Search Criteria

The STEP Workflow Search criteria lets a user search for:

1. Objects that are in a specific state in a specific workflow
2. Objects that are in a specific workflow but could be in any state
3. Objects that are valid for a given workflow, but are notin it

These options are helpful because they allow users to interact with workflows more efficiently. For example, if a
user wants to update a group of items that are already in a specific workflow, they can use search to identify the
items in a particular state and perform a bulk update on all objects. Additionally, if a user wants to see which items
are valid for a particular workflow and which have not yet been initiated they can do so. All of these options assist
users when working with workflows.

Performing a Search with Workflows

Below is an example of how the Search tab can be used for workflows.

1. Navigate to the side Search tab and click on it. A dropdown is present to specify search criteria.

Search ;]
= Advanced T
(2a [ Reset ] [ Search ]
Show Details
[ Mame ]

2. Click onthe dropdown and select STEP Workflow.
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3. When the STEP Workflow criteria is selected, two parameters are available for a user to specify workflow and
state. A workflow must be selected, but selection of a state is optional. Also note the bracketed options in the
State parameter - allowing for users to identify all objects currently in the workflow, or all objects valid for the
workflow but not currently active in it.

(1) |

B Processes

STEP Workflow ;]

STEP Workflow :Shipment Order Process

I

Search

[any State]

Approve Data
Items packaged

[not in STEP Warkflow]

ame Initiate Data
Review Data
Confirm data

m

4. When the options have been selected, click on Search to run the search and view any results.
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Search Result Profiing
STEP Workflow _ [
STEF Workflow _Shipmerlt Order Process - Search Re=zult Pruﬁ"ng
State Review Data =
: : 2 hit(s)
Click links to narrow down search
EE Reset || Scarch
Displaying 2 of 2 results Show Details .
Name Results by Object Type
. BI“E Hat /D = 20505 Product {2} - exclude
* i Yellow & Pink part for flashlight D = 73500

EHEH"I (2} - exclude

Results by Position in Tree Hierarcl
Results by Parent

|jF’rnduc15 f'ﬂ - exclude
[C1Templates (1) - =xcluds

Il Flashlights ltems (1) - ssxclude
Bl Hats and Caps ltems (1) - =xclude

If a user is checking to see what tasks are in a state, they can also verify the results by going to the Tasks sub
tab in the Step Workflow tab. See the Moving Tasks through a Workflow in Workbench section of the
Workflows documentation for more information.

STEP Workilow P Workilow Items
Profile AT BRI E | Products || References || Referenced By
% Shipment Order Process * Workflow Task Column * |Assignes »
e [ ] | | | | Yellow & Pink part for flashlight » ﬂ:] Group : User Group
Filter by Collection E] Blue Hat > @) User : UserL
Initiate Data 22
Review Data 2
Confirm data 70
Approve Data 3|2
Ttems packaged 1[0 4 o
End State 1 Proceed 2 Submit
= sOneButton 1 il

5. Ifthe search is not as refined as needed, a user can add additional search criteria by pressing the green +
button, , and further filtering the results. For example, the workflow criteria could be combined with the
Search Below criteria to isolate objects in a particular category.

For more information on the various search criteria and/or the actions that can be taken with a set of search
results, see the Search and child topics in the Getting Started / User Guide documentation.
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Managing Workflows

When a workflow is selected from the System Setup tab, various settings for the workflow can be viewed and/or
edited (if applicable) on the different tabs. These settings help in giving valuable information in regards to the
particular workflow such as an overview of the workflow, what the workflow is valid for, a list of users who have
interacted with the workflow or made changes, and any revision history.

To view the workflow tabs, go to System Setup, expand the workflows node, and select the relevant workflow.
This opens the workflow in an editor. Note that workflows viewed in the Approved Workspaces are read-only.

STEP Workflow Editor Tab

The STEP Workflow Editor tab displays basic information about the workflow, as well as providing some global
configuration options for the workflow.

[ sTee Workilow eior |G BTy

Mame *| » |Value

> D SampleWorkfiow

> MName Sample Workflow

> Revision 10.65 Last edited by USERS on Wed Jul 13 10:42:18 EDT 2016
> Initiate automatically

» Listen on updates from import

> Use executing user's write privileges

oogE

> Dizable transitions on terminated Workspaces
» Start Condition
'? Used Local Business Rules
Title > |State » |STEP Workflow Component > [Description >
» (@am-4b3d2546-f7d-4081-39b2-d5ed1a703b8a) Review Data -> Gather Data On transition Execute var instjinst = node.getWorkflowInstan...
> (am-513c2626-7885-9abd-90ac-e4151991b0d2)  Enrich Data On exit Execute var instjvar task;
> (am-6e357627-6267-4a%e-864c-6d83199ee1ed) (Gather Data -> Review Data 0On transition Execute var instjinst = node, getWorkflowInstan. ..
@ Used Global Business Rules
Title > |State > |STEP Workflow Component *> |Description >
> Multiplayer Condition Review Data Conditionally mandatory Attribute True if if(attr == "Yes™) {return true;
9 Workflow Privileges
Applies to > |Action Set > |Attribute G... > |Object Type > |Group > Language > [Country >
Add Privilege

For more information on the basic settings, see Creating a Workflow in the Workflows documentation.

The STEP Workflow Editor tab also has two flipper areas that show an overview of the business rules used in a
workflow: 'Used Local Business Rules' and 'Used Global Business rules'.

The Workflow Privileges flipper displays state-specific privileges for the workflow, which can be edited from the
Privilege Rules tab on a User Group, or from this interface. This functionality is useful when a particular user group
should have access to data only when an object is in the indicated state. For example, a user group may have
rights to edit certain data only when accessing the data from a particular state or an onboarding / creation workflow
or a maintenance workflow, but can only view the data for objects not in the editable workflow states.

To edit the workflow privileges, click on the Add Privilege link, and select the state that the particular privilege is to
apply to from the drop-down menu in the pop-up window.
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E3] Add Privilege Rule
Workflow state | 1st State

Action Set:
Attribute Group:
Valid for Object Type:

Apply to Group:

Dimensions:
Language | ANY
Country AN S

II» BBB@«E

Save Cancel

Once the state has been chosen for which the privileges should be applied, it is then possible to set up the various
options to set the privileges for that particular state. Complete configuration information for workflow privilege rules
is provided in the Editing Privilege Rules section of the System Setup / Super User Guide documentation.

Note that if workflow privileges are applied to a state, a 'P' indicator will appear on the state within the workflow

editor: (e e Data &

Validity Tab

The Validity tab allows for specification of which object types the workflow is valid for. Only objects of the selected
types can be initiated into the workflow. Notice that while a workflow can be made valid for multiple object types of
a specific node type, it cannot be valid for object types of different node types. For example, a workflow can be
valid for multiple types of entities, but not for both entities and classifications.
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[] Account
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[] all Customers
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2= yalid for List of Values Types

@ yalid for Asset Types

@ Valid for Product Types

== yalid for Publication Types

@ Valid for Publication Planned Page Types
@ Valid for Publication Section Types
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The Log tab is a list of dates and times when changes were made to the workflow. Listed with each time stamp is

the user who made each change.

STEP Workflow Editor || Validity Status

Showing page 1of 1

2015-12-11 10:57:53 "USER": Madified
2015-12-11 10:57:53 "USER": Madified
2015-12-11 11:15: 38 "USER": Modified
2015-12-11 11:15: 38 'USER": Modified
2015-12-11 11:18:03 "USER": Madified
2015-12-11 11:18:03 "USER": Madified
2015-12-11 11:29: 31 'USER": Modified
2015-12-11 11:29: 31 'USER": Modified
2015-12-11 14:54: 14 "USER": Madified
2015-12-11 14:54: 14 "USER": Madified
2015-12-11 15:01: 56 "USER": Modified
2015-12-11 15:01: 56 "USER": Madified
2015-12-11 15:54:05 "USER": Madified
2015-12-11 15:54:05 "USER": Madified
2015-12-22 14:05:42 "USER": Modified
2015-12-22 14:06:42 "USER": Modified

Status Tab

The Status tab provides an overview of the revisions of the workflow, including the user who changed the object

and when the change occurred.
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Revision Created ¥ |Edited » |Major ¥ | Jser ¥ |Comment >

¥ (1.1 Sun Jan 04 20:29:47 CET 2015 5un Jan 04 20:29:45 CET 2015 STEPSYS  MWorkflow updated

* (L0 Thu Dec 11 12:35:47 CET 2014  [Thu Dec 11 12:35:47 CET 2014 " STEPSYS [ made a major revision

» 0,14 Thu Dec 11 12:34:53 CET 2014  [Thu Dec 11 12:34:53 CET 2014 STEPSYS  MWorkflow updated

* 0.13 Thu Dec 11 12:34:06 CET 2014  [Thu Dec 11 12:34:06 CET 2014 STEPSYS  MWorkflow updated

» 0,12 Thu Dec 11 12:26:55 CET 2014  [Thu Dec 11 12:26:55 CET 2014 STEPSYS  MWorkflow updated

¥ 0,11 Mon Dec 01 14:55:05 CET 2014 Mon Dec 01 14:55:05 CET 2014 STEPSYS  Changed Warkflow Definition
* 0,10 Mon Dec 01 14:52:15 CET 2014 Mon Dec 01 14:52:15 CET 2014 STEPSYS  Auto Generated

* 0.9 Mon Dec 01 14:44:55 CET 2014 Mon Dec 01 14:44:55 CET 2014 STEPSYS Complete approval

* 0.8 Mon Dec 01 14:39:11 CET 2014 Mon Dec 01 14:39:11 CET 2014 STEPSYS  Changed Warkflow Definition
* 0.7 Mon Dec 01 14:39:08 CET 2014 Mon Dec 01 14:39:08 CET 2014 STEPSYS  Changed Warkflow Definition
* 0.6 Mon Dec 01 14:38:53 CET 2014 Mon Dec 01 14:38:53 CET 2014 STEPSYS  Changed Warkflow Definition
* 0.5 Mon Dec 01 14:37:34 CET 2014 Mon Dec 01 14:37:34 CET 2014 STEPSYS  Changed Warkflow Definition
* 0.4 Mon Dec 01 14:37:08 CET 2014 Mon Dec 01 14:37:08 CET 2014 STEPSYS  Changed Warkflow Definition
* 0.3 Mon Dec 01 14:35:35 CET 2014 Mon Dec 01 14:35:35 CET 2014 STEPSYS  Changed Warkflow Definition
*» 0.2 Mon Dec 01 14:34:41 CET 2014 Mon Dec 01 14:34:41 CET 2014 STEPSYS  Changed Warkflow Definition
* 0.1 Mon Dec 01 14:34:41 CET 2014 Mon Dec 01 14:34:41 CET 2014 ETEPSYS
- Hidden values
=~ Diagnostics

Revisions are created when the workflow has had edits made to it in the STEP Workflow Designer, and the
designer is saved and closed. Minor revisions are made automatically when various users interact with the same
object.

Major revisions can be made on both the object initiated in the workflow or the workflow itself. It is recommended
to make a major revision for a workflow each time a set of changes has completed. For example, it may be useful
to make a major revision when UAT begins for a workflow so it is clear what is being tested, and again upon
completion of UAT so that it is clear what has been released for production. To do so, click on the workflow in

System Setup, and select Make Revision from the Maintain menu.
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File Edit View MNavigate Format Maintainﬂduw Help

Context |English US Insert C
Link r
@ Merge »
= Clerical Review 2
T (8] Condition Action Wor 7 Delete
% EE}-- Contact Workflow Force Delete & Purge
i EE}-- Confract Agreements Unlink Object Type
| E}- Contract Agreements
o g
o Critical EE) Duplicate Ctrl+]
] Discontinued State : :
=] Duplicate Recursively
ol FU Errar
LD
[¥]
—

E}- Flatplan group assign Make Revision e

Rl Flatnlznnar

Previous versions of STEP Workflows can be viewed by selecting the revision on the Status tab, right-clicking on
the row indicator (>), and selecting View STEP Workflow.

| STEP Workflow Editor || validty || Lo ||ESGGH
2 Revisions
Revision » |Created > |Edited >
> 0.3 Tue Mar 22 09:45:23 EDT 2016 |Tue Mar 22 09:45:23 EDT 2016
0} 2 Thu Mar 03 09:33:17EST 2016 Thu Mar 03 09:33: 17 EST 2016
15 Cut Ctr+X |Mar 03 09:32:51EST 2016 [Thu Mar 03 09:32:51 EST 2016
¢ Copy Ctrl+C
0 [B Paste Ctrl+V
Paste Link Ctrl+L
Purge
View STEP Workflow 9

Purging Workflow Revisions

Any revision can be purged, but once a revision is purged it cannot be recovered.

To purge arevision, right-click on the row indicator (>) next to the desired revision and select Purge.
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| STEP Workflow Editor || validty || Lo ||ESGGH
Y —
Revision » [Created » |Edited >
* 0.3 Tue Mar 22 09:45:23 EDT 2016 [Tue Mar 22 09:45:23 EDOT 2016
“’ 2 Thi Mar 03 09:33:17EST 2016 Thu Mar 03 09:33: 17 EST 2016
138 Cut Ctrl+X  \Mar 03 09:32:51E5T 2016 [Thu Mar 03 09:32:51 EST 2016
P Copy Ctrl+ C
i [B Paste Ctrl+V
Paste Link Ctrl+L
Purge 9
B View STEP Workflow

For more information on the Status Tab and revisions, see Revisions in the System Setup / Super User Guide
documentation.

Deleting Workflows

To delete an entire workflow, right-click on it from the System Setup tab and select Delete.

@qum Do 2 |

| B8] Clericd B Edit STEP Workflow

] @ Condi

B Conta & Cut Ctrl+X
| B8] Contr Copy Ctrl+C

E}'@ Contr Paste Ctrl+V
- Critica

@ Discor »  Delete
ﬂ] Frrar | =~

Deleted workflows will be available in the System Setup Recycle Bin until they are purged (permanently deleted)
or revived (restored to their previous location).

Compeonent Models
El'ﬁ Recyde Bin
- InitonEntry

>[E Customer Web UL Workflow

- 13| Lead Pipe Plumbing C
| 1-[73] Newsnaner Aitn o X Purge
4 i

Revive
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Advanced Workflow Topics

This portion of the material covers more advanced workflow configurations, going beyond the basic setups
described in the introductory material. Users should be familiar with all material in the Getting Started with
STEP Workflows documentation before attempting to configure and/or utilize more advanced workflow
functionality.

Most real-world workflows will utilize many of the functions described in the advanced topics, but none are
required in any particular workflow. The topics generally do not build on one another and completing one
configuration typically does not require knowledge of any other, outside of the basic workflow setup.

In other words, the advanced workflow documentation is function and topic based, meaning that each topic
describes a particular function a user may wish to carry out (e.g., send email from a workflow or remove objects
from a workflow) or a particular topic a user may wish to read about (e.g., workflow attachments or workflow
deadlines).

Therefore, there is no suggested reading order and users should approach the material in the order that seems
most relevant for their workflow.
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Assignees in Workflows

In workflows, an object cannot be in a state without an assignee being set. This regardless of whether the state
represents a human task or not. The assignee must be an existing STEP User or user group.

An important thing to notice when working with assignees is that users who do not have the 'STEP Workflow
Administrator' privilege for a given workflow only will be able to see tasks assigned to themselves or a group they
are a member of. Furthermore, they will only be able to work with tasks assigned directly to themselves and have
to claim a task (i.e., assign it to themselves) to be able to edit workflow related data and perform transitions. Users
with the 'STEP Workflow Administrator' privilege can view and work with all tasks regardless of who they are
assigned to.

Note: For states that do not represent a human task, you will typically want the assignee to be either an
administrator with in-depth knowledge about the workflow or a dedicated 'automation' dummy user.

There are multiple ways of setting the assignee for a state. In the sections below, the options in the Workflow
Designer State Editor are described.

For setting the assignee using the On Entry tab in the State Editor, see the Assigning Tasks Using Business
Rules topicin the Advanced Workflow Topics section of the Workflows documentation.

For more on retrieving user IDs who work with tasks in workflows, see the Retrieving the ID of an Assignee
Completing a Task in a Workflow in the Advanced Workflow Topics section of the Workflows documentation.

Note: Attempting to delete a user who an assignee for a workflow state will result in errors. For more information,
see the Working with Users topic in the System Setup / Super User Guide documentation.
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Assigning Tasks Using Business Rules

While the assignee always will be set using the option selected on the State Editor's Assignee tab when entering a

state, it is sometimes necessary to overwrite the assignee using a business action configured to run in the State
Editor on the On Entry tab.

e

)

E] State Editor @

Edit

|S13te| On Eﬂtf?|AssjgneelDeadIinefEsmIaﬁunlCnmmentsIWeb UI Screen Mapping|Mandatory Attributesi

Business Rule (Local business rule to be saved with workflow) E

Mame Set Assignee
Description [ . |
P E] Edit Operation @
Type Action
" [Exeoute Javascipt ¥
Scope Local Jav

, Binds: ¢ Binds
Run as privileged [ |variable name > |Binds to
Operations encies|Applies if 3|
Merge into Messages: g
|1.-'aria|:ule name » |Message > |Trans|:

pS|

JavaScript:

Edit externally

q 1l | 3

= = [ Save ][ Cancel ]
Add new Business Action

Overwriting the Assignee in Workflows with JavaScript

If the user has the ID of an assignee in a workflow variable, it is of course recommended that the user use the
'Fetch from Variable' option described in the Workflow State Editor Assignee Tab Option section of the
Workflows documentation. If, however, the user wishes to do it with a script On Entry, it can be done with
JavaScript, which can be found in the online version of this topic.
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- (e Tovaser ¥

F#] Edit Operation

Binds: ¢ Binds

Variable name

v

Binds to

node

Current Object

step

STEF Manager

workflow

Current Workflow

&

Messages: § Messages

|Variable name

> |Message > I'I'ranslah'ons

JavaSeript: var instance = node.getWorkflowlInstance (workflow) ;

rar userdhij = step.getUserHome () .getUserByIdiinstcance.getlinpleVariable ("TorkflowWariableHoldingID™) ) »
instance.getTaskByID ("MyState™) .reassign(userchi)

Edit externally

L1

| P

A user should have STEP Workflow Administrator privilege to use this 'reassign()' APl method, however only if the
'Use executing user's write privilege' option on the Workflow Object editor is selected.

s |

Step Workiom edeor | P27 P o
> >

Mame Value
* ID 11123
» Mame Shipment Order Process
> Revision 0.73 Last edited by USERL on Mon May 23 10:45:27 EOT 2016
> [Initiate automatically I
* Listen on updates from import [l
» Use executing user's write privileges )
» Disable transitions on terminated Workspaces [l
» Start Condition
' Used Local Business Rules

Reassigning to Previous Users in a Workflow

If atask is rejected back to a previous state, and needs to be worked on by the same user who initially worked on it
in that particular state, this business rule can be used in combination with On Exit actions to return the correct
assignee.
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In the example below, a user picks up a task in the Edit sate, completes the assignment and submits it to the
Review state. An On Exit business action is in place on the Edit state to store the data of who last worked on the
task in a workflow variable. For more about On Exit scripts see Retrieving the ID of an Assignee Completing
a Task in a Workflow in the Workflows documentation.

Once in the Review state, a different user looks at the task and does not think it is ready to move forward. They
sends it back to the Edit state to be re-evaluated by the user who originally submitted it.

Eclit (L

Subymit Feject

Review

B

Accept

To do this On Entry action of overriding the workflow default assignee back to the user who originally worked on it
in the Edit state, the following script with the corresponding binds need to be putin place:
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E] State Editor @
Edit
Deadine tion |  Comments | \Web Ul Soreen Mapping | Mandatory Attributes
State On Entry | On Exit [ Assignee
wol Regeopemten =
Namq{ [ Execute Javasaip ]
Desq |[Bnds: @ BiRdEL .,
Variable name Binds to
Typs
workflow Current Workflow
Scop)
node Current Object
Run
manager STEP Manager
> b
@ Messages: 4
Variable name » |Message » [Translations
JavaSaipt | yar task = node.getWorkflowInstance (workflow) .getTaskByID ("Edit™);
var reassignlser = node.getWorkflowInstance (workflow) .get3impleVariable ("Released by");
if (reassignlUser '=null)
rar user = wahadger.getUserHowe () .getUserById (reassignlser)
if (user !'=null) {
manager .executellritePrivileged (function (]
task.reassigniuser) ;
Pl
}
i
Edit externally
< | 1 | 3
-

For the JavaScript example, see the online version of this topic.
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Retrieving the ID of an Assignee Completing a
Task in Workflows

In a workflow, it is common to have more than one user interact with different tasks in a particular state. As a task
progresses through the workflow, it is then helpful to know which user last interacted with the task. To help with
this, there is an automated process that can be set to retrieve the ID of the last assignee to a task. This way, should
there be an error with the task and it needs to be sent back to the previous state, it can also be determined on who
the last user was while in that state.

There are two script options that can be used according to user preference. Both are placed on a State Editor on
the 'On Exit' tab. Both scripts can also be combined with a condition to guarantee the user ID is returned, if
desired.

Using Manager Interface to Return the User ID in a Workflow

In the script below, the ID of the user who performs the transition is obtained via the Manager interface ("step"is a
shorthand for getting the Manager). This script retrieves the ID of an assignee and stores it in a workflow variable
which is being represented by "WorkflowVariable" in this case.

var assigneeld = step.getCurrentUser () .getID();

node.getWorkflowInstance (workflow) .setSimpleVariable ("WorkflowVariable",
assigneeld) ;

For the example below, the workflow variable is called 'MyVariable'.
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E21 state Editor @
Edit
| State I On Entryl On Exit | Assignee I Deadiine Escalation I Comments | Web UI Screen Mapping | Mandatary #\ttributes| | _
Business Rule {Local business rule to be saved with warkflow) E §
MName
Description
Type Actic-nr
Scope Local E! Edit Operation @
Run as privieged  [] R —
Operations Binds: 2 Binds
Variable name » |Binds to >
Merge into node Current Object
workfiow Current Workflow
step STEP Manager
i
Messages: 7 Messages
|\."ariable name > |Message > I'I'ranslat'ons >
JavaSaipt: | gy assigneeld = step.getCurrentUser () .getID();

node.getWorkflowInstance (workflow) .setiimpleVariable ("MyWVarishle™, assigneeld):;

4 T | »
Edit externally

Add new Business Ag

L]

To implement this, open up the desired workflow, right-click on the desired state and select Edit state > On Exit >
Add new Business Action > Merge into > Execute JavaScript. Add any necessary binds for the workflow.

One aspect to be aware of is that a user with the 'STEP Workflow Administrator' privilege potentially could have
completed the task while the workflow was assigned to a group, resulting in the group ID being returned instead.
Use the condition mentioned at the end of this topic if returning the user ID only for the workflow variable is a
concern.

Using Task Interface to Return the User ID in a Workflow

Alternately, the ID of the Assignee can also be obtained via the Task interface. This too is implemented by opening
up the desired workflow, right-clicking on the desired state, and selecting Edit state > On Exit > Add new Business
Action > Merge into > Execute JavaScript. Again, replace "WorkflowVariable" with the variable for the workflow,
and add any necessary binds for the workflow.

var instance = node.getWorkflowInstance (workflow) ;

var assigneeld = instance.getTaskByID("MyState") .getAssignee().getID();

instance.setSimpleVariable ("WorkflowVariable", assigneeld);
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Again, an aspect to be aware of is that a user with the 'STEP Workflow Administrator' privilege potentially could
have completed the task while the workflow was assigned to a group. This could result in the ID of a user group
being stored in the Workflow Variable, versus the individual user ID.

For this reason, adding a condition on the transitions out of the state in conjunction with the script on the Task
interface will guarantee that the ID stored in the variable will be an individual user and not the group ID.

Condition to Aid in returning User ID in Workflows

Below is the condition that can be added to the Transitions Editor on the 'On Transition tab' out of the state that is
retrieving the user ID. This condition in conjunction with the script, will make it impossible for a task to exit the state
if the assignee is a group ID. To implement the condition, right-click on the transition > Edit Transition > Condition
> Add new Business Condition > True if value for Attribute™ "null" > Execute JavaScript. Add any binds needed
for the workflow.

var instance = node.getWorkflowInstance (workflow) ;

if (instance.getTaskByID ("MyState") .getAssignee () instanceof
com.stibo.core.domain.Group) {

condition = false;
resultMessage = "Please claim the Task before submitting.";
}
else {
condition = true;
}
E5] Transition Editor 2]

Edit

Evena Condiﬁon|0n Transition|Mandatory Attribuhes*
i W= |

Business Rule {Local business rule to be sa;
m Edit Operation @
Name
[ (Evahiste Javasipt ¥
Description Binds: @ Binds
Type Condition Variable name > [Binds to
Scope Local node Current Object
Run as privileged  [] workflow Current Workflow
Operations DependendeslApplies i} @
_ ) I Messages: ¥ Messages
True if value for Attribute ™ “nul Variable name » |Message > [Translations
Javasaipt | yay instance = node.getWorkflowInstance (workeflow) ;
if (instance.getTaskByID ("Review™) .getlssignee () instanceof com.stibo.core.domain.Group) |
return "FPlease claim the Task before submitting.™;
i
else |
return true;
i
Edit externally

Add new Business Condition ¢ T 3
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If a user wishes to send a task back to a previous state and re-assign it to the user who worked on the task in that
state, see Assigning Tasks Using Business Rules topic in the Workflows documentation.

© Stibo Systems - Confidential - Release 10.0-MP3 (October 2020) 103



StiboSystems

MASTER DATA MANAGEMENT

Workflow State Editor Assignee Tab Options

Every state in a workflow needs an assignee in order for the workflow to work. An assignee can be set for any
state by opening the State Editor and navigating to the Assignee tab. On the State Editor's Assignee tab the
following options for setting the Assignee are available:

£+1 State Editor ==
Edit
Comments | Web UI Screen Maoning | Mandatory Attributes
State | OnEnty | OnExit || Assignee Deadiine/Escalation

i@ Workflow Default
Assign Task to the default Assignee spedified for the Workflow

(") Select User fGroup
Assign Task to selected User or Group

() Fetch from Variable
Assign Task to User or Group read from Workflow Variable,

() Executing User

Assign Task to the User performing the Transition into the current State

[ Show Edited State

Workflow Default
If this option is selected, the state will get the assignee specified as the default for the entire workflow.

The original Workflow Default for the entire workflow is specified by right-clicking the canvas and selecting 'Edit
Workflow', by double-clicking the canvas, or by double clicking the header bar showing the Workflow ID/Name. As
the user will notice, in the dialog that appears on the Assignee tab, it is not possible to select the "Workflow Default'
option. This is because a user or user group needs to selected in order for there to be a default option for any
states in the workflow.
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£+1 Workflow Editor ==

Edit
Assignee Status Flags

¥a|

wWarkfAow Default
WY RITRTIDYY LS TaldlL

Assign Task to the default Assignee specified for the Workflow

@ Select UserfGroup | Super Users (Super user)
Assign Task to selected User or Group

Assign Task to User or Group read from Workflow Variable,

Executing User

Assign Task to the User performing the Transition into the current State

Advanced |

| Show Edited State

While the user does not necessarily have to specify a default assignee for the workflow, if any of the states are
configured to use it, the workflow will not save until a Workflow Default assignee is established.

Select User / Group

Use this option to pick a specific user or user group to function as the assignee.

Fetch from Variable

Using this option it is possible to set the assignee based on the value of a Workflow Variable. When an object is
transitioned into a state with this setting, the variable value must hold either a STEP URL for a user or a user
group, or the ID of a user or user group (If there is a user and a group with the same ID, the user will be selected).

If STEP cannot find a valid assignee from the variable value, the transition into the state cannot be performed and
the user will get an error. As the 'Fetch from Variable' option requires a Workflow Variable to be set before
entering, it is not available when setting the workflow default and neither is it available for Initial states not inside
clusters.

The variable to read the assignee from could be populated by the "WorkflowVariableUserList' view component
(see the Views and Mappings for Workflows section of the Workflows documentation) or could be setin a
business action. An example could be when leaving a state, the assignee for that state is stored. See Retrieving
the ID of an Assignee Completing a Task in a Workflow in the Workflows documentation for an example.

Executing User

Using this option will set the assignee to be the user who performs the transition into the state. Typical use case is
when the individual who created the workflow wants the user who starts a task in the workflow to become the
assignee for the first state. Beware of the fact that if the option is selected for the entire workflow, the user will be
resolved each time a state configured to use the Workflow Default is entered. That is, for each state the assignee
will be set to the user performing the transition into the state, not the user who originally started the workflow.
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Advanced Options

Via the Advanced button on the Assignee tab it is possible to let the assignee be set by an assignee Provider
plugin. These plugins can be customer specific but three are present in the STEP core:

- !

E] State Editor @
Edit
Comments | Web UI Screen Maopina [ Mandatory Attributes
State | OnEntry | OnExit | Assignee | Deadiine /Escalation
@ Workflow Default i
Assign Task to the default A E] Configure Assignee Provider
() Select User/Group | Super | Provider | -
Assign Task to selected User -F‘arame_
SupplierAssignee
() Fetch from Variable KeY  |supplierLinkAssignee
Assign Task to User or Group VariableAssignee
(") Executing User
Assign Task to the User perfol
| (X (m
I Advanced I
[ [ oK ] [ Cancel ] :]

Component Returned Value

SupplierLinkAssignee | Provider plugin for getting a supplier group assignee via a classification link. Only
works for products.

SupplierAssignee Legacy version SupplierLinkAssignee.

VariableAssignee Legacy version of the 'Fetch from Variable' option described above.

Note: The assignee provider plugins generally require that one of the above three default options is selected. This
selection will then be used as a fallback if the plugin fails in delivering a valid assignee.
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Claiming and Releasing Tasks in Workflows

As noted in the Configuring Views for Workflows section of the Workflows documentation, when using the
WorkflowTaskColumn View Component, it is possible for users to claim and release tasks directly from the STEP
Workflow Items editor or the object's Tasks tab. This is important because it allows users to 'check out' a task to
work on, thus preventing other users from taking the task and working on it as well.

For example, when a user clicks the icon in the column labeled Workflow TaskColumn on a task assigned to a
group, in doing so the user has now assigned the task to themselves and opens it for editing.

|[ Products ” References ” Referenced By l

Workflow Task Column > |Assignee » lobject » [Primary Color > |ID ¥
Yellow & Pink part for flashlight ¥ 0"_] Group : Super Users Wellow & Pink part for flashlight 135008
Blue Hat » ,,:;ﬂ_'] Liser : User L Blue Hat Gray 120805

This implicitly makes the task invisible to the other users in the group, assuming that they do not have the "STEP
Workflow Administrator” privilege.

For normal users that do not have a special 'STEP Workflow Administrator' privilege, the following apply:

« The users can only see tasks assigned to them or a user group they are a member of
« The users can only complete tasks assigned directly to them
« The users can only edit workflow specific data for tasks assigned directly to them

Itis important to notice that an object will not be locked when it is active in a workflow. That s, if a user normally is
privileged to edit an object, the user can still do this regardless of how many different flows the object is active in.
Thus, the assignee related restrictions mentioned above only apply to workflow data and functionality.

When atask is claimed, it is possible to release it again, assigning it back to the latest 'Group Assignee'. If the task
has never been assigned to a group, the task is assigned to the default assignee for the state.

Both the claim and release operations are also available through the API Task interface (Task.claim() and
Task.unclaim()).

Claiming a Task in a Workflow
In the following user group, there are two users, User L and User M.

[#--#h Restricted User
/% SDK and API users
(¥ Stibo Users

= Super Users
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User L signs in, opens the workflow, and navigates to the state where he / she can claim tasks. In this case itis the
Review Data state.

STEP Workflow
Profile

Filter by Collection Product

§ Shipment Order Process -
P D D D < STEP Workflow Items -
i Category Prfie | Poot i || staus | e Log | Tas |

STEP Workflow Items [ " Sub Products " References " Referenced By ]

Initiate Data —|Wnrkﬂnw Task Column » |Assignee > lobject > |Primary Color
Review Data 1 Yellow & Pink part for flashlight > |6:] Group : Super Users elow &Pink part for flas...

Confirm data 0

End State [u]

Note: Should a task be initiated into a workflow by a user, the task will be assigned to the User Group in which the
current user resides.

For User L to claim the state, they click on the Claim icon, o , claim the task, ©2), and the assignee automatically
changes to the user who has signed in, in this case User L.

| STEP Workflow Items [ Product " Sub Products "
Warkflow Task Column » |Assignee >
Yellow & Pink part for flashlight > g':] Ilser : User L

Once a task has been claimed, itis no longer visible to other users in the same user group.

Releasing a Task in a Workflow

To release a task, click on the Release icon, éf], and the Claimicon, d:] , reappears. The Assignee column
changes back to the user group the user is a part of, and another individual in the same user group can now see
the task and claim it if needed.

Profile
(o] B D D D fill < STEP Workflow Items i
. Category Profile || Proof View || Status || State Log || Tasks
Filter by Collection E] STEP Workflow Items [ Product ” Sub Products H References H Referenced By ]
Initiate Data of= Workflow Task Column > |Assignee > jobject » |Primary Color
Review Data 1 Yellow & Pink part for flashlight > |6:] Group : Super Users elow &Pink part for flas...
Confirm data 1]
End State 0
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Workflow Re-assignments

Sometimes it is necessary for an individual user or user group to be assigned a task in a workflow to complete
before the task can move on to the next state. For example, a task may be assigned a 24 hour deadline to be
picked up by a particular user. If the task is not picked by the user in that time period, then a business rule can be
configured in such a way that when the deadline is met, either an email can be sent to a manager to re-assign the
task to other user in the user group, or it can be programmed to automatically assign the task to a different user in
the group.

Re-assignments might also be helpful if a task needs to be reassigned from one user to another user when a task
moves from one state to the next.

There are two ways that a re-assignment of a task can take place. Re-assignments can be performed by a user
with the STEP Workflow Administrator privilege either from view and mapping via the 'WorkflowAssignee'
Component or via the API Task interface (Task.reassign(assignee)).

Users without the STEP Workflow Administrator privilege will only be able to complete and edit workflow data for
tasks assigned directly to them. Thus if a task initially is assigned to a user group but a user needs to work with it,
the user must be provided with an option for claiming the tasks, and reassigning it to themselves.

For tasks handled in workbench, a special task view component called "Workflow Task Column’ exists for this
purpose. The component lets users claim a task and also assign it back, or release it, to the initial group assignee.
More information about this is provided in the Claiming and Releasing Tasks in Workflows topic in the
Workflows documentation.

< STEP Workflow Items
Products || References || Referenced By

Workflow Task Column  * |Assignee * phject ¥ [Primary Color > [ID ¥
Yellow & Pink part for flashlight > ﬂ':] Group : Super Users  [ellow & Pink part for flashlight 135008
Blue Hat d Pl User : User 2 + [plue Hat Gray 20805

Group @ Super Users

Iser : User L I

Discussed below is the setup for STEP Workflow Administrators to perform when configuring re-assignment via
the views and mappings option.

For more on API task re-assignment see the STEP API documentation, accessed by clicking the STEP API
Documentation button on the STEP Start Page.

© Stibo Systems - Confidential - Release 10.0-MP3 (October 2020) 109



StiboSystems

MASTER DATA MANAGEMENT

Administrator Privilege Setup for Workflow Assignee

For a user with STEP Workflow Administrator privilege to assign the tasks to different users in a user group, the
component "Workflow Assignee' should be added in the view and mapped to the required workflow state.
For more on views and mapping see Views and Mappings for Workflows in the Workflows documentation.

1. Navigate to System Setup and select the desired workflow. Right-click the workflow and select Edit STEP
Workflow > Edit Workbench Views and Mappings.

I

£+1 View Editor ==

Edit

: Initial Data

: Review Data

- B view: Confirm data

- /&] View: End State

----- E Mapping : Initiate Data-=Initial Data
----- E Mapping : Review Data-=Review Data
----- E Mapping : Confirm data-=Confirm data
'I5 Mapping : End State->End State

2. Right-click the view that needs assignees and select Add Column > Add Component > WorkflowAssignee.

P "

£21 View Editor ==

Edit

#-& view: Initial Data Component
=& View: Review Data Titie

- E Column:Warkflow Task Column (WerkflowTaske

- Bl Column:object (WorkflowLinkedMame) [| Read Only
-[I3 Attribute: PrimaryColor

-%] Aspect: id

-2 Aspect: name

- E Column:Who last Edited? (Workflowvariable)
- EJE Column:Rejection (WorkflowVariable)

- EJ& Column:

[ Mandatory

Component | -

DeDuplication
DTFTaskInfoProvider

— PluginableCellDebug
EEI" View: Confirm datz FluginableCellPrimaryImage

-] View: End State Vendar

----- E Mapping : Initiate Data-=Initial Data M
----- E Mapping : Review Data-=Review Data WorkfAowAtachment e

m

----- Mapping : Confirm data-=Confirm data
----- 15 Mapping : End State->End State

4 1L} I

3. Add any user groups and Users to the component as needed, and title appropriately.
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-

£+1 view Editor =
Edit
Editar |x|u|i
- View: Initial Data Component
= . View: Review Data Title |Assignee
- E|g Column:Waorkflow Task Column (WorkflowTaskColum)
- B2 IColumn:Assignee (WorkfowAssignee) | [] Read Only
- E|g Column:object (WorkflowLinkedMame)
-] Attribute: PrimaryColor 7] Mandatory
R Aspect:id Component | WarkflowAssignee o
-Z] Aspect: name : .
- E|g Column:Who last Edited? (Workflowvariable) Output Var | Who approved? x|
- E|g Column:Rejection (WorkflowVariable) ] Expand User Groups
& . View: Confirm data
B . View: End State Super Lisers
----- E Mapping : Initiate Data-=Initial Data
----- E Mapping : Review Data-=Review Data
----- E Mapping : Confirm data-=Confirm data
----- E Mapping : End State->End State JUser Groups
zer 2
zer L
Uszers

Itis important to note that if the option ‘Read Only’ is checked then the Workflow Assignee column will be un-
editable, and the user with STEP Workflow Administrator privilege will no longer be allowed to assign the task to
other users.
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- - view: Initial Data
EI . View: Review Data

-1 attribute: PrimaryColar
&%) Aspect: id
A

----- i B8 Column:Workflow Task Column {WorkflowTaskColumn)

--EE Column:object (WorkflowLinkedMame)

Component

Title |Assignee

I [¥] Read Only I

[ Mandatory

Component .Workﬁuw.hssign : -

STEP Workflow Items

STEP Workflow Items | Products | References || Referenced By I

Workflow Task Column Assignee

object

Yellow & Pink part for flashlight

W

o

roup : super Lsers

ellow & Pink part for flas...

Blue Hat

W

oJ

ser : User 2 lue Hat

Re-assignment Procedures for STEP Workflow Administrators

To assign a particular task to a user, the user with STEP Workflow Administrator privilege can do so manually on
the STEP Workflow tab and the object's Tasks tab, or by creating a business rule. For task reassignment using
business rules, refer to the document Assigning Tasks Using Business Rules in the Workflows

documentation.

STEP Workflow Tab

1. Go to STEP Workflow Tab and select the relevant workflow.

2. Click on the particular state in the workflow, and navigate to the 'Assignee' column in STEP Workflow ltems

tab.

3. Once on the 'Assignee’ column, click on the dropdown so that assigned user will be visible.

STEP Workflow

Profile

- Sales Item Creation - original
= Sample Workflow
E"S_th]

¥ Shipment Order Process

ele  [E)ia)

Filter by Collection

Initiate Data
Review Data
Confirm data
End State

ololn B ]I

STEP Workflow Items

S AV LT NGRS | Products || References || Referenced By

Workflow Task Column >

W

Assignes

object

‘fellow & Pink part for flashlight *

o)

Group : Super Users

Yellow & Pink part fo

Blue Hat >

o

User : User 2 -

Elue Hat
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Select the user from the dropdown in parallel with the task to be assigned.

Object's Task Tab

Similarly to how an assignment to a user is performed on the STEP Workflow tab, a task can also be assigned on
an object's Tasks tab.

1. Todo so, click on the object and navigate to the Tasks tab.

2. Once on the tab, locate the workflow the object is in that needs a task assignment. Select the user it should be
assigned to from the 'Assignee’ column.

Tree Yellow & Pink part for flashlight rev.0.2 - Tasks
__ Flashlight Bulbs & o Commercial || Tables || Category Profile || Proof View || Status || State Log
E Flashlight Bulbs 8(2) STEP Worlkflow Ikems H Praduct ” Sub Products ” References ” Referenced By I
E Flashlight Bulbs 9 @ Shipment Order Process Review Data (USER)
’a Flashlight C Batteries Yellow & Pink part for flashlight
- |{™ Red flashlight
E Yellow &Pink part for flashlight Workflow Task Column * ey
[+-[[T] Flashlights SalesItems Assignee ey | Group : Super Users
#-[7] Displays object 3
-1 Furniture Primary Color il Group : Super Users
&-[[5) Automotive D *|User : User 2
+-{{T] Building Products __|[[Name *|user : User L
—_ i i =
[+-{{T] Electrical and Electronics |= “'-!D IE!St Edited? ’
* >
#-IT] Food and Beverage Rejection : -
H-[[7] Kitchen . Proceed 2 « |
1 | L} t Headers marked with asterisk (*) specifies workflow mandatory values
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Auto-Initiation of Tasks in Workflows

Automatic initiation is used to automatically initiate an object into the desired workflow, otherwise a manual action
is required. With auto-initiation, items can be pushed through automatically, making it much simpler and more time
effective.

Two common scenarios for auto-initiation are:

1. Once a user creates an object in workbench or Web Ul, the object can be initiated automatically in the specific
workflow.

2. When new objects are imported, the object can be initiated automatically in the specific workflow.

For example, if a workflow is valid for Products, Classifications, Assets, Entities, Publications, Publication
Sections, or Flatplanner Planned Pages, it is possible to have an instance of a given workflow created whenever
an object of the valid object type(s) is created. In other words, a workflow is automatically started when the object
is created.

Setting up Automatic Initiation of Tasks in Workflows

1. To setup auto-initiation, select the System Setup tab and expand the folder that houses workflows.

2. Select the desired workflow (in this example, Shipment Order Process will be used) and check the 'Initiate
automatically' checkbox on the STEP Workflows Editor tab.

System Setup Jhlpmpnt Order Proce v.0.81 - STEP Workflow Editc
EI[E Workflows B STEP Workflow Editor | Skatus
@ Sales Item Creation
@ Sales Them Creation - original Mame Value
@ Sample Waorkflow » ID 11123
@ Sample Workflow(2) > Mame shipment Order Process
@ Shipment Order Process
» Revision 0.81 Last edited by USERL on Thu May 26 11:24:45 EDT 2016
» [nitiate automatically I
» Listen on updates from import [
» Use executing user's write privileges
|| || * Disable transitions on terminated Workspaces [
» Start Condition
@ Used Local Business Rules
Title » |State » |STEP Workflow Component
» acn-92a63753-44a7-4483-boc8-d 399 1Confirm data - Review Data On transition
» Nacn-d8b535fa-4739-4695-803b-5f3173Review Data On entry
@ Used Global Business Rules
‘ ’TI'HE > F‘I‘EP Workflow Compan... » >
@ Workflow Privileges
|Applies to > |.-5.cﬁ0n Zet > |.-'-\ttribute G > |Clbject Type * |Gr0up > |Language > |C0untr\,r > |
3 Add Privilege
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Whenever an object of a type valid for the workflow is created, a workflow is started. This could happen via
workbench, Web Ul, web services, or through an import.

Initiating an Object Automatically in Workflows

Before creating an object, it is important to know what the desired workflow is valid for, otherwise the object will not
be able to automatically initiate. To check the validity type, view the workflow and select the Validity tab. In this
example, the Shipment Order Process workflow is valid for products that have one of the three object types below.

m < Shipment Order Process - Validity

- Discontinued State - STEP WorkFlow Editor m Log || Status

% valid for Product Types

Flatplan group assignment

-- F.}"q:ment Order Process| (] Al
Item

TtemFamily
ItemFolder

Note: Object types/ names will vary according to user setup.

Create and Initiate from Workbench

Once the validity type is verified, a product can be created in the workbench by entering an ID and name, as well
as any other required data. The following image shows that a Supplier Part Number is required to create an item.

i )

E] Create Product @

Ohject Type

i@ Item

(7 TtemFamily

Attributes
Mame *| > |Value ¥
» Bupplier Part Mumber abe

ID 179835

Mame  Ski Hat

Create ] [ Cancel

For more information on creating new objects see the Creating Objects in Tree topic in the User Guide /
Getting Stared documentation.
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There are a number of ways to verifying that the product was automatically initiated into the desired workflow. A
few are:

« Onthe Search tab, search the workflow to verify the object is displayed as a result.

Search Result Profiling

STEP Workflow
STEP Warkflow _Shiprnent Order Process

State Initiate Data

Search Result Profiling

1 hit(s)
Click links to narrow down search

(8 . :
Displaying 1 of 1results Show Details -

Name .|| Results by Object Type
ﬁﬁkj Hat I = 179555 Product (1) - exclude

E”Eﬂ"l f'ﬂl - exclude

m

Results by Position in Tree Hierarchy
Results below child nodes of Hats and Caps tems
B8 SkiHat (1) - excluce

Results by Parent

Operations on Entire Result Bl Hats and Caps ltems (1) - sxclude

<

1

« Navigate to the STEP Workflow tab, open the workflow, and verify that the object appears in the first state in
STEP Workflows Items tab.

STEP Workflow STEP Workflow Items
Prafile | Products | References || Referenced By

@ Shipment Order Process - Object Who Approved? Date

@@ [ ” || * Bki Hat

Filter by Collection E]
1
2
0
0

v

Initiate Data
Review Data
Confirm data
End State

i Proceed 1 [ submt_|

- Workflow 4 -

« Navigate to the item's Task tab and verify that the object appears in the desired workflow flipper.
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S e < SKi Hat rev.0.1 - Tasks

r_=| Upper Body Wear & Category Profile || Proof View | Status || Skate Log
E”j Head Wear Referenced By ” Images & Documenks Comme
E|r_=| Hats and Caps STEP Worlflow Items ” Product ” Sub Products
=}l Hats and Caps [tems § shipment Order Process/Initiate Data (USER)
-\ (111777)(2) T
-\ (111778) =
Object » 5ki Hat
™ (120170)
i 2
- (120666) Who Approved: »
Date >
- (179653) _ _
8 s roceed 1 + st |
E Blue Hat
E Gray Hat
E Industrial Hard Hat
R -
1 | »

Note: If an object in the Recycle Bin (and thus taken out of any workflow) is revived, it will be re-initiated in the
workflows with auto-initiation turned on and that match the object's validity.

Create and Initiate from Import

Another way to create and initiate objects into a workflow automatically is to do so via an import, where product
information, such as that below, is uploaded to the STEP Workbench.

A B C D
<0Object Type

1 <D= <Mame> <ParentID= MName:>

2 179835 skiHat 20436 Item

3

To automatically initiate items upon import, in the Import Manager wizard, under 'Advanced Settings' check the
Auto-Initiate STEP Workflow on Item Creation option.

© Stibo Systems - Confidential - Release 10.0-MP3 (October 2020) 117



StiboSystems

MASTER DATA MANAGEMENT

ra 4

E] Import Manager @
Steps Advanced Settings

1. Select Configuration Context English Us - -

2, Select Data Source

Import Process Template: Importer

3. Select Format . 1=

4, Map Data Match Units By Mame -

5. Identify Objects Approve Import Changes O

6. Identify Destination Auto-Tnitiate STEP Workflows on Ttem Creation

7. Select Business Rules

Trigger STEP Workflow import events on Item Updates
S — ag p p [
Suppress Re-Translations

Auto select Import Mode i@

Force Database Import

Back Mext | [ Finish |[ Cancel

When the import is run, a background process is created and the user can see the object(s) initiated into the
workflow in the background process.

§ Execution Report

Retrieval started (Tue May 31 12:15:48 EDT 2016)
Retrieved 9402 bytes (Tue May 31 12:15:48 EDT 2016)
Conversion started (Tue May 31 12:15:48 EDT 20186)
Converted 1 objects (Tue May 31 12:15:48 EDT 2016)
Logged on

Mapping started (Tue May 31 12:15:48 EDT 2016)
Mapping completed (Tue May 31 12:15:48 EDT 2016)
Import Started (Tue May 31 12:15:48 EDT 2016)

Logged COn

Lsing import mode "domain”

Starting first import pass (creating system setup objects)
Starting second import pass (importing data)
Started 1 objects in Workflow "11123" (0 failed).
Imported 1 new products, 0 new classifications, 0 new entities and 0 new assets.

Processed 1 existing products, 0 existing classifications, 0 existing entities and 0 existing assets.
Skipped 0 products, 0 classifications, 0 entities and 0 assets.

Deleted 0 products, 0 classifications, 0 entities and 0 assets.

Found 0 warnings

Found 0 errors

Import completed (Tue May 31 12:15:48 EDT 2016)
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For more details on the Import Manager functionality and the Import Manager wizard, see Creating a Data
Import in the Data Exchange documentation.

Disabling Auto-Initiation

If a user has the 'Disable STEP Workflow Auto-initiation in Imports' privilege for a workflow, he/she is allowed to
disable auto-initiation in the Import Manager (column based Imports) or directly in the XML for XML imports (by
setting Autolnitiate="N" in the STEPProductinformation tag as shown below).

<?xml version="1.0" encoding="utf-8"7=
<STEP-ProductInformation ContextID="Contextl" workspaceID="Main" AutoInitiate="N">

<Products ID="179859" DefaultParentID="20436" DefaultUserTypeID="Item"=
<Product />

</Products>
</STEP-ProductInformation:
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Auto-Routing Tasks in a Workflow

In workflows, there may be cases where the system (via business rules) should make the decision for the path a
task takes through the workflow, rather than a user. While there are many use cases for this, a simple scenario is
the'if X, then Y' reasoning. For example, a user may have a workflow set up that evaluates each product that
passes through a particular state to see if there is lead in it. If so, special handling instructions need to be applied,
whereas this is not required for items that are lead-free. Therefore, tasks are automatically routed to differing
states based on the presence / absence of lead, which is determined by an attribute value.

This topic describes the preferred method for basic auto-routing of tasks, and allows for users to submit a task
without requiring any knowledge of where it needs to go next, as this is evaluated and determined via a series of
conditions on the available transitions. There are additional methods available for auto-routing of tasks, including
via use of the Scripting API Task interface and the triggerBylD() and triggerLaterBylD() methods.

Auto-routing using conditions requires that all transitions from the state have the same event name applied. It is
also important to remember that all conditions return either true or false, and that a condition evaluating to true on
a transition means that the transition can be taken, while a condition evaluating to false means that the transition
cannot be taken.

This setup can be used to skip states, as well as to select between one of two states. Therefore, either of the below
workflows could utilize it, and in both cases the outcome will be that the task is sent to the Has Lead state from the
Review Data state, if needed. Note that in all cases, all transitions out of the Review Data state have the Proceed
event. With this setup, the end user will see only a single selection option (Proceed) when submitting the task,
allowing the system to make the decision, while keeping things simple for the end user.

Start

Proceed Start

il
B

Gather Data (1) Proceed

b

Gather Data (1)
PR
Review Data (1) Proceed
-
Proceed )
il Proceed Review Data
Has Leacd ' Proceed - Proceed

NE
Final Review ARRIOVE E ApRrove
(oo ]

Approve

Proceed

Finish

H{

© Stibo Systems - Confidential - Release 10.0-MP3 (October 2020) 120



StiboSystems

MASTER DATA MANAGEMENT

In order to determine where the task should go, an attribute with ID=HaslLead is evaluated. If the value is Yes, the
task must go to the Has Lead state. If the value is No, the task must take the other transition. We could setup a
"Yes" condition and a "No" condition, applying one to each transition out of the state as appropriate, and that would
accomplish the end result. However, if an object did not have the HasLead attribute populated, it would not have a
viable transition, unless we wrote a condition to account for a null value. Assuming mandatory attribute
functionality was applied and we could ensure a value was present, there is however still an easier way to do it
using only a single condition, which evaluates to true if HasLead=Yes. By leaving another transition with no
conditions applied, and instructing the system to always evaluate the conditioned transition first, all tasks with the
Yes value are caught first and appropriately routed, and all tasks with a 'No' or null value take the other
(unimpeded) option.

Detailed instructions and additional considerations for this setup are below.

1. Setthe order in which outgoing transitions are attempted by right-clicking on the state that has the multiple
transitions with the same name coming out of it, and selecting Edit Order of Outgoing Transitions.

B S| Edit State
Proceed

- ¥ Delete
Has Lead &)

Edit Order of Outgoing Transitions

Approve

- Recursive Auto-Layout
i
Auto-Layout

2. Inthe dialog that appears, select any entry and use the Move Up or Move Down buttons to set the appropriate
order. Note that the example uses only two transitions, but this method works for any number of transitions.
The '0' transition is evaluated first, and subsequent transitions are evaluated in sequential order. The system
will send the object via the first transition it finds that evaluates as true.

Start

Proceed
"1’

Gather Data (1)

o =

E] Transition Order Edi... @
Proceed Proceed —_—

L ; Mave Up | Mowe Down
Lead Free 0: -> Has Lead [Proceed]

1: -> Lead Free [Proceed]

Approve Approve

(o) (o=
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If multiple transitions will exist with conditions applied, care should be taken to ensure that they are sequenced
properly, that they do not overlap unless intended (and managed via sequencing), and that all tasks have a
way to exit the state. With that in mind, it is generally advised to ensure that conditions are exclusive (e.g., a
task is not likely to evaluate true for more than one transition), and that one transition exists unimpeded (e.g.,
without a condition). However, there are exceptions, so carefully test the design and outcome.

. Set a condition on the transition to be evaluated first. For the purposes of the example, a basic attribute value
comparison will be done, but any condition could be used. Double-click on the order zero transition to open the
Transition Editor. Select the Condition tab and click the Add new Business Condition link. Click the Edit
icon to open the Edit Operation dialog and select Attribute Value Comparison from the dropdown. Select
the appropriate attribute, operator, and value. Click Save to close the Edit Operation dialog, and click the X in
the upper right corner to close the Transition Editor.

P

5

E] Transition Editor
Edit

|E1.rer1ts:| Cnndiﬁon||;]n TransiﬁnnIMandatory Attributesi

BusnessRule  |(con-2d838242-89c5-48c3-ad49-be571c6bedes) .. [\

Mame

Description

Type Condition

Scope Locaf 1
E] Edit Operation @

Run as privileged [

Operations|Dependend

rue if value for

[Atribute Value Comparson ¥
Has Lead (HasLead)| E]

fes

I
4

[ Save H Cancel ]

Add new Buzinezs Condition

Show Edited Transition ]
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Bulk Update Operations for Workflows

The STEP Bulk Update operations is an efficient way of updating multiple objects in a single operation. For
workflows it can be used to claim multiple objects in a specific state in a specific workflow, initiate multiple objects
into a specific workflow, remove multiple objects from a specific workflow, or trigger a specific event for multiple
objects in a specific workflow.

£+ Bulk Update 5]
Steps Operations
;ziﬁizi: Trigger STEP Workflow Event . E
3 Peremeters Attribute values » x. 4
4. Preview Data Quality k il
. Advanced Publishing 3 -
References and Links k
Workflow — Clairn
Run Business Rule Initiate iterns in STEP Workflow
Send Republish Event Remowve itemns from STEP Workflow
Set Mame Trigger STEP Workflow Event
Set Object Type
Add Operation
| Back || Next || Finsh || Cancel

For more on bulk updates see the Bulk Updates documentation.

The table below defines how each operation is expected to perform. Additionally, the next proceeding sections of
this document will explain how each operation works more precisely.

Operation Description

Claim Assigning a workflow task to a specific user

Initiate items in STEP Workflow Bulk update is performed on the objects to initiate them into a selected
Workflow.

Remove items from STEP Removes all objects from the selected workflow.
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Workflow
Trigger STEP Workflow Event Triggers a selected workflow event.

Claiming a Task in a Workflow

The 'Claim' bulk update operation allows the user to claim multiple tasks in a state at one time. For example, if
there are 10 tasks in one state, instead of a user having navigate to the STEP Workflow tab, opening up the

desired workflow and clicking each individual task using the claim button, dﬁ, in the STEP Workflow Items tab, a
user can claim all the tasks at once using bulk updates.

Claiming a Task

To claim tasks, the following steps need to be followed by the user who wishes to claim the tasks. In this case itis
UserL.

1. ltisimportant to check and make sure that the tasks are initially unassigned to any user in a state.

[ Products ” References " Referenced By ]

| Yelow & Pink part for ﬂﬁht > |Blue Hat v
I'I.“.I'DFkﬂDW Task Column > ﬂ:] ﬂij

Assignee > IGroup : User Group Group : User Group

Frimary Color > '(-ErEn,-I

D » (135008 20805

Mame * fellow & Pink part for flashlight Blue Hat

Who last Edited?™* >

Rejection™ > Meeds to be re-stiched

2. Once verified that they are unclaimed, go to the Search tab, and select STEP Workflow from the dropdown.
Next select the desired workflow and state to display the objects present in that particular state, and click the

3
bulk update button, .
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- [STER Workflow | 5

STEP Workflow :Shipment Order Process -

State .F'.E'u'iEW Data -

STEP Worlflow

B | Reset | .
Displaying 2 of 2 results Show Details
Mame

. - Blue Hat 1D = 20805
* i Yellow & Pink part for flashlight D = 135005

1 | 1] | 3

- Operation ntire Result

[ Bookmarks " System Setup ” BG Processes ]

This will create a bulk update for all of the objects in that particular state. Additionally, it is also possible to save the
search results as a collection, and schedule a bulk update by selecting the saved configurations. Note that this also

saves all tasks that show up in the sate in the collection.

-

P

£21 Bulk Update =

Steps Operations

;'- zlﬁi::: Merge Attribute Yalues
2 Parameters Attribute values * [Z] into E]
2. Breview Data Quality ¥ &l values -
5. Advanced Publishing ¥ -

References and Links  * :

Workflow bk Clairm

Run Business Rule Initiate items in STEP Workflow

Send Republish Event Remove iterns from STEP Workflow

; Set Mame Trigger STEP Workflow Event
Set Object Type

Back Mext Finish
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Note: If a user wishes to only claim certain tasks that show up in the search, they should press 'control' and select
the desired tasks. Then instead of pressing the bulk update button at the bottom of the search, a user should go up

to File > Bulk Update > Run Bulk Update.

3. Select the workflow and the state from the dropdown.

.

£+] Bulk Update =
Steps Operations
1. Configuration
2. Operations STEP Workflow: | Shipment Order Process >
3. Parameters F —
Current State: | Review Data i
4. Preview - -
5. Advanced

Add Operation
[ Back ][ Mext H Finish H Cancel

4. Navigate through the succeeding windows, and click on Finish.
5. A background process, BGP, will run and when clicked upon, will display the report of the bulk update process.
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Bulk Update - Background Process

Backgruund F = [ Quene Info
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Prnperty Value »
Started by LISERL

Id BGP_130209

Description Bulk Update

Execution Server doc-dev

Status su::ceeded

Created Thu Jun 16 10:51:46 EDT 2016
Started Thu Jun 16 10:51:51 EDT 2016
Finished Thu Jun 16 10:51:51 EDT 2016
Processing Time OmOs

Time in Queus Omb5s

# of warnings ]

# of errors 0

¥ Execution Report

1 Bulk update background process started (Thu Jun 16 10:51:51 EDT 2016)

2 Context: Context1

* Waorkspace: Main

< Commit Mode: Commit

= Auto Approve: Mo

= Collection: BGP_ 180209 tmp input

7 Configuration: temporary configuration

5 Read bulk update operation configuration successfully (Thu Jun 16 10:51:51 EDT 20186)
= Created temporary collection: BGP_180209 tmp fail (Thu Jun 16 10:51:51 EDT 2016)
10 Applying operations to dataset (Thu Jun 16 10:51:51 EDT 20186)

T Summary (Thu Jun 16 10:51:51 EDT 20186)
12 2 objects QK. 0 objects failed.
12 0 info messages. 0 warning messages. 0 Error messages.
14 End of Summary

If the BGP was successful, navigate to the STEP Workflows tab again and check to see that the items are now

claimed and assigned to the appropriate user, in this case User L.
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STEP Workflow Items

STEP Workflow Items |0l | References || Referenced By

Blue Hat » [Yellow & Pink part for flashlight W
Workflow Task Calumn > é:] Eiﬂ
Assignee * User i User L User : User L
Primary Color > Gray
D > 20805 135003
Mame » Blue Hat Wellow & Pink part for flashlight
Who last Edited?* >
Rejection™ » Meeds to be re-stiched

Initiate Items in STEP Workflows

Whenever new objects / products / items / or tasks are created or on-boarded, it has to be processed via the
workflow. Instead of initiating each item individually, a user can save time by initiating them all at once in a bulk
update.

How to Initiate Tasks in STEP Workflow Using Bulk Updates

The following steps are required configurations to run a bulk update. It is important to keep in mind that a workflow
needs to be valid for the objects / products / items / tasks being initiated into it.

1.

First search for the products that are to be initiated into the desired workflow and select the button for a bulk

update.

Search Below
’VHEF'JS - High: 3" or higher (20654)

(oo ¥

Displaying 10 of 10 results

| Reset ||

Show Details

MName

>

* Qi 20714 1D = 20714

* N 20714A 1D = 135835

* N 20714-B ID = 135825

> Qi 20714-C D = 135830

* N 20714-D ID = 135851

* W] 20714-E I = 135832

> ] 20714-F I = 135835

* if%| Dress Shoes D = 135834

* i Heels - High: 3" or higher 1D = 20594

> ™ Red Pumps D = 20595

-Operations on Entire Result

() (@[]
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Alternatively, you could click on the objects in tree and go up to File > Bulk Update > Run Bulk Update.
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2. Inthe Bulk Update wizard that appears, navigate to the Operations window and select Workflow > Initiate

P

51 Bulk Update I
Steps Operations

L. Configuration [Initiate tems in STEF Workilow ¥

L mnils Choose a Workflow: :11123 -

3. Parameters -

. Process Maote: Imparting shoes
4. Preview
5. Advanced
Add Operation
[ Back ] [ Mext ] [ Finish ] [ Cancel

3. Navigate through the succeeding windows, and click on Finish.

items in STEP Workflow. Select the correct workflow from the dropdown, and add a process note if desired.

A background process, BGP, will run and when clicked upon, will display the report of the bulk update process.

5. Ifthe BGP was successful, navigate to the STEP Workflows tab again and view the items that were initiated in
the workflow. The assignee of all of these items will be the user who is logged in and performed the bulk

update.

STEP Workflow L 4 STEP Workflow Items

Praofile 0 0 Products || References || Referenced By
L & jec > o Approved? * Da * Workflow Deadline * e > fWorkflowAssignee >
9 shipment Order Process Object Who A d? > [Date Workflow Deadl Attach ti WorkflowA,
& l I » |20714 i [cofser : User
i .
Filter by Collection Q > 207148 E [eeser : User
. »> |20714-C [;]User : User
Initiate Data 10 —
Review Data 2 7 j20714D \ﬂ E]User : User
i .
Confirm data 1 »|20714-E =) - E]User : User
Approve Data 3 > J20714-F [;]User : User
Ttems packaged 1 ||| > 207144 ﬁ E]User : User
End State 1 > |Dress Shoes & ... E] iser : User
@~ sOneButton1 = » JHeels - High: 37 or higher [;] |lser : User
= ‘Workflow » [Red Pumps i [cofiser : User
G User Web UI Workflow i ] .
&= WF_Addint_Logic il Proceed 1 v

Removing Iltems from STEP Workflow

Should a user want to remove all objects from one state in a workflow, they can do so using bulk updates if they
have the ability to search the STEP workflow tab, and they have the '‘Perform Bulk Update' privilege.
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For complete directions on how to use bulk updates to remove items from STEP Workflows, see the Remove
Objects From Workflows topic in the Workflows documentation.

Trigger STEP Workflow Event

This function is useful when a user completes multiple tasks and needs to trigger multiple tasks from one state to

another at one time

How to Trigger STEPS Workflow Events

For example, if a workflow has a state called Confirm Data with 7 tasks in it that all need to be moved to the next
state, called Approve Data, the user would follow the steps below to perform this action.

STEP Workflow

STEP Workflow Items

Prafile SR LT TR ) B | Products || References || Referenced By
@ shipment Order Process - Ohject ¥ |City > ID > |Mame >
@ u l—] l—] 20714-E > 20714E 135832 20714E
20714-B > 207148 135829 20714-B
Filter by Collection [ ||l20723C > 20714C 135830 20714C
. 207144 *> 207144 135828 207144
Initiate Data B ||o71ar > [po71aF 135833 20714F
L] z flashlight case » fashlight case 129666 flashlight case
Confirm data 7 I 20714-D > [20714-D 135831 20714D
Approve Data 3
Items packaged 1=
End State iy
© sOneButtonl Error Subrmit

1. First gotothe Search tab, and select STEP Workflow from the dropdown. Next select the desired workflow

H
and state to display the products present in that particular state, and click the bulk update button, .
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STEP Workflow _
STEP Workflow _Shipment Order Process
State :Conﬁrm data
|
(8 Reset || :
Displaying 7 of 7 results Show Details
MName

W] 20714A 1D = 135826

g 20714-B ID = 155825

N 20714-C ID = 135830

R 20714-D I = 135851

B 20714-E ID = 135832

N 20714-F JD = 1358535

I flashlight case ID' = 129665

1| 1] [ 3

-Operations on Entire Result

2. Inthe Bulk Update wizard that appears, navigate to the Operations window and select Workflow > Trigger
STEP Workflow Event. Select the correct workflow, state, and event to be performed. Add a process note if
needed (process notes are the information for the users in the next state.).

. 1

£+ Bulk Update [5m]

Steps Operations
L AT - [Trigger STEP Workflow Event -
5 : R
S isE STEP Workflow: | Shipment Order Process - E
3. Parameters : .
4. Preview Current State: :Cﬂﬂﬁrl'l'l data - |
5. Advanced Event: Proceed 3 v

Process Mote: | All are ready for approval

Add Operation

[ Back ][ Mext H Finish H Cancel

3. Navigate through the succeeding windows, and click on Finish.
4. A background process, BGP, will run and when clicked upon, will display the report of the bulk update process.

© Stibo Systems - Confidential - Release 10.0-MP3 (October 2020) 131



StiboSystems

MASTER DATA MANAGEMENT

5. Ifthe BGP was successful, navigate to the STEP Workflows tab again and view the items that were moved
from one state to the next in the workflow.

STEP Workflow STEP Workflow Items =~
Profile SRV TR E | Producks || References || Referenced By
@ Shipment Order Process Object * |Mame ’
207148 » [20714-B 207148
@ 9 [ ] 20714-C » [ 20714-C 20714-C
207144 » (207144 207144
Filter by Collection
flashlight case * flashlight case flashlight case
Initiate Data 15 109308 > (109308 109308
Review Data 2 20714E * 20714E 20714E
Confirm data / 0 Blue and Purple Flashlight * Blue and Purple Flashlight Blue and Purple Flashlight
A Data w0l Silver Flashlight * Silver Flashlight Silver Flashlight
=||{20714-F » 20714-F 20714+
Ttems packaged L] ||[z07190 > 20714D 20714D
End State 1
& soneButtonl il Data Mot Approved Submit

Note: If the Bulk Update is run on objects not in the specified state in the specified workflow, warnings will be
generated in the Bulk Update Background Process and the objects left unchanged.
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Business Rules and Workflows

When working with workflows, it is very common to use business rules. They can help with a number of functions,
such as sending email, validating data, moving a task through a workflow, assigning tasks in a workflow to
particular users, among many other actions. It is important to know that business actions can take actionsin a
workflow, while business conditions are able only to check and/or validate data.

This topic provides a general introduction to some overall functionality specific to business rules in workflows.
Much more information regarding business rules in general (applicable to rules used both within workflows and
external to workflows) is available in the general Business Rules section of the documentation.

A Simple Example

Below is an example of how a number of business rules can work together to make a coherent and functioning
workflow. Itis possible to define business actions to be executed as part of the workflow on states or transitions,
and to define conditions to be tested before transitions between states are performed.

E] STEP Workflow Designer - ContractAgreements(2)*

File Edit View
Workflow Properties =
i Contractagreements(2)
Start (&)
Mame |Contract Agreements

Workflow VariablesfAttachments SUEJ““

'assingee’ abe Elit G0

'Released_by' abe:

Subymit Feject

Review

B

Acaept

For example, a company needs a number of documents signed and agreed upon before they can proceed with
their new business partners. In order to make sure that the documents were reviewed and signed to exact
specifications, the workflow above was created to help with the process.

For this workflow a document, or task, enters into the Start state where it is picked up by an assigned user, @
After all assignments are completed they submit the task to the Edit state. Next, a user claims the task, completes
any assignments regarding the task on time, ', and then submits it to the Review state. As they submit it to the
Review state, a business rule captures the ID of the user who submitted the task, ©'.
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Once in the Review state, a new user claims the task. If however, they do not think that it is ready for review, they
have the option to send it back to the Edit sate. If they choose to do this, as the task enters into the Edit state again,

there are business rules in place to send the task back to the user who originally worked on it in this state, T and
sends them an email to notify them it was rejected back to them.

However, if the task enters the Review state and the user who picks it up does think it is ready to be delivered, they
can choose to accept it, and submit it to the Done state. Notice that a condition is in place on the transition from the
Review State to the Done state. This condition makes it so that the reviewer has to populate an attribute field on
the task called 'Approved' to 'Yes' in order for it to be submitted to the Done state successfully.

A few aspects to note:

« If a script exception is thrown during the transaction, or the assignee for the Edit state cannot be set, the
entire transaction including any changes made is rolled back

« When the On Transition Action is executed the task is not in any state, any attempt to manipulate a task will
cause an error to be thrown, and again the transaction will be rolled back

Applying Rules in a Workflow
Business actions can executed from workflow states at three points:
1. Entering a state (On Entry)

2. Exiting a state (On Exit)

3. Aspart of an escalation when a deadline for a state has been met (see Deadlines and Escalations inthe
Advanced Workflow Topics documentation for more details).
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Edit

E! State Editor

Deadline

:Hour{s] -

Escalation

Business Rule E] 'ﬁ *

Mame
Description

Type Action
Scope Mone

Run as privieged [

Dperaﬁﬂﬂ5|Dependendes|Applies if

Add new Buziness Action

[ Show Edited State

Business actions can also be executed on transitions between states:

1

"

E] Transition Editor

Edit

Business Rule E] " * |

[Events|Conditior] On Transitior: landatory Attributes

Mame

Description

Type Action
Scope Mone

Run as privileged [

Operations|Dependencies| Applies if

Add new Business Action

Show Edited Transition
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Business conditions can be executed only on transitions:

-

E] Transition Editor @

Edit
|EuenH. Condition i)l n Trar1si1:iu::nn||'~"|andatcnr}-I Attril::utesl J
Business Rule E] h | by

Mame

Description

Type Condition
Soope Mone

Run as privileged [

Operations| Dependencies| Applies i

Add new Business Condition

[ Show Edited Transition ]

Regardless of the place the rule is applied, or whether it is a condition or an action, a few things are common to the
editors (and specific to the business rule editors within workflows).

To add a business rule to a workflow, click the ellipsis button ([...)) and select an existing rule (1), or click the Add
new Business Action/Add new Business Condition link (2).

E] State Editor @

|Edit |
Comments | Web UI Screen Mapping I Mandatory Attributes
State | OnEntry | OnExit | Assignes |  Deadine/Escalation
Business Rule % h | *
Mame
Description
Type Action
Scope Mone

Run as privileged [

Operations|Dependencies|Applies if

Add new Business Actiune

Show Edited State
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Defining a new business rule from within the STEP Workflow Designer, creates a local business action (2), while
selection of an existing rule (1) allows users to choose from global rules.

Important: Local business rules can only be used in the workflow where they were created.

If arule could be re-used in multiple locations, it is generally better to create it as a global rule.

If a local rule has been created, it can be promoted to a global rule using the hand icon g. This creates a global
copy of the rule so that it can be used elsewhere.

If a global rule is selected, it can be edited using the edit icon , though care should be take with this as it results
in changing the rule in all places where it is used.

If a global rule should be changed, it is often better to make a local copy of the rule using the copy button ,
ensuring that any changes made to the rule will only affect the current workflow.

Local business rules created or edited through the STEP Workflow Designer are saved when the workflow is
saved. Global business rules are saved when changes are saved within the business rule editor.

Workflow Business Rules in Operation

Each time a business action or condition is configured on a state or on a transition, the workflow has indicators to
signal to the user where these business rules have been applied. The indicators are the following:

Indicator Description

‘Al A default assignee for a particular state (or workflow) has been assigned.

D’ A default deadline has been selected.

I' Signals the configuration of an 'On Entry' action. It may help to remember this as 'l' for 'In’
(e.g., into the state).

'O Signals the configuration of an 'On Exit' action. It may help to remember this as 'O’ for
'Out’ (e.g., out of the state).

dotted transition Indicates a condition has been placed on the transition.
line

rounded end on Indicates an action has been placed on the transition.
transition
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Order of Operation

Itis important to note the order of operation of the various rule types (condition or action) and where they are
applied (entry, exit, transition, or deadline). Consider an object going from a current state to a next state. Business
rules are evaluated in this order:

Condition on transition exiting current state

On exit action from current state

On transition action between current and next state

Default assignee on entry to next state (if assignee is set in workflow designer rather than using business rules)
Deadline set in next state

o g s~ wDdh =

On entry action in next state

More Information

This topic has provided a basic introduction to how business rules can be used in conjunction with workflows.
Topics covering how to carry out all of the functions described in the above example can be found throughout the
Advanced Workflow Topics section of the documentation, in addition to other use cases and topics, including:

« Assigning Tasks Using Business Rules

o Auto-Routing Tasks in a workflow

« Configuring Status Flags in workflows

« Deadlines and Escalations in workflows

« e-Signature used to re-authenticate in a workflow

« Java API for workflows

« Remove Objects from workflows

» Running Background Processes from workflows

o Send Email from a workflow

» Validate Data in a workflow
As business rules provide robust functionality to meet the individual needs of each customer, it will also be useful to
see the general Business Rules section of the documentation to understand more advanced features, as well as

the Scripting API section of the STEP API documentation, accessed by clicking the STEP APl Documentation
button on the STEP Start Page.
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Deadlines and Escalations in Workflows

In the Workflow Designer a user can define a deadline for a state via the State Editor Deadline/Escalation tab.
This is useful for a number of reasons, one of which might be to notify a supervisor, or task manager, if a deadline
is not met for a particular task in a particular state. This may be important to know because if the task is late, it could
impact many steps that come after it.

Understanding Deadlines in the Workflow State Editor

The deadline is set relative to the time an object enters the state. For example, if the deadline is set to '5 Hour(s)',
an object entering the state at 6 a.m. will get the deadline setto 11 a.m. The available time periods are: Hour(s),
Day(s), Work Hour(s), and Work Day(s). Work hours are hard-coded to be from 8 a.m. to 4 p.m., with work days
being Monday to Friday (bank holidays and the like are not taken into consideration).

E] State Editor @
Edit
Comments | Web UI Screen Mapping | Mandatary Attributes |
State | OnEntry | OnExit | Assignee |  Deadine/Escalation
Deadline

Hour(s)
Day(s)

Escalatio

susiesel ok Day(s) &) [ X
Mame

Description

Type Action

Scope Morie

Run &z privieged  [7]

Operations | Dependencies | Applies if|

Add new Business Action

[ Show Edited State

Setting Up Deadlines for Workflows

1. In System Setup, navigate to the desired workflow, right-click on it, and select Edit STEP Workflow.
2. Right-click on the desired state and select Edit State.
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3. Inthe new dialog, select the Deadline/Escalation tab.

On the same tab it is possible to define or select a business action that should be executed if the deadline is met
and the background process for monitoring deadlines is run. To run this background process, right-click the
Workflows folder in System Setup, then select 'Start Background Process to Monitor Deadlines.'

=[5 Workflows

51 Mew Setup Group...

vﬁ Mew Business Action

<?> Mew Business Condition

E Mew Business Function

5| Create STEP Workflow

| Create Status Flag Ctrl+Shift+5
G| Start Background Process to Monitor Deadlines  Ctrl+Shift+D
&% Cut Ctrl+X
Copy Ctrl+C

Paste Ctrl+V
¥ Delete

Once selected, the dialog to set the frequency to monitor deadlines displays.

32 STEP Workflow Deadline monitoring.

Steps Escalating items in states with exceeded deadlines.

1. Escalating items in states with exceeded deadlines. Start

() Now 30 minutes

() Weekly
() Monthly

Start every 30 minutes
Back Mext Cancel

This background process (BGP), which can be scheduled to run at specific intervals, can be started from any
Setup Group in System Setup that can hold workflow objects. Since this initiation of the BGP happens at the folder
level, this setting applies to all workflows contained in the folder.
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Note: Once the deadline has elapsed, the escalation rules will run every time the BGP set in the previous image
looks for passed deadlines. For example, with a four-hour deadline and an 'Escalating Items' BGP set to start
every 30 minutes, the escalation rules run with four hours have elapsed, and then again every 30 minutes until the
object in this escalated status is moved to a new state.

Business Actions for the Workflow On Entry Tab

As described in the Views and Mappings for Workflows section of the Workflows documentation. Deadlines
can be viewed and manipulated in views via the 'WorkflowDeadline' Component. In the public API, methods for
getting and setting deadlines are available via the Task interface. Below is an example of how a deadline can be
set to an hour from now in a business action, in an On Entry tab.

var date = new Date();

date.setTime (date.getTime () + 3600000) ;

node.getTaskByID ("Workflow ID", "State ID").setDeadline (date);

As the deadline is set via the Task interface, the above will only work from the state with ID 'State ID'. An example
can be seen in the image below:

© Stibo Systems - Confidential - Release 10.0-MP3 (October 2020) 141



StiboSystems

MASTER DATA MANAGEMENT

e

-5

Business Rule

|[L|:u:al business rule to be saved with workflow)

£2] state Editor [==]
Edit
Statefon Entry bn Exit|Assignee |Deadline /Escalation|Comments|Web UI Screen Mapping|Mandatory Attributes

LEBEER

Mame | |
Description
Typel F51 Edit Operation
Scop
[ | Execute Javasoipt ;]
Run 3
Binds: @ Binds
Ope Variable name * |Binds to »
E node Current Object
Messages: 7
ariable name » |Message ¥ [Translations »
JavaSaipt: | yay date = new Date(];
date.setTime (date.getTime () + 36000007 ;
node.getTaskByID ("UF1", "Itateli™) .setDeadline (date) ;
Edit externally
[ Save ] [ Cancel

Add new Business Action

Show Edited State

When viewed in STEP Workflow, if a deadline is not yet met it looks like the image below:

STEP Workflow

E@%

9
P

Initial 1
Enrich 1

|Fi|ter by Collection
Final 0

e Workflows
eWorkflows

STEP Workflow Items

Category Profile || Proof View || Status || State Log || Tasks

Referenced By Images & Documents " Commercial ” Tables
STEP Workflow Items [ Product ” Sub Products ” References
WF_Test v
> 179762
> WF_Test
MyVariable » [Super user
Deadline > x

[The deadline; 2016-06-03 15:14:30 not reached|
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If a user wishes to remove a deadline from a business rule, this can be done by setting the deadline to null, as
shown below.

node.getTaskByID ("Workflow ID", "State ID").setDeadline (null);

Editing Deadlines through Workflow Views and Mappings

Deadlines can also be set by editing the workbench views and mapping for a given workflow. To do so:

1. Open the desired workflows Designer and go to Edit > Edit Workflow Views and Mappings.
2. Inthe view that needs a deadline added to it, right-click on the view and select Add Column.
3. Inthe Component dropdown, select WorkflowDeadline.

E] View Editor @

Edit
Editor | xmL
=& View: Example1 Component
EE' Aspect: id Title | Deadline
ih Aspect: name
Elg Column:MyVariable (WorkflawVariable) [] Read Only
- E]g Column:Deadiine (WorkflowDeadline)
PR [] Mandatary
----- E Mapping : Initial->Example 1
""" E Mappi:ng : Er1rid’1—:=—ExampIel Component Mﬂrkﬂmﬂ]aadhe vi
----- E Mapping : Final-=Example1 WorkflowAttachment -
WorkflowLinkedMame
WaorkflowNoteColumn i
WorkflowPlannedPage
WorkflowTaskColumn E
WaorkflowVariable i
WorkflowVariableUserList -

Once selected, the deadline can be set manually in the object itself via the object's Task tab, or in the STEP
Workflows navigator tab.

Tree 129707 rev.0.4 - Tasks ~pm
E“ Flashlights Item Commercial || Tables || Category Profile || Proof View || Status || State Log
E (179501) Product H Sub Products ” References H Referenced By Images & Documents ]
- (179917) (= =
= WF tial user
E 129997 129707 v
a 179997 1D » 1129708 g
a 179999 Mame » 129707
a 134352 MyVariable * . E
E 134853 Deadline » /
|. = - No deadline has been et for this task|  _
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Note: State Editor Deadline/Escalation tab allows a user to set the deadline for all the products in a particular
state within the workflow, but the deadline set using workbench views and mappings will apply for a particular
product in a particular state in a workflow.
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Deleting Objects in Workflows

Itis sometimes necessary to delete a product that is in a workflow. This could be for many reasons, including that
the product is no longer needed or is discontinued. However, if the product is currently in a workflow and a user is
trying to delete an object in a workflow, the user will be prohibited from doing so unless they 'force delete' the
object.

E! Delete report @

Deleted 0 out of 1 objects. 1 object(s) could not be deleted due to the objections stated below,

Mame
> ™ Gray Hat ID = 114505

4 I 3

-Delete Objections

"Gray Hat"™ could not be deleted due to the reasons listed below:

step:/fproduct?id=179487 has a cross reference to the object being deleted step: /fproduct?id=114503, The link
is visible in workspace Main.

step: /fproduct?id=20695 has a cross reference to the object being deleted step://product?id=114509. The link is
wvisible in workspace Main,

Force Delete I l Close I

The above message will include the list of workflows in which the product exists. If the user chooses to force a
deletion, it will not only delete the product from the hierarchy but will also take it out from all workflows it is currently
in.

Note: For objects that are not deleted directly, but put into the Recycle Bin, they will not be inserted into the states
they were in prior to the deletion if revived.

A force deletion of a product that is currently in a workflow should only be done when a user is sure that the
product is no longer required.

Should a user move a product to the Recycle Bin, this will also take the product out of any workflows. However, if
the product needs to be revived from the recycle bin it should be known that once revived, it will not automatically
go back into any workflows and their states that it was in initially. If it is desired that the product that was revived
from the Recycle Bin go back into any workflows it once was in, then the option 'Initiate automatically' in System
Setup on the STEP Workflow Editor tab needs to be checked for all the workflows that need that particular product
again.
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ﬁ Escalate

@ Released_by

@ Released_By

----- -ﬁ Send_email

[#- IEI Business_Action{2)
@ Clerical Review

@ Clerical Review 2
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Business_Action rev.0.66 - STEP Workflow Editor

STEP Workflow Editor |RYE! 130 Status

MName Value
> D Business_Action
> Mame Business_Action
* Revision 0.66 Last edited by USERL on Mon Jun 20 15:07:07 EOT 2016

W

Initiate automatically

W

Listen on updates from import

W

Use executing user's write privileges

HAutomaticaIIy initiate new items in the STEP Workflow when they are created

W

Disable transitions on terminated Workspaces

SE

W

Start Condition

If auto-initiation is turned on for the workflow, a new instance will be created. This means that if a product has an
object type which is valid for a particular workflow, then the product is automatically initiated to that workflow at the

beginning.
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Edit a Workflow in Use

Once a workflow has been created and is in use, it may be necessary to change it. If the workflow is not yetin use
(e.g., there are no active tasks for the workflow, or the workflow is in a test state only and not yet released for
production), editing a workflow is does not require any special considerations.

General information on creating and editing workflows can be found in the Getting Started with STEP
Workflows documentation, specifically in the Creating a Workflow and STEP Workflow Designer topics.

This topic provides guidance specifically on editing workflows that are already in production and/or contain active
tasks.

Important considerations before editing a workflow in use

When there are objects in a workflow, certain changes to the workflow are prohibited as they could cause
disruption to the tasks within them. Thus it is not possible to rename, delete, or change the state characteristics
of any states that have tasks within them. In addition, states with active tasks cannot be moved inside or taken
out of a cluster or parallel, and parallels may not have new clusters added.

Itis best to receive advice and guidance from a STEP expert before making changes to a live workflow.

Itis always recommended to duplicate the existing workflow, do the necessary modifications in the duplication,
test it, and then apply the same changes to the workflow in use.

If the required changes are significant, it may be best to process all existing tasks in the workflow, and make
sure that no new tasks are added, before the changes are made to the workflow.

Already existing business rules should be taken into consideration when editing a workflow. It is possible for a
rule to rely on a state that is deleted, event that is changed, etc that could prevent the rule from working
following updates to the workflow. It is important to evaluate all existing business rules following changes to a
workflow, and to test those that may have been impacted.
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Exporting Workflow Definitions

In order to move workflow configurations between systems and/or to compare workflow definitions using external
source control systems, workflow definitions can be exported using STEPXML and Advanced STEPXML.
Depending on the intended use of the output file, the appropriate method should be selected.

Exporting Workflow Configurations for Loading to Another System

Workflow definitions (including global and local business rules used by the workflow) can be exported in several
ways. The simplest of these is described. Exports carried out in this manner provide an encoded workflow
definition that, while not necessarily human-readable, provides all necessary information to replicate the workflow
on another STEP system.

A workflow definition (including used global and local business rules) can be exported in XML.

1. Right-click on the workflow object in System Setup and selecting Export STEP Workflow from the menu.

; !
> Test Workfow

Warkf -

D Derived By Edit STEP Workflow
-2 Object Ty

- Units Copy
rgw Users &G Paste

--E.‘ Reference

*EE Workspac . Delete
- /! Table

- Duplicate

[+~ Keys

jg Event Qul ik Export STEP Workflow I

Companer Remove items from STEP Workflow

2. Inthe pre-configured Export Manager wizard, proceed to the Select Format step and select STEPXML from
the dropdown.

3% Export Manager

Steps Select Format

1. Select Configuration STEPXML ~
2. Select Objects

Exports data in @ STEP Product Information XML format, Mote that this format ignores the leaf products only setting.
3. Select Format
4, Map Data Incude Websites Ma y ~
5. Advanced Include Workflows i :
6, Select Delivery Method

W

Publishing

Back Mext Finish Cancel
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3. Setthe Configuration > Include Workflows parameter to 'All' so that the selected workflow is exported.

4. Setthe Configuration > Include Business Rules (Global) and Libraries parameter to 'Referenced' so that
all global business rules used in the workflow will be included in the export.

Note: Local business rules are exported nested in the STEP Workflow element and will always be included.
5. Navigate through the wizard, making any other required settings, and click Finish.

The exported STEPXML file can be imported on another STEP system via the standard Import Manager.

The same export can also be accomplished using Advanced STEPXML. Following the steps outlined above, but
selecting the 'Advanced STEPXML' format on the Select Format step of the Export Manager will yield a pre-
populated export template that will produce the same results.

Note: The export option on the workflow designer File menu lets you export the SCXML on which the workflow is
based. This option is for debugging only and should not be used to transfer workflow configurations between
systems.

Steps to export the workflow in the SCXML format

1. Go to System Setup and locate the workflow

2. Right-click on the workflow and then click on Edit Step Workflow option

3. Inthe new window, click on File -> Export, and then select the path in which the file is to be saved

xt :English us . LJ 6 (' URL 156 E:i STEP Workflow Designer - 11133
System Setup Edit View

[+ 3] Order Process - i Export .
(18] Page Planner Flow N
- 13| Pen Workflow ST

El Pen Workflaw Two Save and Exit ' /OCESS
3] Product Awaiting Asset
E] Publications

E] Publication Sections

| 3| Sales Item Creation statusFlag? e
}E] Sales Item Creation - original 'statusFlag?' abe
| 13| Sample Workflow

| 13| Sample Workflow(2)

/- 13| Shipment Order Process
4 1 b 4

Exit achments

'Reson for rejection? abe

m [ »

m

1

| O O o O |

Validation errors:

Exporting Workflow Definitions as Comments for External
Comparison

Workflow definitions can be exported as comments using Advanced STEPXML. These exports can be submitted
to external source control systems for comparison purposes. Exports generated in this manner are not encoded
(as described above), allowing for readability by other systems. However, these exports do not provide the
necessary information to transfer a workflow between STEP systems and use in this manner is not supported.
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To export a workflow for external comparison, Advanced STEPXML must be used and the
DefinitionsAsComments tag must be set to 'true'.

On the Select Format step of the outbound tool, choose the Advanced STEPXML format, then copy and paste the
following text into the Template field:

<?xml version='1.0'"?>

<STEP-ProductInformation DefinitionsAsComments="true">
<STEPWorkflow ExportSize="All"/>
</STEP-ProductInformation>

An example of the output for a workflow definition as comments is shown below:

<STEPWorkflow...>

<!--Definition: [This is the Workflow definition. Removed for brevity.]-->
[Remaining configuration]

</StepWorkflow>

Note: The content of the comment field is not part of the STEPXML XSD and therefore Stibo Systems reserves
the right to change the format of the output content at any time.

For more information, see the STEP-Productinformation Tag in STEPXML section of the Data Exchange
documentation.
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Exporting Workflow Statuses

When exporting Products, Classifications, Assets, and Entities it is possible to have workflow related information
included in the exported file.

Workflow status export (STEPXML or Excel) is a kind of meta data information to communicate with the other
systems. For example, in the case of translation XML, the workflow states will act as a flag to match the status in
other systems.

When exporting STEPXML, the option to include the information is found on the Select Format page, using the
Data Objects > Include Workflow Tasks parameter. If set to 'yes', then each object in the exported STEPXML
will have a CurrentTasks element with info similar to what is shown below.

<CurrentTasks>

<Task STEPWorkflowID="Item Introduction" StateID="Technical
Specifications" AssigneelID="Stibo Systems Technical Writers"
AssignedToGroup="true" EntryTime="2012-10-18 11:31:39" Priority="-1"/>

<Task STEPWorkflowID="Testing 1-2-3" StateID="A Parallel"
AssigneeID="Super user" AssignedToGroup="true" EntryTime="2012-10-31
12:30:56" Priority="-1"/>

<Task STEPWorkflowID="Testing 1-2-3" StateID="Cl" AssigneelD="Super
user" AssignedToGroup="true" EntryTime="2012-10-31 12:30:56" Priority="-
1"/>

<Task STEPWorkflowID="Testing 1-2-3" StateID="Cl-Final"
AssigneeID="Super user" AssignedToGroup="true" EntryTime="2012-11-06
12:48:50" Priority="-1"/>

<Task STEPWorkflowID="Testing 1-2-3" StateID="C2" AssigneelID="Super
user" AssignedToGroup="true" EntryTime="2012-10-31 12:30:56" Priority="-
l"/>

<Task STEPWorkflowID="Testing 1-2-3" StateID="C2-Initial"
AssigneelID="Super user" AssignedToGroup="true" EntryTime="2012-10-31
12:30:56" Priority="-1"/>

<Task STEPWorkflowID="Testing 4-5-6" StateID="Some_ State"
AssigneeID="Super user" AssignedToGroup="true" EntryTime="2012-11-05
14:45:18" Priority="-1"/>

</CurrentTasks>
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Steps Select Format

1, Select Configuration STEFXML »
2. Select Objects

Exports data in a STEP Product Information XML format. Mote that this format ignores the leaf products only setting.
3. Select Format
4, Map Data Incude Asset Content Mone w "
5. Advanced

Indude Workflow Tasks Ham e
&. Select Delivery Method

Configuration y
Back Mext Finish Cancel

The same information can be included in column based exports, but data must be mapped into columns for each

workflow of interest.

To specify which type of workflow related data goes into a column, click the flipper button for the mapped data and
click the transform button for the value part. For details on this setup, see the STEP Workflow Task Info - Data
Source Outbound topic in the Data Exchange documentation.

Exports data in Excel format.

@ Column (2 mapped)

&= <D= ID

| 0] |'111:'_3' State ID

Header "Shipment Order Process' State ID"

'I.l'alue 11123 State ID

Target:

Source:

Aspect:

Multi-value separator:

2 Transformations

Value
'11123 State ID

State ID

Al
Av

Assignee ID
_ Assigned to Group
Add Transformation Priority
Save BEEntry'.'I'lmE
Deadline

For more information about exporting in STEPXML format, sece STEPXML Outbound Parameters in the Data

Exchange documentation.

For more information about exporting data in Excel format, see Excel Format section of the Data Exchange

documentation.
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Workflows and LOVs

An LOV can be initiated into and/or removed from a workflow the same way as products, classification, entities,
and assets. LOVs can be assigned to a respective user or user group to update the LOV values, similar to the
enrichment of product attributes.

The workflow must be valid for the LOV object type ‘Domains’ as shown in the image below.

System Setup < Approve Recursively - Validity
- grkﬂﬂws | STEP Workflow Editor Log |[ Status

bS8 (Mew Collection)

: B Attribute Types

@ Approve Recursively Eeey ; ET

(18] Business_Action ©- valid for Classification Types

@ Clerical Workflow 2 = valid for Entity Types

>@ Collection % Valid for List of Values Types
(18] Contact Workflow
i#+(I5] Contract Agreements M _

- J0 critical Domaing

; @ Discontinued State

- ©=valid for Asset Types

Domains are the only object type for LOVs and are found in workbench in System Setup > Object Types &
Structures > Basic Object Types > List Of Values Group Type (as shown in the image below).

System Setup
=& Object Types & Structures
[+-[ 7] Alternate Classifications
-- Assets
8 Availability
E}Iﬁ‘ Basic Object Types
{%‘ Asset Importer Configuration
-z Attribute Group
- attribute Transformation
{7 Business Action Type
@ Business Condition Type

-z List Of Values Group Type

-2 Qutbound Intearation Endooir

Initiate an LOV in a Workflow

Below are steps to initiate one LOV to a Workflow, however more than one LOV can be initiated to the same
workflow.

1. Right-click on an LOV, and select ‘Initiate in STEP Workflow.’
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LOV_Energy dr

| I AT AITNTOIE STOOE

Cut

Delete

2 %e

Duplicate

Merge LOVs

Merge Values in LOV

Ctrl+X

Ctrl+

Initiate in STEP Workflow

Remowve from STEP Workflow

2. The Initiate in STEP Workflow dialog will display listing only those workflows configured with validity for

Domains (LOVs). Select the appropriate workflow, optionally enter text within the Process Note parameter,

and click the OK button.

32 Initiate in STEP Workflow

(@) Approve Recursively

() Business_Action

Process Mote

Cancel

The LOV has now been initiated into the workflow. This can be viewed by going to STEP Workflow >

Expanding the respective workflow flipper and selecting the workflow state. The workflow editor will display.
Click the STEP Workflow Items tab and the LOV will display.

STEP Workflow

Profile

STEP Workflow Items

) LT A TR LB | List of Values || References State Log | Tasks

& Approve Recursively

e P

> [Mame

> WD

W

Energy Drinks Energyﬂrlnks Energy Drinks

S

Filter by Collection

Failure
Initial

F Business_Action
- Clerical Workflow 2
- Collection

Submit

For more information, see the Working with Tasks in Workflows section of the Workflows documentation.
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Remove an LOV from a Workflow

Below are steps to remove an LOV from a Workflow.

1. Right-click on the LOV which is already in a workflow, and select the option ‘Remove from the STEP Workflow'
as shown below.

- Eﬂ Energy
]| SoftDrinks | & Cut Ctrl+X
]| Teas
> Delete
aa Duplicate Ctrl+]
Merge LOVs

Merge Values in LOV
Initiate in STEP Workflow
Rermove from STEP Waorlflow I

2. The Remove from STEP Workflow dialog will display with the workflow in which the LOV has been initiated for.
If required add text to the Process Note parameter, then click the OK button.

3 Remove from STEP Workflow

(®) Approve Recursively (started)

Process Mote

Cancel

The LOV has now been removed from the workflow. For more information on workflows, see the Workflows
guide.
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Java API for Workflows

Complete documentation for API functionality related to workflows can be found in the STEP API documentation
at [system]/sdk or by clicking the STEP APl Documentation button on the STEP Start Page. This topic provides
some introductory information and simple examples, but should not be considered comprehensive.

In the Public Java API "WorkflowableNode" is the main interface for Workflow related functionality. All the
"workflowable" node types inherit the interface and thus you can call the available methods from the node
shorthand.

If, for instance, you wanted to get the time where an object entered a specific state, on entry to the state you could
have a business action with a script like the one below, storing the entry time in the script variable "entryTime".

var entryTime = node.getTaskByID("Workflow ID", "State ID").getEntryTime
0

The getTaskBylD() method from the WorkflowableNode interface is called on node. This returns a Task that has
the getEntryTime() method (see the Task interface).

Note that this script will only work if the object is actually in the workflow with the specified ID and in the state with
the specified ID.

From a business rule used in a workflow (e.g., a local rule within the workflow itself), you can typically be pretty
sure that the object is in fact in the workflow. However, if you run from a business rule used elsewhere in STEP
and wanted to check whether an object was in a given flow, you could write something like:

if (node.getWorkflowInstanceByID ("Workflow ID")) {

// Object is in Workflow - do something

else {
// Object is not in Workflow - do something else
}

Thus, if the object is not in the workflow, the method returns "null" - a "false" value in JavaScript.

While in the entry time example above you could be sure that you were in the workflow, likewise if you ran the
script on entry to the state referenced with "State ID", you could be sure that you were in that state. However, if
you are working with parallels, you could wish to do something with a task on a state that is not the same as the
one you are running the business rule from. In that case it would make sense to start your script with a check for
whether your object is actually in that other state:

var task = node.getTaskByID ("Workflow ID", "ID of another State");
if (task) {
var entryTime = task.getEntryTime ()
}
else {
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logger.warning ("Object with ID '" + node.getID() + "' is not in expected
State");

}

The two primary interfaces available through the WorkflowableNode interface are Task and WorkflowInstance.
Via the Task interface you have methods available that relate to a given object-in-state-in-workflow relation.
WorkflowInstance meanwhile gives you access to the methods relating to the object-in-workflow relation. In the
Workflow Variables topic of the Advanced Workflow topics documentation, the concept of workflow variables is
described. These variables live on the object-in-workflow relation and can thus be manipulated via the
WorkflowInstance interface.
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Localizing Workflow State Names and Events

End users interact with STEP in many languages. Though a workflow may be initially created in one language,
end users may use a different language and would therefore prefer to see workflow state names and eventsina
different language. This is possible using the Localize State Names and Events options in the STEP Workflow
Designer. With this functionality, workflow designers can create a single workflow that includes localized workflow
state names and events, thus eliminating the need to maintain multiple workflows for localization purposes.

To localize workflow state names or events:

1. From the System Setup tab, select the relevant workflow, right-click, and select Edit STEP Workflow.
2. Fromthe Edit menu in the STEP Workflow Designer, select Localize State Names and Events.

E] STEP Workflow Designer - SampleWorkflow

File |Edit| View
Wor @y Undo Sample Workflow (SampleWorkflow) (&
D | ™ Redo
Man % Cut
H Copy Progeed
E [ Paste
stab %
— Delete
' Enrich Data © = Product Assets
Select All
Edit Workbench Views and Mappings /// \\\ ; " .,
[E . pPing Progéed Rgred F‘rug:Eed Hej‘glct .
I Localize State Mames and Events I ", - ", » ™,
v 5 5 ! g ! 7 No_lmages
e
Approve Approve
h L S 4
[Enri::h Data Cnmplete] [Prudu::t Asszets Complete ]

3. Enter the localized values for each state name and/or event.

-
E] Localize 5tate Mames and Events u
State Mames E“E”a
D * Mame > Danish * [German * Spanish >
» Btart Start Empezar
» SectionMaint Review Revisar
» Done End Final
4 i 3
b
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Note: The languages available for translation are determined by two things: Translated workbench instances and
the locales available in the Web Ul. Web Ul locales are determined by the portal messages files in the
PortalLocales folder. The PortalLocales folder can be found on the application server in the location specified by
the Portal.Localizer.Folder property in the sharedconfig.properties file.

Localized values entered in the workflow designer appear when users access a workflow in the relevant locale-
specific Web Ul or in a translated instance of the STEP Workbench. Within the workbench, this includes but is not
limited to: STEP Workflow tab, object Status and State Log tabs, and dropdown search options when using a
STEP Workflow search criteria.

For example, a user logging in to the Spanish workbench or Web Ul locale would see the corresponding localized
values entered in the workflow designer.

Launch Workbench

Launch STEP Workbench (English} Launch STEP Workbench (Espanol}

®

LOCALE

espafiol

Note: Changing the Context selection in the workbench does not have any impact on the display of localized state
names or events.

Considerations and Limitations

« The name of the workflow itself is not translatable via this feature as this is driven by context. If the context
being viewed employs a different language than the translated workbench instance or selected Web Ul
locale, this could result in an end user seeing the name of the workflow itself and the states and/or events
within the workflow in different languages.

« Offline translation of state names and events via export/ import is not supported. Exports of workflows with
localized state names or events include the localized values and import to new systems will reflect the
localizations. If an imported workflow contains more locales than the target system, only locales common to
both systems are displayed. If a new locale is later added on the target system and localized values exist for it
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via previous import, the localized values will display. If an imported workflow contains fewer locales than the
target system, translations on the target system that are existing will be deleted, since the imported workflow
definition will be seen as the governing workflow.
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Mandatory Attributes and References in Workflows

Workflow mandatory attributes and references are one of the most common ways to set up mandatory attributes.
The primary benefits to using this functionality are:

« Designers are given the freedom to make the right data mandatory at the right time (as opposed to using
approval mandatory settings)

« Mandatory settings are configured a single time in the STEP Workflow Designer and take effect across all
interfaces (workbench, Web Ul, and Smartsheets), without requiring any additional configuration

« Functionality includes both visual indicators and user-facing messages at the time of enforcement (e.g.,
when a task is submitted from a state)

Essentially, workflow mandatory attributes provide a combination of the functionalities described above as they
provide both visual indicators and enforcement, and do so across workbench, Web Ul, and Smartsheets, as well
as allowing for attributes to be conditionally mandatory in all of these interfaces. Because of this, workflow
mandatory is the preferred method for handling mandatory attributes. However, this method is of course only
available when data is being populated within a workflow, so when this is not the case, the other mandatory
attribute settings described in this topic can be used.

This topic describes the functionality for making attributes, attribute groups, and references mandatory specifically
within a workflow state or for a particular workflow transition.

Prerequisites

In using this functionality, it may also be helpful to understand the other mandatory attribute settings (e.g., those
that are not specific to objects within a workflow). For more information on general mandatory attribute settings,
see the Mandatory Attributes topic in the Attributes section of the System Setup / Super User Guide.

For mandatory references, there is no general functionality, other than business rules, to make references
mandatory for objects that are not specifically in a workflow. However, references can be made mandatory in
Smartsheets without the need for business rules to enforce their population. For more information on mandatory
references in Smartsheets, see the Mandatory Data in Smartsheets topicin the Excel Smartsheet Format
section of the Data Exchange documentation.

Setting up Workflow State Mandatory Data

Users can specify which attributes, attribute groups, and references are mandatory for a selected workflow
state via the State Editor.

Setting up Workflow State Mandatory Attributes

The following steps describe how to specify which attributes and attribute groups are mandatory for a workflow
state via the State Editor.

Mandatory attributes configured on a state will be marked with an asterisk when working in Web Ul. Mandatory
attributes configured on a state will be marked with an asterisk in the workbench only if the ‘Mandatory' checkbox
is selected when adding the attribute to the workbench view. For more information, see the Configuring Views
for Workflows topic in the Workflows documentation.
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Note: No markers are displayed to indicate mandatory attributes for workflow transitions.

1. In System Setup, locate and select the desired workflow.
2. Right-click and select Edit STEP Workflow.

3. Inthe STEP Workflow Designer, select the relevant state, then right-click and select Edit State to edit the
state.

4. Selectthe Mandatory Data tab in the State Editor.

3 State Editor

Edit

State On Entry On Exit i
Deadling/Escalation Comments Web U Screen Mapping Mandatory Data

@ Mandatory Attribute Groups
D * [Mame ¥ Include References » (Condition ¥

» MarketingApproverApprove  Marketing Approver, Appru:u
*|| Add Attribute Group

@ Mandatory Attributes

D » [Mame » [Condition »
* Date Date
* Category Description Category Description IsProductItem
*1| Add Attribute
&= Mandatory References

Show Edited State

5. Click Add Attribute Group or Add Attribute to add an attribute or attribute group to the list of mandatory
attributes.

6. Ifthe mandatory status of an attribute or attribute group needs to be determined by a business condition, click
the ellipsis button (EJ) next to the applicable attribute or attribute group. In the Mandatory Condition editor,

configure an appropriate business condition or select a global business rule.

Note: Unless the condition returns 'False,’ the attribute will remain mandatory.

For more information about conditionally mandatory attributes, see the Conditionally Mandatory Attributes
and References in Workflows section of the Workflows documentation.

7. Save the workflow.

If any mandatory attributes are missing when submitting an object in workbench or Web Ul, an error message
listing all missing mandatory attributes will appear, preventing the user from progressing through the workflow. For
more information on how Web Ul handles this, see the Workflow Mandatory Attributes in Web Ul topicin the
Web Ul Getting Started documentation.

© Stibo Systems - Confidential - Release 10.0-MP3 (October 2020) 162



StiboSystems

MASTER DATA MANAGEMENT

In Excel Smartsheets, users will receive an error message when validating a sheet with missing mandatory
attributes. For more information, see the Mandatory Data in Smartsheets topic in the Excel Smartsheet
Format section of the Data Exchange / Data Formats documentation.

Setting up Workflow State Mandatory References

Mandatory references are set up in a similar way to mandatory attributes in the State Editor. Mandatory
references configured on a state will be marked with an asterisk in the following Web Ul components:

« References

« Reference Value

« Reference Header

« Referenced Asset Representation
« Classification Links

« Classification Product Links

Note: No markers are displayed to indicate mandatory references for workflow transitions.

1. In System Setup, locate and select the desired workflow.
2. Right-click and select Edit STEP Workflow.
3. Inthe STEP Workflow Designer, select the relevant state, then right-click and select Edit State to edit the

state.
4. Selectthe Mandatory Data tab in the State Editor.

3 State Editor

Edit

State 0On Entry On Exit
Deadline Escalation Comments Web UI Screen Mapping

@ Mandatory Attribute Groups
I(n] > [Mame #Include References > (Condition »

» MarketingApproverApprove  Marketing Apprau‘er,.ﬂ.pprnv

> Add Attribute Group

E= Mandatory Attributes

@ Mandatory References
D » [Mame » [Condition »

» |Additional Digital Assets and Files  |Additional Digital Assets and Files

*|| Add Reference

Show Edited State

5. Click Add Attribute Group, then check the Include References box to make all references contained in the
attribute group mandatory for the workflow state.
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Click Add Reference to add a reference to the list of mandatory references.

If the mandatory status of a reference or references within an attribute group need to be determined by a
business condition, click the ellipsis button (|...]) next to the applicable reference or attribute group. In the

Mandatory Condition editor, configure an appropriate business condition or select a global business rule.

Note: Unless the condition returns 'False,' the reference will remain mandatory.

For more information about conditionally mandatory references, see the Conditionally Mandatory
Attributes and References in Workflows section of the Workflows documentation.

Save the workflow.

If any mandatory references are missing when submitting an object in workbench or Web Ul, an error message
listing all missing mandatory references will appear, preventing the user from progressing through the workflow.

In Excel Smartsheets, users will receive an error message when validating a sheet with missing mandatory
references. For more information, see the Mandatory Data in Smartsheets topic in the Excel Smartsheet
Format section of the Data Exchange / Data Formats documentation.

Setting up Workflow Transition Mandatory Data

Users can specify which attributes, attribute groups, and references are mandatory on workflow transitions
via the Transition Editor.

Setting up Workflow Transition Mandatory Attributes

1.
2.
3.

In System Setup, locate and select the desired workflow.
Right-click and select Edit STEP Workflow.

In the STEP Workflow Designer, select the relevant transition, then right-click and select Edit Transition to
edit the transition.

Select the Mandatory Data tab in the Transition Editor.
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2 Transition Editor

Edit

Events Condition On Transiﬁu:url Mandatory Data

@ Mandatory Attribute Groups
D » [Mame » [Indlude References » [Condition >

» Coloratiributes Color Attributes ]
*|| Add Attribute Group

@ Mandatory Atiributes

D * [Mame * [Condition >
» ShortltermDescription Short Item Description I= Specific Hierarchy Item
* Date Date
*| Add Attribute
&= Mandatory References

Show Edited Transition

Click Add Attribute Group or Add Attribute to add an attribute group / attribute to the list of mandatory
attributes.

If the mandatory status of an attribute needs to be determined by a business condition, click the ellipsis button (
...)) next to the applicable attribute. In the Mandatory Condition editor, configure an appropriate business

condition or select a global business rule.

Note: Unless the condition returns 'False,’ the attribute will remain mandatory.

For more information about conditionally mandatory attributes, see the Conditionally Mandatory Attributes
and References section of the Workflows documentation.

Save the workflow.

If any mandatory attributes are missing when submitting an object in workbench or Web Ul, an error message
listing all missing mandatory attributes will appear, preventing the user from progressing through the workflow. For
more information on how Web Ul handles this, see the Workflow Mandatory Attributes in Web Ul section of
the Web User Interfaces / Workflows in Web Ul documentation.

Setting up Workflow Transition Mandatory References
Mandatory references are set up in a similar way to mandatory attributes in the Transition Editor.

1.
2.
3.

In System Setup, locate and select the desired workflow.
Right-click and select Edit STEP Workflow.

Inthe STEP Workflow Designer, select the relevant transition, then right-click and select Edit Transition to
edit the transition.

Select the Mandatory Data tab in the Transition Editor.
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2 Transition Editor

Edit

Events Condition On Transitiony MandatoryData

@ Mandatory Attribute Groups
D > [Mame Include References

ColorAttributes Color Attributes
Add Atribute G rl:lupl

s
W

Condition >

L

W

&= Mandatory Atiributes

@ Mandatory References
D

L
L

Mame Condition »

W

PrimaryProductImage Primary Product Image
A Jﬁu:l-:l Reference

o

Show Edited Transition

5. Click Add Attribute Group, then check the Include References box to make all references contained in the
attribute group mandatory for the workflow transition.

6. Click Add Reference to add a reference to the list of mandatory references.

7. Ifthe mandatory status of a reference needs to be determined by a business condition, click the ellipsis button (
[Z]) next to the applicable attribute group or reference. In the Mandatory Condition editor, configure an
appropriate business condition or select a global business rule.

Smartsheets State Mandatory Attributes and References

In Smartsheets, it is possible to enforce the mandatory status of attributes, attribute groups, and/or references on
workflow states. For more information, see the Mandatory Data in Smartsheets topic in the Excel
Smartsheet Format section of the Data Exchange / Data Formats documentation.

Set Workflow to Ignore Mandatory Attributes and References

After setting mandatory attributes and/or references on a state, transition, or on a Web Ul screen, specific events
can be identified for which the population of the attributes and/or references should not be enforced. This allows
an object to move through designated states in a workflow, even when the object is missing mandatory attribute
values or linked references. The following example uses mandatory attributes, though the functionality behaves
identically for mandatory references.

In the below example, 'Color' and 'Material' are set as mandatory attributes on the Enrich state. If the user does
not populate these values on a given product and attempts to submit from the state via any transition (Reject or
Approve), the object would not be able to proceed through the workflow until the missing values were provided.
However, if the Reject event is set to ignore mandatory attributes, the user may send the product to the 'Rejected'
state even if 'Color' and 'Material' have missing values.

1. Inthe workflow editor, navigate to Edit > Edit Event Mandatory Settings.
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File | Edit  Wiew
i
Wark ¥ Undo
D
™ Redo
Mam
% Cut
Wark
Copy
[ Paste
¥ Delete
Select All
B Select Mone
Vi
Edit Workbench Views and Mappings
Localize State Mames and Events
Edit Event Mandatory Settings
Edit Audit Action

Item Enrich (ltemEnrich) &

|
Subymit
' __~Re-Submit-__

Rejected

Reject -~

2. Inthe 'Event Mandatoriness Settings' pop-up window, check the appropriate event(s) for which mandatory
attribute and reference requirements should be ignored, then close the window.

32 Event Mandatoriness Settings

Tick checkboxes below for all events that
should override State and Transition
Mandatoriness

[] Approve
] Re-5ubmit
Reject

[] submit

3. Save the workflow.

Note: While this can also be accomplished by setting mandatory attributes and references on transitions
themselves, the Web Ul only provides a visual indicator (asterisk) on mandatory attributes and references that are
set in workflow states. This feature allows users to see the visual indicator for mandatory attributes and
references required for forward progression, while also being able to disregard these requirements for certain

transitions, such as Rejections.
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Mandatory attributes set on a Web Ul screen are only honored if the 'Submit Action' has 'Enforced Validity'
checked. For more information, see the Mandatory Attributes in Web Ul topic in the Web User Interfaces /
Web Ul Getting Started documentation.
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Conditionally Mandatory Attributes and References
in Workflows

Sometimes it is essential for an attribute or reference to be populated in one or two specific cases, but is otherwise
unnecessary. To account for these cases, the mandatory status of attributes and references on objects moving
through a workflow can be enforced via business conditions set on a state or transition.

Mandatory attributes and references configured with a condition will remain mandatory unless that condition
returns false, indicating that the condition was not met and the attributes in question are not required when
proceeding to the next state in the workflow. Like standard mandatory attributes and references, if conditionally
mandatory attributes / references are missing values when attempting to submit an object to the next state, the
object is prevented from progressing through the workflow and the user receives a message listing the attributes /
references that have missing mandatory values. In Web Ul, these conditions can be evaluated on the fly and
dynamically reflected as the user works with the data, with a change in mandatory status being reflected on the
screen in real time, allowing users to react immediately, without having to submit and receive an error message.

For more information about setting mandatory attributes and references in workflows, see the Mandatory
Attributes and References in Workflows section of the Workflows documentation.

For more information about business conditions, see the Business Conditions section of the Business Rules
documentation.

Configuring Workflow States / Transitions with Conditionally
Mandatory Attributes

A condition can be mapped to an attribute or a group of attributes on either a state or transition in a workflow.

1. Navigate to the Mandatory Data tab in the State / Transition Editor.
2. Locate the relevant attribute group and/or attribute(s) and click the ellipsis button ((...]) in the 'Condition' column.
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Edit

State  OnEntry OnExt Assignee  Deadline/Escalation

@ Mandatory Attribute Groups

Comments Web UI Screen Mapping Mandatory Data

Show Edited State

D » [Mame » [Include References » [Condition
* lzameAttributes Game Attributes ] zame Reference Condition
> | Add Aftribute Group
@ Mandatory Atiributes
D » [Mame » [Condition
» Co-op Co-op Multiplayer
* PP == Multiplayer
> | Add Attribute
&= Mandatory References

In the 'Mandatory condition for' editor that displays, specify the condition to use by selecting a global business
rule via the 'Business Rule' ellipsis button (...)). Once the selection is made, close the editor.

32 Mandatory condition for Attribute Co-op

Business Rule Multiplayer Condition (Multiplayer)

Mame Multiplayer Condition
Description

Type Condition

Scope Glabal

Valid Object Types | &ll object types valid
Run as privileged

Operations Dependencies Appliesif

| Bl @] (X

£

L
| JavaScriptBusinessCondi tionWithBinds: Bindings, 0 messages, if(attr == "fes") {return true;}else {returnLIE|'sE

Add new Business Condition

Alternatively, you can create a new business condition by clicking the 'Add new Business Condition' link at the
bottom of the editor, and then click the Edit Operation button that appears. From the dropdown, select
'Evaluate JavaScript,’ then enter the business condition in the JavaScript area.
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Mame

Description

Type Condition
Scope Local

Run as privileged [ ]

Operations Dependencies Appliesif

Business Rule (Local business rule to be saved with workflow) | E @ bt

. iTrue if value for Attribute ™ "null™

NN

Add new Business Condition |
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Important: For use with conditionally mandatory attributes, the business condition should only return 'True' or

'False.' If anything else is returned it will be treated as "True'.

4. Once finished, click Save and close the editor.
5. Close the State / Transition Editor and Save the workflow.

Configuring Workflow States / Transitions with Conditionally

Mandatory References

Conditionally mandatory references on workflow states and transitions are configured similarly to conditionally
mandatory attributes. Conditions can be mapped to all references listed within an attribute group or to individual

references.

1. Navigate to the Mandatory Data tab in the State / Transition Editor.

2. Locate the relevant attribute group and/or reference and click the ellipsis button ([Z]) in the 'Condition’ column.

Note: To apply a condition to all references within an attribute group, the 'Include References' box must first
be checked. Also note that the condition will apply to both the attributes and the references in the group, so the

condition should be written to take this into consideration.

© Stibo Systems - Confidential - Release 10.0-MP3 (October 2020)

171



StiboSystems

MASTER DATA MANAGEMENT

3 State Editor

Edit
State  OnEntry OnExt Assignee Deadline/Escalation  Comments Web UI Screen Mapping Mandatory Data
@ Mandatory Attribute Groups
D » [Mame » [Include References » [Condition >
* lzameAttributes Game Attributes I5ame Reference Condition
> | Add Aftribute Group
&= Mandatory Atiributes
@ Mandatory References
D » [Mame » [Condition 3
» PrimaryProductImage Primary Product Image FalseForDiscontinuedProducts |
ﬂﬁu:ld Reference
Showe Edited State

3. Inthe'Mandatory condition for' editor that displays, specify the condition to use by selecting a global business
rule via the 'Business Rule' ellipsis button (E]). Once the selection is made, close the editor. (This editor is

identical to the one that displays for conditionally mandatory attributes.)
Alternatively, you can create a new business condition by clicking the 'Add new Business Condition' link at the

bottom of the editor, and then click the Edit Operation button that appears. From the dropdown, select
'Evaluate JavaScript,' then enter the business condition in the JavaScript area.

Important: For use with conditionally mandatory references, the business condition should only return 'True'
or 'False." If anything else is returned it will be treated as 'True'.

4. Once finished, click Save and close the editor.
5. Close the State / Transition Editor and Save the workflow.

Conditionally Mandatory Attribute and Reference Handling in Web Ul

In Web Ul, the mandatory status of attributes and references can be evaluated on the fly as the user works with
the data, with any change in mandatory status being reflected on the screen in real time. In order to display these
dynamic changes, the attribute values driving the condition must be bound to that condition in the business rule
configuration. While the condition driving the mandatory status of an attribute or reference can take more than just
attributes into account, if something else is driving the condition, such as a reference, the page will need to be
refreshed to update the interface.

[ Evalsste Javasoipt

Binds: ¥ Binds
Variable name »|Binds to » IF‘arameter »
atir Atribute Value lﬂulﬁplayer (Multiplayer)

S|
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Important: The use of business rules to determine mandatory status of an attribute or reference should be done
with care, as the performance of the dynamic behavior of the editors could be impacted if highly complex business
rules are used.

When viewing a state in a Node Editor, any attributes or references that are currently mandatory are marked with
an asterisk. If the condition returns false due to changes in data on the page, these indicators vanish. Additionally,
if there are any missing attributes that are currently mandatory, the Submit/ Approve button will be locked.

Note: Conditionally mandatory attributes and references on transitions do not have visual indicators to end users
since they are not evaluated until the transition is selected. That said, the warning message will still appear listing
the missing attribute values / references.

On Node Lists using Multi-Edit Display Mode, conditionally mandatory attributes and references are indicated by
highlighting the cell blue. As with the Node Editor screen, the mandatory status is dynamically evaluated so if the
condition returns false, the highlighting disappears.

Example

Note: This example uses conditionally mandatory attributes to describe the functionality, but the behavior is the
same for conditionally mandatory references.

The business condition states that if the value of the attribute 'Multiplayer' is 'Yes', the attributes 'Co-op' and 'PvP'
are mandatory. Otherwise, 'Co-op' and 'PvP' are not mandatory.

In the image below, the condition is returning true for the Space Adventure Game, so 'Co-op' and 'PvP' are
mandatory (and are highlighted blue). Clicking Submit/ Approve if either mandatory value is missing will result in
an error message listing which mandatory attribute(s) are missing. If both attributes have values they are free to
move on to the next state.

Iltem Enrich - Enrich

@ Select all

Fad 1D . Co-op A PvP . Multiplayer ®
College Baseball | . ..
O : J : 236126 2-6 Players 2-16 Players Yes
Game
Space
[ Adventure 236124 2-3 Flayers ez
Game
Cosmic Video S
D 347736 Mo

Game
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In the image below, the condition is returning false for the Space Adventure Game, so 'Co-op' and 'PvP' are not
mandatory (and are not highlighted). This object is free to move on to the next state, even if 'Co-op' and 'PvP' don't
have values.

Iltem Enrich - Enrich

@ Select all Submit Export Export Smartsheet

Fad 1D . Co-op v PvP . Multiplayer ®
0O ;Ee Baseball | 536126 2-6 Players 2-16 Players Yes
Space
[ Adventure 236124 2-3 Players Mo
Game
0 Cosmic Video 347736 No

Game

In the image below, the condition is returning true, so 'Co-op' and 'PvP' are mandatory (and are marked with
asterisks). Since they have values, the Submit/ Approve button is enabled.
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Basic Information and References Display Relations Cost and Prices Status

D 236124

Product Categoryfx Products | Electronics | Game Software | Playstation 4 | F#

This attribue will show the path to the object in the Tres tak

MName Space Adventure Game
* Cp-gp “m— 2-3 Players ,;

Disc Dimensions ,;

Multiplayer Yes ,;
Y R a— 2-3 Players ’;
I

In the image below, the condition is returning false, so 'Co-op' and 'PvP' are not mandatory (and are not marked
with asterisks). Since it does not matter if they have values, the Submit / Approve button is enabled.
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Basic Information and References Display Relations Cost and Prices Status
] 236124
Product Category.fx Products | Electronics | Game Software | Playstation 4 | F#
This attribus will show the path to the object in the Tres tak
Mame Space Adventure Game
Co-0p m— ’:f
Disc Dimensions B/ x53x05In "";
Multiplayer Mo "";
Dyp — — ’
S
G e [ B semaroron |

In the image below, the condition is returning true, so 'Co-op' and 'PvP' are mandatory (and are marked with
asterisks). Since 'Co-op' is missing a value, the Submit/ Approve button is disabled.
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Basic Information and References Display Relations Cost and Prices Status
D 236124
Product Categoryfx Products | Electronics | Game Software | Playstation 4 | F#°
MName Space Adventure Game
* Co-op b ,:?,
Disc Dimensions ,:?,
Multiplayer Yes ,;
- — 2-3 Players ’

Conditionally Mandatory Attribute and Reference Handling in
Workbench

Support for conditionally mandatory attributes and references is also available in the workbench, though visual
indicators are not managed in relation to this. When attempting to submit an object, conditionally mandatory
attributes / references are evaluated and an error is presented to the user listing any missing conditionally
mandatory attributes / references (in the same manner that standard mandatory attributes / references are
reported).

Determining Mandatory Status of an Attribute or Reference

Any attributes / attribute groups and/or references specified under the ‘Mandatory Data' tab of a workflow state or
transition are considered mandatory if:

« Thereis no condition set for the attribute / attribute group or reference(s)

« The condition is not applicable for the object type of the object being evaluated

« There is a pre-condition on the rule that is not met and therefore the condition is not evaluated
« The condition fails

« The condition returns '"True'
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The only case in which an attribute / attribute group or reference is not considered mandatory is if the condition
returns 'False’.

Because the mandatory status of an individual attribute or reference can be determined in a number of different
ways, some methods must take priority over others:

« Anindividual attribute or reference specified on the state / transition takes priority over attributes / references
specified as part of a group.

« Ifan attribute / reference is listed via multiple groups, the group configured with a condition takes priority.

« Ifan attribute / reference is listed via multiple groups and more than one of those groups is configured with a
condition, only the first condition listed is applied.

« Ifthe attribute is explicitly defined as mandatory in Web Ul via being set as mandatory on the screen, that
setting overrides any conditions that may say otherwise. (This does not apply to references, which cannot be
set as anything other than 'visually mandatory' on Web Ul screens)
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Monitoring Workflows

Workflows can be monitored via Workflow Profiles. Profiles are maintained on the Profile sub-tab of the STEP
Workflow navigator tab. Profiles are available to users with the 'View and Maintain STEP Workflow Profile’
privilege. A Profile can contain a wealth of information about workflows, such as: number of exceeded deadlines,
how long the tasks have been assigned to the assignees, what is the workflow throughput this month versus the
last six months, etc. This is all configured using the STEP Workflow Profile Wizard.

To create a new Profile, navigate to the STEP Workflow tab, select the Profile sub-tab, and click the Create new
link at the bottom of the Profile sub-tab.

Context |English US

New Item Creation Profile

[ Bookmarks ” System Setup ” BG Processes (4) " Search " Tree

=
=]
=
-
=
=]
=
Bl
[Te]
-
WA

Create new

Ready

Step 1: Label and Type

In the wizard that appears, provide an ID, Label (name), assign a Setup Group, and choose a Domain.
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£+ STEP Workflow Profile Wizard

Steps Label and Type

1. Label and Type ID: workflowProfile
2 W Al Label: Warkflow Profile
3, Collection Filtering
4. User feroup ke Setup Group:  |\Workflows (Workflows) E]
5. Display SEIEEFE?Taln

@ States

(") Assignees

(7 STEP Workflows

Back [ Mext ] [ Finish ] [ Cancel

The Domain options are the following:
Domain Description

States Allows a user to view data
focused on workflow states.

Example

« How many objects are in the various states of a workflow

« Who the state tasks are assigned to

« How long the objects have been in the states

« Number of exceeded deadlines

« How long the objects have been in the states that are
assigned to a particular user or group

« How many objects have passed through the states today
versus yesterday, versus the day before, etc.

Allows a user to view data
focused on assignees.

Assignee

« How many tasks are assigned to the various assignees
« How long the tasks have been assigned to the assignees
« Ifthe assignees have tasks with exceeded deadlines

« How many tasks the assignee has completed this week
versus the week before, etc.

STEP Allows a user to view data

Workflows | focused on entire workflows.

« How many objects are currently in the workflows

« How long the objects have been in the workflow, on
average

o Whatis the workflow throughput this month versus the last
six months, etc.
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workflows) that the profile should contain will be specified. The options differ somewhat for each domain (selected
in the previous step). Since profiles are not limited to a single workflow, a user could have an Assignee-domain
Profile that shows information for tasks in numerous workflows.

According to the domain chosen, the following options are available:

« States domain: A user will specify whether the profile should contain data from all workflow states or if it
should be limited to specific workflow states only. Note that if 'All States with tasks' is selected, the profile will
contain data from every workflow state, from every workflow in the system. The option to 'Hide States with no
Tasks' is unavailable if this option is selected.

-

E] STEP Worlflow Profile Wizard

Steps STEP Workflow Filtering

1. Label and Type

2. STEP Workflow Filtering
3. Collection Filtering

4, User/Group Filtering

All States with tasks

@) Spedfic States

Available States

5. Display Q Advanced Search
E] Asset Update
E] Item Creation
E] Item Maintenance

E] Product Awaiting Asset

u
E
=
T
=]
3
]
i

{13] Sales Ttem Creation
{13| UserPortal Workflow

I

Remowve Al

Selected States

-

(=)

Forecasting

Hide States with no Tasks:

| Back || Mext || Finish || Cancel

» Assignees domain: The STEP Workflow Filtering wizard screen for the Assignees domain contains the

same options as the screen that appears for the States domain.

« STEP Workflows domain: Only entire workflows can be chosen for this option. Data cannot be filtered down
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e

Steps

£+ STEP Weorkflow Profile Wizard
STEP Workflow Filtering

1. Label and Type

3, Collection Filtering
4, User/Group Fitering

5, Display

2. STEP Workflow Filtering

(7 All STEP Workflows

i@ Spedfic STEP Workflows

Availzble STEP Workflows

1] Advanced Search

3] Asset Update

E] Item Creation

E] Item Maintenance

E] Product Awaiting Asset
| Pull From Site

E] Sales Item Creation
3] UserPortal Workflow

Up

=

Selected STEP Workflows
Item Creation

[ Back ]| Mext |[ Finish ][ Cancel

-

Step 3: Collection Filtering

For Collection Filtering, a user can filter the profile results to contain information only for objects in a given

collection. This step is optional.

For example, a user could create a profile that only shows data for objects that are to go live at a certain date, or

only shows data for objects in a particular part of the tree hierarchy.
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£+1 STEP Workflow Profile Wizard ]
Steps Collection Fittering

1. Label and Type [ Filter by Collection

2. STEP Workflow Filteri

arkiiow Fitenng Select Collection Selected Collection

3. Collection Filtering

4., User/Group Filtering -8 Collections

5, Display Add

o
i
[=]
i

Automatically refresh Collection when Profile is loaded

[ Back ]| Next |[ Finish H Cancel

Step 4: User / Group Filtering

A user can filter the profile results to contain information only for tasks that are assigned to specific users or user
groups.

Note: Step 4 is disabled for the STEP Workflows domain.

For example, in the Assignee domain, the 'Specific Users / Groups' option is valuable if a user would like to view
the workload for a number of users. If the 'Assignees’ option is selected, users with no tasks will also be included in

the profile.
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£+1 STEP Workflow Profile Wizard =
Steps User/Group Fittering

1. Label and Type Assignees

2. STEP Workflow Filtering

3. Collection Filteri All Only Users (@ Only Groups

4. User/Group Filtering i@ Specdific Users /Groups

c Di

i Select Users/Groups Selected Users/Groups

:ﬁ- Buyer Group

L
7
£
[

=
m
o
(=8
o
=]
=
m

- e oor

1:%. eCom Group

: £ Remay
[+-%h Forecasting Group e
1:@: Image Group
¥ Integration
[#-<% Marketing Copy Group =
Hide Users/Groups with no Tasks
| Back || MNext || Finish || Cancel

Step 5: Display

The profile display will be different depending on which domain was selected in Step 1. For the States and
Assignees domains, the profile will consist of two tables: a Master Table and a Details Table.

Table Description

Master | Displays more general information about the states or assignees.
Table

Details | Appearswhen a row in the Master Table is selected—displays more specific information about the
Table | objects that are contained within a state or assigned to an assignee.

For the STEP Workflows domain, there is only a single Master Table. Step 5 is where a user specifies which
columns should be shown in these tables.

Common to all domains are the two divisions of the Master Table settings: Live Data and On Demand Data.
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Live Data Data that can be kept up to date automatically—data for workflow instances in their present
state.
On Demand Historical data that is retrieved from the object's State Logs.
Data

As the name indicates, this data is only generated on demand. For all three domains, the On Demand section
allows a user to specify a time period of days, weeks, or months for which they would like to generate historical
data. For example, if you select three (3) days, the generated On Demand table will display three columns, one for
each selected day (e.g., "Throughput today," "Throughput yesterday," "Throughput 2 days ago.")

E] STEP Werlflow Profile Wizard >
Steps Display
1, Label and Type Master Table:
2. STEP Workflow Filtering Live Data:
3. Collection Filtering Show count column Show exceed Deadlines column
4. User/Group Filtering Show average time in State column Show maximum time in State column
5. Display Show STEP Workflow column
On Demand Data:
Show histarical throughput Show historical avg. time in State

Show columns for the last |1« | |month{s) -

Details Table:

Show STEP Workflow column Show Deadline column
Show time in State column Show Assignee column
Show Assignment time column Show Status Flag column

Back Mext Cancel

The following sections explain the different options by domain, for Step 5:
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States Domain

Table Description

Settings

Master « Show count column: Number of objects currently in the state

-Il_-abké)- « Show average time in State column: Average time that the objects have been in the state
ive Data

o Show STEP Workflow column: Name of the workflow to which the state belongs

« Show exceeded Deadlines column: Number of exceeded deadlines for objects in the state,
followed by the average exceed time

« Show maximum time in State column: The longest period an object currently in the state has

been there
Master « Show historical throughput: Number of objects that have exited the state within the given
Table-On period (day/week/month). The number is increased each time an object exits the state,
Demand regardless of whether the object has been in and exited the state earlier.
Data « Show historical average time in state: Average time that objects—which have exited the state
within the given period (day / week / month)—were in the state
Details « Show STEP Workflow column: Title of the workflow to which the state selected in the Master
Table Table belongs

« Show time in State column: How long the object has been in the state

« Show Assignment time column: How long the task (which the object-in-state represents) has
been assigned to the current assignee

« Show Deadline column: The deadline, if any
« Show Assignee column: The assignee
« Show Status Flag column: The current status

Assignees Domain

Table Description

Settings

Master Table- | « Show count column: Number of tasks currently assigned to the User/Group

Live Data « Show average Assignment column: Average time the current tasks have been assigned to
the user/ group

« Show exceeded Deadlines column: Number of exceeded Deadlines for Tasks assigned to
the user / group, followed by average exceed time

« Show maximum Assignment time column: Longest period that a task has been assigned to
the user/ group

Master Table- | « Show historical number of assignments: Number of assignments within the given period
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Table Description

Settings

On Demand (day/week/month). i.e., how many times during the period have tasks been assigned to
Data the user/ group

« Show historical number of completed tasks: Number of tasks that were completed within
the given period (day / week / month) while assigned to the user / group

« Show historical average assignment time: Average time tasks were assigned to the user/
group within the given period (day / week / month)

« Show historical average completion time: Average time within the given period (day / week
/ month) that it took a user / group to complete a task, once assigned

Details Table « Show STEP Workflow column: Name of the workflow in which the task exists
« Show State column: The state in which the task exists

« Show Assignment time column: How long the task has been assigned to the current
assignee

« Show Deadline column: The deadline, if any

« Show time in State column: How long the task has existed, i.e., how long the object has
been in the state

« Show Status Flag column: The current status

STEP Workflows Domain

Table Description

Settings

Master Table- | « Show count column: Number of objects currently in the workflow that are not in a final state
Live Data on the outer level

« Show average time in STEP Workflow column: Average time the objects have been in the
workflow

Master Table- | « Show historical throughput: Number of objects that have reached a final state on the outer
On Demand level during the given period (day / week / month)

Data « Show historical avg. time in STEP Workflow: Average time that it took objects to reach a

final state on the outer level (from time of workflow initiation) during the given period (day /
week / month)

Profile Editor

Once a profile has been configured, it is possible to generate the On Demand data by clicking the 'Update on-
demand data' button at the top of the Profile tab. It is also possible to edit the configuration and copy the master
table data into the clipboard, allowing you to easily paste it into a spreadsheet (e.g., Excel).
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Itis important to note that the 'Update on-demand data' button option will be available only if either one or both of
the check box options under On Demand Data is checked. These options are 'Show historical throughput' or
'Show historical avg. time in state' while creating a new profile. If the option is not available, it can be enabled by
editing the configuration.

F¥1 STEP Workflow Profile Wizard Py
Steps Display
1. Label and Type Master Table:
2. STEP Workflow Filtering ~ Live Data:
3. Collection Filtering Show count column Show exceed Deadlines column
4. User/Group Filtering Show average time in State column Show maximumn time in State column
5. Display Show STEP Workflow colurmn
On Demand Data:
Show historical throughput Show historical avg. time in State

Show columns for the last |1« | |month{s) -

Details Table:

Show STEP Workflow column Show Deadline column
Show time in State column Show Assignee column
Show Assignment time column Show Status Flag column

Back Mext Cancel

Once the 'Update on-demand data' option is run, a background process is created, and then the table is updated.
The main use of this option is that it will display the number of objects that have exited the workflow (for STEP
Workflow domain) within the given period or based on the average time in state.

Note: Data from Workflow Profiles can be represented in widgets on the Global STEP Dashboard. For more
information, see the Global Dashboard topic in the Data Quality documentation.
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Remove Objects from Workflows

There are many reasons why an object may need to be removed from a workflow. A few of the reasons for
removing an object from a workflow are:

1. It has finished going through the workflow
2. The object needs to be amended before being put back into the workflow
3. The objectis no longer relevant for the workflow

No matter the reason for removing an object from a workflow, objects can be removed, i.e., taken out of
workflows, in several different ways.

Remove Single Object

If a user wants to remove a single object from a workflow, and they have the 'Remove Items from STEP Workflow'
privilege, this can be accomplished via the Remove from STEP Workflow context menu option on the object.

To do so, right-click on an object, or product, and select Remove from STEP Workflow.
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Convert to Product-Override
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Cut Ctrl+ X
Copy Ctrl+C
Paste Ctrl+V
Paste Link Ctrl+L
Delete

Duplicate Ctrl+]

DuplicateRecursively
Add Children To Override

Rernowe Child From Owverride

Approve Object Ctrl+Shift+]
Partial Approve...
Check Approve

Approve Recursively

Search Below
Export Data Below
Initiate in STEP Workflow

1eady

Rermowe from STEP Workflow

Remove All Objects from a Workflow

If a user needs to remove all objects from a workflow, and they have the 'Remove ltems from STEP Workflow'
privilege, this is possible via the workflow context menu option Remove items from STEP Workflow.
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Navigate to System Setup, right-click on the workflow that needs all items removed, and select Remove items

from STEP Workflow.
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Remove Objects from a State Using Bulk Updates
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Should a user want to remove all objects from one state in a workflow, they can do so using Bulk Updates if they
have the ability to search the STEP Workflow tab, and they have the 'Perform Bulk Update' privilege.

1. First navigate to the main Search tab, and once on the tab, from the dropdown Search menu select STEP

Workflow.
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Revised Objects Changed Since

Document Content D = 135006

Search from List

Javascript search

Missing Mandatory Values
Unapproved

Product Override Search

Search in Publication Hierarchy
Referenced By
References
STEP Worlflow
Sample Result

Translation Status
Unpushed or Failed Assets

[ STEP Workflow ” Bookmarks ” System Setup ” BG Processes ]

StiboSystems

MASTER DATA MANAGEMENT

2. Next, from the two dropdown menu, selects the desired workflow and then specifies which state all objects are

to be removed from. Press Search when finished.

STEP Workflows
STEP Workflow :Shipment Order Process -
State Review Data x|
G~ | Reset |
Search Result Show Details
[ Mame * |

3. Once the search result displays, click on the Bulk Updates button at the bottom of the results list.
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4. The Bulk Updates window will display. Click next and on the second step, Operations, from the dropdown
menu at the top select Workflow > Remove items from STEP Workflow.

i

-

Run Business Rule

£%] Bulk Update 5]
Steps Operations
1. Con ation
figur Merge Attribute Values
2. Operations )
2 Parameters Attribute values » : E] into [;]
CL T Data Quality ¥ 3l values -
5. Advanced Publishing r -
References and Links k
Workflow r Clairm

Initiate iterns in STEP Workflow

Send Republish Event I

Remove items from STEP Workflow I

Set Mame Trigger STEP Workflow Event
Set Object Type
Add Operation
Back MNext Finish

5. Select the desired workflow, enter a 'Process Note' if desired, and select Finish. This will remove all objects

from the state.
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[=3 Bulk Update =
Steps Operations
1. Configuration (Remova items from STEP Workiow i
liEeris Choose a Workflow :11123 -
3. Parameters Process Mote This is the workfow ID for Shipment Process Order. All Items are removed from the Review Data state
4. Preview
5. Advanced

Add Operation

[ Back ][ Next ]I Finish ]I[ Cancel ]

Removing Objects from the Final State

As objects by default stay in the final states of the workflow until explicitly removed, it is highly recommended to
automatically take the objects out of the workflow when reaching a final state on the outer level. This can be done
one of two ways: use the 'Remove object from STEP Workflow' business action or use an 'Execute JavaScript'
business action. It is important to note that both business actions can be used on states other than the final state,
however, the information described below is the most typical scenario in which these actions are used.

Remove object from STEP Workflow Business Action

1. Tosetup the business action, navigate to System Setup, open the STEP Workflow Designer for the desired
workflow, and right-click on the outer level Final State.

2. Inthe dialog that appears, select the On Entry tab > Add new Business Action > Merge into.
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E STEP Workflow Designer - 11123*
File Edit View

StiboSystems

Workflow Properties
jin} 11123

Mame | Shipment Order Process

Workflow Variables/Attachments

Reson for rejection?’ abe | -
statusFlag1’ abe |§|
statusFlag? abe|

Validation errars:

the submenu.

MASTER DATA MANAGEMENT
Shipment Order Process (11123) & -
End State (1)
State Editor
Stata 0N Entr ) Assignee|Deadine/Escalation| Comments|eb UL Screen Mapping|Mandatory Attributes
Business Rule {Local business rule to be saved with workflow) E
Name
Description
Type Action
Scope Local

Run as privileged [

Merge into e X

Add new Business Action a

[ Show Edited State

Go to 'Workflow' from the dropdown menu, and click on the Remove object from STEP Workflow option in

The Current radio button is selected by default. (If using this business action in a way that it will be invoked

outside of a workflow or if the current action should apply to a different workflow, then you can select Other and

specify a different workflow.)
Next, if desired, add a message to be logged in the Note field of the object State Log.
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$ Edit Operation

r [ Remove ohject from STEP Workflow

Message:

Save Cance

6. Click Save and remember to save your changes before exiting the STEP Workflow Designer.

Execute JavaScript Business Action

If below script is entered in a business action configured 'On Entry' to the final state, once objects enter the state,
they will be removed from the workflow and the supplied process note posted to the State Log if one was entered.

node.getWorkflowInstance (workflow) .delete ("Object automatically removed
from Workflow");

1. Toadd the above script to a business action, navigate to System Setup, open the desired workflow's STEP
Workflow Designer, and right-click on the outer level Final State.

2. Inthe dialog that appears, select the On Entry tab > Add new Business Action > Merge into.
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File Edit View

Workflow Properties

»

Shipment Order Process (11123) &

D 11123

Mame | Shipment Order Process

Workflow Variables/Attachments

Reson for rejection?’ abe | -
statusFlag 1’ ahe El
statusFlag? abe|

EEIR

Validation errars:

Proceed _1

m

Proceed_2

Review Data (1) Error

Confirm data

Proceed_3

End State (1)
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\ State Editor

Business Rule

{Local business rule to be saved with workflow)

Name

Description

Type Action
Scope Local

Run as privileged [

Operations|Dependencies|Applies i

Istate 5 ENtrY assignee| Deadine Escalation|Comments|Wieb UL Screen Mapping|Mandatory Atiributes

¥ & X

Merge into e

LT

Add new Business Action n

[ Show Edited State

3. Select'Execute JavaScript' from the dropdown menu, and click on the Edit Binds button, to add any
necessary binds. Note that the two binds being added for this particular workflow are: Workflow to Current
Workflow and Node to Current Object.
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£+ Edit Operation ==
Execute JavaScript ¥ |
Binds: ¢ Binds
Variable name * |Binds to >
workflow Current Workflow
node Current Object
Messages: § Messages
|h'.aria|:nle name » |Message
JavaScript: 1
2
3
Edit externally
4 1 [ 3
Save Test JavaScript Cancel

4. Nextadd the following script in the JavaScript window. Notice how the variable name for the Current Workflow
Bind is used. Users should make sure to replace with their variable name in the script.

£%] Edit Operation [

[ | Exeoute JavaSoaipt ;]

Binds: {7 Binds
Variable name

x

W

Binds to
warkfow ~ Current Workflow

node \ Current Object

b3 \
Messages: § Messages
N

Variable name
JavaSaipt: 1l node.getWorkflowInstance (workflow) .delete ("Chject automatically removed from Workflow™) :

z
3

> |Message > I'Franslatiu:uns

Edit externally
4 mm | &

Save Test Javascript Cancel

5. Click Save and remember to save your changes before exiting the STEP Workflow Designer.
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Running Background Processes from Workflows

Viathe API Task interface, it is possible to start a background process, BGP, and have events triggered on the
task matching the end status of the background process. Image below shows a simple workflow where an
Approve Recursively Background Process is started when entering the 'Trigger_ BGP' state. When the
background process is done, one of the transitions out of the state will be performed based on the end status of the
background process. i.e., If the end status is 'succeeded’, the "bgp.succeeded" event will be triggered. If it is failed,
the "bgp.failed" event will be triggered. Similar to the "StatelD.Something" (where 'Something' stands for the
user's word choice) and "stibo.import" events, any event beginning with "bgp." will be hidden in the STEP
Workflow Items editor and on the Object Tasks tab.

In the picture below, as soon as a task is released to the 'Trigger BGP' state, the Approve Recursively with a BGP
process script will execute.

E! STEP Workflow Designer - Testl @
File Edit View
Workflow Properties =

»

Approve Recur;ively (Test1) @&

(] Testl

Mame |Approve Recursively

Workflow Variables/attachments
BGP ID' abe
VariableHoldingUserID' abe

—Try_Again— Trigger_BGP ()

. sugceeded
Failure @) —bgp-fii"e‘*/bgp
Success
e )
Validation errors: =
4]

Final

:

4 1l | 3

Once a BGP has finished, if a particular task / item needs to be investigated, a user can navigate to its State Log
tab and see all Background Process IDs that occurred.
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12-GGK79 rev.0.11 - Status|

Product || Sub Products || References || Referenced By || Images & Documents || Commercial || Tables || Category Profile || Proof View || Status m

@ Approve Recursively

Show transitions Show assignments Show notes

[Time User  » |Event From State > [To State Mote > |Assignee * Log Type
> |2016-05-23 07:13:24 USERL Success T COIERATFDMES A b transition

removed from Workflow
> | 2016-05-23 07:11:18 USERL Success LISERL assignment
> | 2016-05-23 07:11:18 USERL  bop.succeeded  [(State-3)  Success :Lﬁ:zgsﬂﬂg?m} iggesdmstats transition
* |2016-05-2307:11:13 LSERL State-3) USERL assignment
> | 2016-05-2307:11:13 USERL  [Try Again Failure (state-3) transition
> | 2016-05-23 06:02:52 LUSERL Failure LISERL assignment
> | 2016-05-23 06:02:52 USERL  bap.failed (state-3)  Failure gi‘l’::“ (EE® Fran) g Enshlis transition
» | 2016-05-23 06:02:50 LISERL State-3) USERL assignment
» | 2016-05-23 06:02:50 USERL Initial (5tate-3) ftransition
» | 2016-05-23 06:02:10 USERL Initial USERL assignment
» | 2016-05-23 06:02: 10 USERL Initial transition
A SYSTEM-GEMERATED MESSAGE: Object "

» | 2016-05-23 06:01:46 USERL Success Femoved from WiorkRow fransition
» | 2016-05-23 05:50:55 LUSERL Success LISERL assignment
> | 2016-05-23 05:50:55 USERL  bap.succeeded I[Stahe—S} Success :ﬁ:g@_mm; ooeadaisiatn: transition
» | 2016-05-23 05:50:51 USERL ||[513he—3} USERL assignment
» | 2016-05-23 05:50:51 USERL IInitial (5tate-3) transition

Should the user need to examine any background process information further, they can do so by either going to

the main BG Processes tab and looking at the receptive workflow's background processes or by searching for the
Background Process ID.
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44 Context Enlish US - €D Cwm 5] 2 E [l eoto [10ieme = ER
BG Processes Started from Workflow - Background Process
; ook aroumivrocess [
- ﬁfﬁ AddItemsToCollection » [|'$ Properties &
= - Analyze Change-Package | ||property » Value 3
EI L——_I--:'::ﬁ Approve Recursively Started by —
>% Queued Processes
" E}% Active Processes = || BGP_175853
E : -%:% Approve 12-GGKT9 Description Started from Workflow
E % Started from Workfiow Execution Server doc-dev
& -é:% Started from Workflow Done
2 % Approve RecydeBin Progress
— . .38 Approve Level2_Test Status succeeded
s = Ended Processes Created Thu Jun 02 15:01:54 EOT 2016
o Workflow
p & rrramr Started Thu Jun 02 15:01:55 EDT 2016
@ E]--:!:ﬁ Asset Integrity check
2 E]..L‘:ﬁ AssetDelivery Finished Thu Jun 02 15:01:55 EDT 2016 E
(0]
— E]--:!:ﬁ Autopage Batch Service Processing Time Om0s
‘% E]":':ﬁ BGRTest Time in Queus Omis
El - £ Bulk Update :
S | E1-£i Category Profile Batch Processes P 0
m
] E]--% Change Attribute References # of errors 0
= E]--% Create Collection
Execution Report
i? E]--:':ﬁ Create Publication Section as copy of @
2 E]--% CreatelnDesignPackage 1 Recursive approval started on *100703" in context ‘English US’
f -5 CreatePDF © Approved 0 classifications; 0 products; 0 assets: 0 entities..
] {5 CreatePDFofPublication = Recursive approval of 0 objects done. 0 warnings and 0 errors.
E]--% CreateProductProof
[#-#:~ Data Profiler i
] |:;E T N b 4 | 130f3 | Ik [ [ Save... ] [ Truncate

If the BGP should fail, looking at the BGP report can help in determining why.
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Started from Workflow - Background Process

<
% Properties

Property > Value >
Started by DBA

Id BGP_179741

Description Started from Workflow

Execution Server doc-dev

Status failed )
Created Mon May 23 09:01:23 EDT 2016

Started Mon May 23 09:01: 24 EDT 2015

Finished Mon May 23 09:01:25 EDT 2016

Processing Time Omls

Time in Queue Omls

# of warnings ]

# of errors 1

¥ Execution Report
Recursive approval started on “100703" in context ‘Enaglish UK
Approved O classifications; 1 products; 0 assets; 0 entities.; 1 errors
Approve error repart for 12-GGKT9
I Unable to approve object due to missing mandatory values on attribute(s): stepaifattripute ?id=0tyOfMextlowerPackage
Recursive approval of 1 objects done. 0 warnings and 1 erraors.

4 4l 1-50f5 | [k [ Truncate

In the case of this 'Approve Recursively' workflow example, the task will be moved to the Failure state, and only
once the error is fixed, then the task can be moved from the Failure state by selecting the event'Try_Again'. Then
if the BGP is successful, it will move to the Success state.

On Entry Background Process Script

While the script below could be used for other scenarios, two scenarios that this script can be used with workflow
for are the following:

1. Ifan objectis required to run a translation, and it is mandatory that an object is in the approved state before
running the translation.

2. Ifthere is any extraction required from the Approved workspace
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The On Entry script that starts the background process is shown below. The last line stores the ID of the started
background process in a workflow variable with ID "BGP ID". The ApproveRecursiveServiceDescriptor is

described in the public API documentation, accessed by clicking the STEP APl Documentation button on the
STEP Start Page.

var task = node.getTaskByID ("WokflowID", "WorkflowStateID");

var serviceDescriptor =

com.stibo.services.base.approverecursive.ApproveRecursiveServiceDescripto
r;

var parameter = new serviceDescriptor.Parameter();
parameter.context = step.getCurrentContext ()
parameter.nodes = [node];

var bgp = task.startBackgroundProcess (serviceDescriptor, parameter,
"Started from Workflow");

node.getWorkflowInstance (workflow) .setSimpleVariable
("WorkflowVariableID", bgp.getID());

Note: The "WorkflowID" and "WorkflowStateID" in the top line, and "WorkflowVariableID" in the bottom should
be replaced by the users desired workflow information.

The On Entry script in the state "Trigger BGP" will look like the image below. Also notice that the image below has

filled in the appropriate "WorkflowID," "WorkflowStateID," and "WorkflowVariablelD" in accordance to the
workflow information.

E! Edit Operation @
r

Binds: % Binds
Variable name » |Binds to

node Current Object

step STEP Manager
workflow

A

Messages: 7 Messages

Variable name » |Message

AS

rar task = node.getTaskByID|("Testl”, "Trigger EGF™):

Current Workflow

» [Translations

JavaScript:

rar sServicelescriptor = com.stibo.services.base.approverecursive., ApproveRecursivelervicelescriptor:
rar parameter = new sServicelescriptor.Parameter (] :

parameter.conteXt = step.getCurrentContexti()
parameter.nodes = [node] :
var bgp = task.startBackgroundProcess (servicelescriptor, parameter, "3tarted from Workflow™):

node ., getorkflowvInstance (workflow) .getlimpleVariable ("EGF IDY, bgp.getID(l];

Edit externally

I

Save Cancel
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Send Email from a Workflow

Generally emails are sent from a workflow to a user to escalate the importance of a task as it moves during the
transition from one state to another. There are a number of reasons why a workflow might be setup to do this. One
reason might be that a task was rejected from a state by the 'reviewer' due to the task not being done correctly. In
this case, if there was a business action set up on the transition to notify the previous user, the user then would
receive an email saying that the task they had previously pushed through was sent back. No matter the reason for
setting up email notifications from workflows, it is possible to set this configuration up via a business action utilizing
the "mailer" script shorthand. The business action can be configured or used on the State Editor screen in the
'Deadline/Escalation’, 'On Entry', or 'On Exit' tabs, as well as on the Transition Editor on the 'On Transition' tab.

For information on configuring email from STEP, see the Email from STEP topic in the Resource Materials of
online help.

Dynamic Email Addresses

When sending emails from a workflow, it is often necessary to send emails to different users who interact with the
same workflow. One scenario for this might be that a number of users may claim tasks from the same state. If the
task is later released, and then rejected due to an error, it is important to inform the correct user who last worked
onit.

Configuring Emails from Workflows

The script example below shows how an email address defined on a STEP User can be obtained, and how an
email without attachments is sent to that user. In the following example, this script is used on a Transition Editor on
the 'On Transition' tab.

var userId = node.getWorkflowInstance (workflow) .getSimpleVariable
("VariableHoldingUserID") ;

var emailAddress = step.getUserHome () .getUserById (userId).getEMail () ;
if (emailAddress) {
mailer.send ("noreply@stibo.com", emailAddress, "From Workflow",

"This is a mail sent from a Workflow");

else {

logger.warning ("No email address specified for User with ID " + userId);

}

Conditions
To execute the above configuration, the following two conditions must be met for 'Sending Email from a Workflow'.
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1. A Simple Mail Transfer Protocol (SMTP) server must be configured in the executing system.

2. The user who is to receive the email should be entered into the User tab under description. To do so, go to
System Setup, navigate to the node that houses Users and Groups, expand the node and click on the user who
will be emailed. Enter in their name and email.

System Setup < User L - User
=i Super Users || [TEEH | Guiset-Up || System Settings || Log |
..... & cfor @ —
..... c_ien
..... g DBA Mame | » |Value 3
..... £, DTPUser * D LISERL
""" & kihe * Mame Lger L
..... i 1
g ::pfbher » E-Mail email @domain.com
..... g
,,,,, £ user » Force Authentication wia 5...|  []
..... &, User * Group Information abi;
""" & USER * User Information abe:
..... lUser 2
_____ g User 3 | * |Change User Password
..... 2 User 4 || ¥ Groups
..... £, User 5 Mame v|Group Information >
..... &, User 6 * Buper Users
..... &, User 7 _ ||| | Add User to Group
..... & Lser 8 =
..... ﬁ l=zer 9
..... ﬁ User A
----- % UserB -
..... ﬁ User G
..... ﬁ USEF J
..... I& LIHL
----- =, User M 1N

In the example below, there are two business actions set up to send emails to various users.
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£+ STEP Workflow Designer - Business_Action
File Edit View
. =
Workflow Properties Business_Action (Business_Action) & i
D Business_Action

Mame |Business_Action

Workflow Variables/Attachments

assinge’ abe:

Released_by' abe

Validation errors:

m

Submit e

Review

ﬂ;\

Acéept

One business rule is on the State Editor on the 'On Exit' tab coming from the Edit state going to the Review state.
This business action, which is pictured below, is set up to retrieve the email ID of a user who submits a task from

Edit state to the Review state as a variable. In this case, 'Released_by' is the variable defined to retrieve the email
ID.

See Workflow Variables in the Workflows documentation for more on workflow variables.
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E] Edit Operation @

[ | Execute Javasoipt ;]
Binds: % Binds

Variable name > [Binds to

node Current Object

workflow Current Waorkflow

step STEF Manager

b3

Messages: 7 Messages

Variable name » |Message > Translations

=

rvar assigneelIDl = step.getCurrentUser () .getIDi();
node.getWorkflowInstance (workflow) .setiimpleVariable ("Released Bvy", assigneelD):

JavaScript:

Edit externally

[ Save ” Cancel

The second business action is on the Transition Editor on the 'On Transition' tab. This transition is coming from the
Review state going to the Edit state and has the event name Reject.

The business action script uses the variable 'Released_by' as well, where it is helping to identify who to send the
workflow email to and notify that the task they just submitted was rejected. This script also is sending the email to
the user without any attachments other than the message. Notice that the message shown in pink, can be crafted
to say anything that might be helpful to the receiver whenever a task is rejected.
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E] Edit Operation @
r [Exeaute Javasaipt =
Binds: § Binds
Variable name » |Binds to >
node Current Object
step STEP Manager
workflow Current Workflow
mailer Mailer

=

Messages: 7 Messages
Variable name » |Message * [Translations »

&

var userld = node.getWorkflowInstance (workflow) .get3impleVariahle ("Eeleased hby");
rar emailiddress = step.getlUserHowe () .getUserById(userId) .gecEMaili)
if [emailiddress) |

JavaScript:

mailer.send("noreplyistibo.com™, emailiddress, "Fromw Business Action Workflow™,
"Thiz is a mwail sent from a Workflow, as this task has been rejected™):

¥

else
logoger.warning ("o email address specified for User with ID " + userId);

i

4 1 3
Edit externally

[ Save ” Cancel

Itis important to note that if there is no email address registered, or if the email is not a valid one, the executing
user is not notified (e.g., no pop-up appears). However, it is captured in the STEP system log on the application
server.

If the user doing the rejecting should be notified that no email was sent and provided with an error message, then a
business condition must be added to the Transition Editor on the 'Condition’ tab. The following script is what
should be entered in below.

var userId = node.getWorkflowInstance (workflow) .getSimpleVariable
("Released by");

var emailAddress = step.getUserHome () .getUserById (userId).getEMail () ;
if (emailAddress) {

return true;

}

else {

return "No email address specified for User with ID " + userId;

}
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7

E! Edit Operation @
r [Evakate Javasoipt_=
Binds: § Binds
Variable name * |Binds to »
node Current Object
workflow Current Workflow
STEF STEF Manager
Messages: § Messages
Variable name » |Message * [Translations >

=

Javasaipt | yay userId = node.getWorkflowInstance (workflow) .getSimpleVariable ("Released by");
var emailbddress = step.getUserHomwe () .getUserById (userId) .getEMail() ;

if (emailaddress) |
return trues;
K
else |
return "No email address specified for User with ID " + userId:;

Edit externally

[ Save H Cancel

Static Email Address

In the above scenario, STEP will trigger emails to the executing users. However, in some cases the same user will
always need to be notified and never change (a static email address). In this case it is possible to send emails to
the static email address with the 'Send Email' operation, and no JavaScript is needed.

This 'Send Email' operation can be added in a State Editor on the 'On Entry', 'On Exit' or 'Escalation’ tabs. It can
also be sent in the Transition Editor on the 'On Transition' tab. Select the appropriate Editor and tab and then
select Add new Business Action > Merge into > Send Email.
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E] Edit Operation @

[ Send Email -
5 | %

To: | |

From: |d|::|:—dE'u' @stibo.com |

Subject: | |

Message:

[ Save H Cancel
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State Characteristics in Workflows

The State tab of the State Editor allows for workflow designers to assign specific characteristics to a state.

-

£+1 State Editor ==

Edit

D State-1
MName |Initiate Data

- Characteristics
Initial

[ Final

[ Cluster

[ Parallel

[ Show Edited State |

When creating states for a workflow, not all states need a characteristic assigned to them. Many states will not
have any characteristics assigned, but in some cases state characteristics become very important. For example, in
order for a workflow to be valid, it needs one Initial state and one Final state. Additionally, if clusters are presentin
a workflow, there also needs to be one Initial state inside the cluster.

This section of the documentation describes the various state characteristics and how they are used within
workflows, specifically:

« Initial and Final
o Clusters
o Parallels
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Initial and Final States in a Workflow

A workflow can have as many states as it needs in order to correctly depict the action or actions taking place.
These states all must have at least one transition coming into the state and at least one outgoing transition from the
state. However, the two states that every workflow need, the Initial State and a Final State, do not necessarily
have to abide by these transition rules depending on the workflow layer they reside in.

Initial

Initial State

The Initial State, represented by a slightly darker colored state, signals to an object entering the workflow where
to start. This could be in a simple workflow, such as the one pictured below, or it could be in regards to telling an
object which state to start with when entering a cluster. There can only be one outer Initial State for the general
workflow, and there can only be one Initial State inside each cluster. An outer layer Initial State does not have an
incoming transition, only an outgoing transition. This outer Initial State signals to the object / task entering the
workflow where to start. Once an object knows what state to start with, the workflow can progress.

Workflow 4 (Workflowd) @&

‘ Initial State ‘

-
State 2
w

For more on Clusters, see Clusters in Workflows in the Workflows documentation.

Initial as a Parallel

It is often necessary for more than one incident to take place at a time in a workflow. In this case, a Parallel
structure should be used as the Initial State, which auto-initiates the object into the Initial States within each
cluster simultaneously. The object only leaves the Parallel once the object has reached the Final State in each
cluster.
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Workflow 4 (Workflowd) &

= Cluster = Cluster 2

State 2 Cluster
State 2 Cluster 2

w
| Fimal Cluster Final cluster 2

1

Review State
w

o)

D.

Final

For more on Parallels, see Parallels in Workflows in the Workflows documentation.

Final State

States with the Final characteristic are used to denote the ending of either an entire Workflow or a Cluster. Only
Final States within Parallels and Clusters can have an incoming and outgoing transition.
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i

Review State
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All workflows should have a reachable outer layer Final State. Never-ending workflows can lead to performance
impacts. However, there cannot be transitions out of a outer layer Final State characteristic, only incoming
transitions. For this reason the outer layer Final State rarely represents a human task. When an object reaches a
Final State on the outer level of a workflow (not in a Parallel or Cluster), it will remain there until the object is taken

out of the workflow.

For performance reasons, and because the workflow cannot be started again on an object already in the
workflow, it often makes sense to automatically remove objects from the workflow as they reach a Final State on

the outer level.

For more on how to automatically remove an object from a workflow see Remove Objects from Workflows in
the Workflows documentation.
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Clusters in Workflows

A cluster is a grouping of states. There are two main reasons why a grouping of particular states might be
beneficial within a workflow. It may be useful for purely administrative reasons, making it possible to easily monitor
a section in a workflow, or it may be used in conjunction with other clusters inside of a parallel, which is the more
likely use case. For whatever the reason may be, it is important to know how to clusters work and how to create
them.

Creating and Entering Clusters in Workflow

Any state can have the cluster characteristic added to it. This means that the particular state can have sub-states.
The first sub-state in a cluster has to be an Initial state in order for the workflow to be valid. This means that there
could be multiple states in a workflow with the characteristic of Initial state.

r
Workflow3 (Workflow3) %
¥
= 2nd State

¥
4th State

Sth State

UU

L
End Inside Cluster

7th State

End Woarkflow

2l

Note: For more on the Initial state, see Initial and Final States in a Workflow in the Workflows
documentation.

Itis important to note that states with cluster characteristics are still states in their own right. If an objectisin a
cluster sub-state, it is also at the same time in the state with the cluster characteristic.
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If a state with a cluster characteristic contains sub-states, the cluster characteristic cannot be deselected in the
State Editor.

= o
= 2nd State ” T ........ \__b
E] State Editor

Edit

Portal Screen Mapping I Mandatory Attributes
Deadline [Escalation I Comments
. State | OnEntry | OnExit | Assignee

4th State
] State-2

Mame |2nd State

- Characteristics
[ Initial

Final

f Cluster I
|

' [ Parallel
[ 7th State ] [ Show Edited State ]

In looking at the following cluster, it is important to know how an object placed into the workflow would move
throughit.
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Workflow3 (Workflow3) (&

1st State

d; I

= 2nd State

3rd State-Initial

4th State

/|

U

ath State

L
End Ingide Cluster

7th State

Enel Woark flow

gl

1. After entering into the 1st Initial State, an object enters into the 2nd State, which also happens to be a
cluster.

2. Onceinthe cluster, the object also simultaneously enters into the 3rd State-Initial.

3. ltthen proceeds through the next ordered steps until it reaches the End Inside Cluster (Final state).
Because this is inside of a cluster, there is a transition allowed out of this Final state (which is different than
what is allowed for the ultimate Final state of a workflow). In this case, it exits not only the End Inside Cluster
(Final state), but it also exits the entire cluster and goes to the 7th State.

4. Fromthe 7th State, it proceeds to the End of Workflow (Final state). The object has reached the end of the
workflow.

Exiting a Cluster in a Workflow

When exiting a Final state in a cluster, the name of events on transitions can aid with the progression of the
workflow. If an event on a transition has the naming formula of 'cluster state ID.done’ the transition out of the Final
state with the cluster characteristic to the next state will be triggered automatically.

For example, in the picture below, the name of the event on the transition from End Inside Cluster (which has the
characteristic of a Final state) to 7th State is being named. Following the formula to trigger the transition
automatically, the name takes on the 2nd State cluster's ID followed by '.done'.
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_ ¥
= 2nd State

3rd State-Initial

|

4th State - S
E]TransitionE tar | & |

Edit

"]
%

U U

Sth State

| Mandagory Attributes
: I

e —

End Inside Cluster £ Add Event I‘-'E—E-J

Event | State-2.done

l oK H Cancel ]

Tth State
Show Edited Transition |

™
Endl Wark flow | [

IS

This is useful for clusters that have their last state in the cluster with the characteristic as Final state, such as the
one in the example. Normal functionality dictates that an object in a Final state would stay there until it is manually
taken out or there is special coding set up to take the object out of the workflow automatically. However, with this
naming system there is no need for a manual removal or special configurations to progress the object through the
workflow. This naming configuration allows the object to leave the Final state within the cluster, and also leave the
cluster state itself.

The system will always look for a transition out of a cluster that has an event name of 'Cluster ID.done'. If there is

not a transition found with this name, the system will look for a transition out of the cluster with no named event and
perform that transition.

If there are two or more transitions out of the cluster that all have either the 'Cluster ID.done' event name or no
named events, the system will randomly perform one of the transitions unless conditions on the transitions
determine which one to perform.

If there are only transitions with named events different from 'Cluster ID.done’ out of the cluster, objects will remain
in the Final state and can only be progressed by triggering events on the cluster state.

Note: Prefixing an event on a transition with the ID of the state from which the transition goes and a dot (.") will
cause the event to be hidden to users working with the workflow in the workbench. This approach should
therefore be used whenever you have a 'system' event that should not be triggerable by human users.
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The image below shows an alternate way of configuring a cluster and transition relationship. There is no Final
state inside the cluster. Instead there is a transition directly from End Inside Cluster to 7th State outside the cluster.

When this transition is performed, the object will exit both the End Inside Cluster state and the 2nd State cluster.
While this configuration is perfectly valid, generally the first type of state setup with a Final state and transition is
recommended.

L

= 2nd State

4th State

ath State

| End Inside Cluster
L
| Tth State

w

End Workflow

i
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Parallels in Workflows

Parallels

The Parallel characteristic is used for implementing two or more clusters simultaneously in the workflow. A Parallel
state will automatically get the cluster characteristic indicating that it can only contain clusters as its immediate sub-

states.

= Cluster = Cluster 2
.E] State Editor ﬁ
Edit

Deadline [Escalation I Comments
State | OnEntry | OnExit | Assignee

C Portal Screen Mapping I Mandatory Attributes
Stal

ID State-13

Mame |Parallel

- Characteristics
Initial

Final

Cluster

Parallel

Once the Final states of all the clusters that are immediate children of a parallel have been reached, the parallel is
automatically exited upon the next transition.

Exiting a Parallel

Transitions from parallels and Final states in clusters can be simultaneously and automatically triggered by using
the formula Parallel ID.done to name the event. This then allows the object in the workflow to move to the next
state outside of the parallel.

1. Inthe picture below, an object entering into the workflow would first enter into the parallel (as it is also the Initial
state), and into the Initial states inside of each cluster simultaneously.

2. The object would then proceed through both clusters simultaneously until the Final state for each cluster is
reached.

3. Once the object has reached the Final states in all clusters inside of the parallel, it then leaves the parallel and
all clusters at the same time and enters into the first state outside of the parallel.
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4. Ifthe event on the transition out of the parallel is named with the formula of Parallel ID.done (in this case State-
13.done), the object leaves both Final states in the clusters and the parallel at the same time, and automatically
goes to the Review State which is situated outside of the parallel state. If the event is unnamed, or named
without this formula, it would have to be manually moved to the Review State.

Note: When going through the workflow, it automatically will look for Parallel ID.done events first to be tried
and performed, but if none exist it will then look for transitions with no special named events.

Workflow 4 (Workflow4) &

Cluster 2

Cluster

State 2 Cluster State 2 Cluster 2

L 4

'\-I'
Final Cluster Final cluster 2

E] Transiticon Edita

Review State

f3] Add Event

Event |stgte-13.done

[ oK H Cancel

L -

5. The object then continues through State 2 and ends in Final.

6. While the object is finished going through the workflow, it will not leave the workflow unless coding is in place to
trigger it to leave, or the object is manually removed.

Note: Prefixing an event on a transition with the ID of the state from which the transition goes and a dot (.") will
cause the event to be hidden to users working with the workflow in the workbench. This approach should
therefore be used whenever you have a 'system' event that should not be triggerable by human users.

The image below shows an alternate way of configuring a parallel and transition relationship. There is a transition
from Initial Cluster out of the parallel straight to Review State. If this transition is performed, the entire parallel and
all its sub-states will be exited regardless of which state the object is in for Cluster 2.
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Note: Parallel States are used for modeling concurrency and should only have child states with the Cluster

Characteristic. Cluster and Parallel States do not typically represent human Tasks.
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Status Flags

Status flags are an aspect of tasks in a workflow that can be useful to group tasks, and are often used to indicate
tasks that need a higher priority or extra attention. For example, status flags can be used to signal tasks that have
been returned to a previous state, tasks that are considered critical or time-sensitive, tasks that have errors, etc.

When a status flag is applied, it is specific to the task-in-state, similar to an assignee. An assignee does not travel
with an object throughout the workflow, rather it is assigned at entry to each state, and upon exit from any state the
current assignee is not retained (unless business rules are set up to record this information). Furthermore, when
an object exits a workflow, there is no longer any assignee associated with it.

Status flags should be thought of in the same way as assignees. Configuring status flags requires the
understanding that they are specific to a task in a state, and therefore must be applied at entry to any state. In
addition, tasks in parallel states of a workflow may have different status flags applied in each state.

This section of the documentation describes how to configure status flags.

First, a place must be created to store the status flags, which is described in the Initial Setup for Status Flags
topic.

Second, status flags must be configured for the particular workflow(s) in which they should be used, which is
described in the Configuring Status Flags topic.
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Initial Setup for Status Flags in Workflows

In order to use status flags for workflows, a setup group that can hold status flag objects must be configured. This
only needs to be done once on any system and if already completed, this configuration is not required.

The required setup can be verified by skipping to step 3 below and checking if the option to create a status flag is
available from the setup group that houses workflows or any other setup group defined as a parent on the 'Status
flag type' defined in step 2 below. If you are able to create a status flag, then you may proceed directly to the
Configuring Status Flags in Workflows topic to add status flags to a particular workflow.

Prerequisites

The below configuration instructions require that a setup group has first been created for workflows. If the
Workflows setup group seen in step 3 below is not present, see the Initial Setup for Workflows topic to
configure it.

Configuration

1. Go to System Setup and select Object Types and Structures > Basic Object Types to find the object type
called Status Flags type.

System Setup

EI{E’ Object Types & Structures -
|'_=| Alternate Classifications

".;'J Assets

E}[ﬁ’ Basic Object Types

-2 Attribute Group

- Attribute Transformation
{7 Business Action Type

{E’ Business Condition Type

{72 Inbound Integration Endpoint”
EEI--%’ InDesign Document

%‘ Key

EEI--{E‘ List Of Values Group Type
{7 Match Code

{7 Matching Algorithm

{7 Reference-Type

- Setup Entity user-type root

r{ﬁ’ Status flag type |
%’ STEP Workflow Profile Type

2. Select the References tab, click the Add Parent link, select the Workflows node (or any other node where
status flags will be created) in the dialog that pops up, and click Select to close the dialog. The end result
should appear as below:
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@’ Setup Entity user-type root
@

@’ Asset Importer Configuration Type

-

Object Type Log
©- Objects of this Object Type
' Parents
18] Mame
» Workflows Workflows
| * | Add Parent

This allows status flags to be created under the selected setup group.

[T L] \anual LSl 1T MUiss

Eﬁ Inbound Integration Endpoints

: -[F5] Match Codes and Matching Algorithms

-[Z5] Outbound Integration Endpoints

(18] 5tatus Flags
-5 Web Uls
[+ Web Uls

Eﬁ Workflow Profiles

Mew Setup Group...
Mew Business Action
Mew Business Condition

Create STEP Workflow

[ STEP Workflow ” Bookmarks ]w

Create status flag I Ctrl+Shift+5
Start Background Process to Monitor Deadlines  Ctrl+5Shift+D
[+-{5m Keys Cut Ctrl+X
5 Event Copy Ctrl+C
Compa .
-5 Recyd Paste Ctrl+V
¥ Delete
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3. Tocreate a status flag, go to the selected setup group, right-click on it, and select Create status flag.

4. GiveitanID, name, and click Create. Upon creation, the status flag will appear under the selected node.
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Create as many status flags as are needed to support the workflows that require them.

Note: Any workflow using status flags will automatically have a default flag applied to each task. Therefore, it is
useful to create a standard or 'Normal' flag that can be applied as the default.

Status flags are global, meaning that once they are created, they can be used by any workflows in the system.
However, status flags are not available in any workflows until they have been applied to each workflow in which
they are needed. See Configuring Status Flags in Workflows for details on how to do this.
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Configuring Status Flags in Workflows

Status flags are global objects that must be applied to any workflow in which they should be used. Once the
needed status flags are created under the top node that houses them, they can then be associated to the desired
workflow.

This topic describes how to add status flags to workflows, and how to use business rules to set status flags on
tasks.

Prerequisites

Before status flags can be added to workflows, a setup group must first exist that can hold status flags, and at least
one status flag must have been created. For instructions on these processes, see Initial Setup for Status Flags
in Workflows.

In addition, it is important to understand that status flags are specific to a task in a particular state. More information
on this can be found in the introductory Status Flags topic.

Configuration

Use the following steps to enable status flags for a workflow.

1. Openthe STEP Workflow Designer of the workflow that needs status flags associated to it.

2. Double-click a blank area in the workflow frame, or right-click inside the workflow frame, and select Edit
Workflow to display the Workflow Editor dialog.

3. Select the Status Flags tab, and add any flags that are needed for the workflow. Note that a 'default status
flag' for the workflow must be selected.

Important: Any new tasks assigned to the workflow will be given the default status flag unless the workflow is
directed to do otherwise via business rules. Any existing tasks already in the workflow will also receive the
default status flag.

4. When finished, close the editor, and save your changes.
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[ 53 STEP Workfiow Designer - 11123 | = |
File Edit View
Workflow Properties = Workflow 5-“ 1123) ® -
1] 11123
Mame |Workflow 5 -rE] Workflow Editor
Workflow Variables/Attachments Edit
|assigne Status Flagy
Legal Status Flags
Validation errors: D » |Mame » |Default flag »
* Error Error [l
* Mormal Mormal if—
% * Critical Critical [l
o [ I * |A|:I|:I status flag I
Show Edited State

4

5. Aside from the default flag applied to all tasks in the workflow, status flags are not truly enabled until business
rules are created to apply them to tasks. Therefore, instructions for using business rules to apply status flags
are included below.

Using Business Rules to Set Status Flags in Workflows

While it is not required to use workflow variables in conjunction with status flags, it is often useful to create
workflow variables to be associated with each state in which a status flag should be applied. This allows for greater
flexibility in how and when status flags can be set. This is because status flags are somewhat like workflow
assignees in that they are specific to an object in a given state, and cannot be set in advance. Just as you cannot
assign a task to a user until it enters the applicable state, you also cannot bind a status flag to an object's presence
in a workflow until it enters the state. As it is often something from a previous state that determines what the status
of the object is in a subsequent state, workflow variables can be used to capture and store what the flag should be,
which can then be set on entry to the appropriate state.

The below instructions describe how to set a status flag based on a transition being taken. For example, a task that
has been rejected may need to be marked as 'Critical' as it is now spending additional time in the workflow. This is
not the only way to work with status flags, but serves merely as one example of one common use case. Rather
than using a transition to determine the status flag for a task, any data could be used, such as an attribute value,
reference value, presence or absence of particular data, etc. The options for setting status flags are limited only to
what can be done within business rules.
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However, the options for end users viewing and accessing status flags are limited by the interface in which they
access workflows. If workflows are accessed in Web Ul, it is not required that status flags be stored in workflow
variables. However, if end users will interact with the workflow only in the STEP Workbench, status flag
assignments must be stored in workflow variables as that is the only way to make them visible to the end user.

Use a Workflow Variable to Capture a Status and Apply a Status Flag

The below instructions walk through an example of how to capture a desired status flag based on a particular
transition being taken, store the information in a workflow variable, and subsequently apply the desired status flag
at entry to a subsequent state.

1. Create a workflow variable to hold the status flag using the @ button. As status flags are state-specific, it is

recommended to create one workflow variable for each state in the workflow that will have a status flag
determined by some factor other than entering the state, so that when the determining factor is evaluated, the
resulting flag to be applied at any given state can be stored for that state.

E] STEP Workflow Designer - SampleWorlflow3state

File| Edit View
Waorkflow Properties =

1D SampleWorkflow3state

Mame |Sample Workflow (3 states) Start (1)

Workflow Variables/Attachments

[ ; Proceed Reject
StatusFlagDoWark abi; )
'StatusFlagFinish’ abe Do Wark (&) |
'StatusFlagStart’ abe

Progeed

B (9

Validation errors:

Finish

Df

For additional information on workflow variables, see the Workflow Variables section of the documentation.

2. For this example, when a task is rejected, we want to apply a Critical status flag so that users know to quickly
process the task in the Start state. Therefore, we need a business rule to record that the Reject transition has
been taken and store that information. As we want the task to then have a Critical status in the Start state, we
will store the information in the StatusFlag_Start workflow variable.

Right-click on the transition that should be recorded, select Edit Transition, click on the On Transition tab,
and click the Add new Business Action link.
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F‘ruc‘éxe Réﬂﬂ X
.
] E] Transiticn Editor @
Do Wiark (&) Edit

Progeed Euentslt:nndiﬁ;n On Transition i‘landatory Attribute 4

Finish
Mame
Description
Type Action
Scope Maone

Run as privileged [

Operations Dependencies|Applies if

¥ Business Rule E] E *

4 1)

Add new Business Action

Show Edited Transition

3. Click on the Edit icon button that appears under the Operations tab. This will bring up the Edit Operation

dialog. Select the Execute JavaScript dropdown option.
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Eﬂ Transition Editar @
Edit
el O Tarton oy piutane] . [
Business Rule | saved with workflow) ||Z| E’ H . .
Mame | |

B

Description | |

Type Action
Scope Local
Fun as privileged i

Operations |Dependen|
Enacme]av |

erge into Binds:
'l.n'arlable name ¥ |Binds to

Add new Business |

[ Messages:
'u'ariable name * [Message * [Tr

JavaScript: | 1

&
Edit externally
] 1 3

| Save || Test JavaScript || Cancel

4. Under Binds, click the Edit Binds button, and then click the Add Bind button.

E! Edit Operation @

| Execute JavaSoipt ;]

Binds: § Binds
Variable name > |Bir1ds to > |

L1 ][]

Variable name Binds to Parameters

Ja“ﬂe Add Bind I!EI
N

_______ [ox | [coneel | |—
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5. For this example, we need to bind to both current object and current workflow. Input variable names and select
the appropriate binds, as shown below. Click OK to close the Edit Binds dialog when complete.

£ Edit Binds [==]
Variable name Binds to Parameters
node |Current Ohject v| @
wf |Current Workflow v| @
Add Bind

[ oK ][ Cancel

6. Inthe JavaScript field type in the appropriate JavaScript formula. An example is provided below that will set the
value of the workflow variable 'StatusFlag_Start' to 'Critical'. Keep in mind that what is written in the
parentheses is driven by the variable name that was written in the bind, the workflow variable created to hold
the status flag value, and the ID of the status flag that is to be assigned.

var inst;
inst = node.getWorkflowInstance (wf);

inst.setSimpleVariable ('StatusFlagStart', 'Critical');

P

E] Edit Operation @

r [ Exeoute JavaSoipt. =
Binds: § Binds
ariable name * |Binds to
node Current Object
wf Current Workflow

&

Messages: § Messages

ariable name » |Message * Translations

b3

JavaScript: | 1 l.rar £ e -
Z inat = node.getlorkflowInstance (w) ;

3 inst.zetlinmpleVarighle ('StatusFlagsitart' , 'Criticasl'):
Edit externally
4 | 1} 3

Save Test JavaScript Cancel

Click Save in the Edit Operation dialog when finished, and close the Transition Editor using the X button in the
upper right corner.
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7. Atthis point we have only stored what the status flag should be, but have not applied the status flag to any task.
To do that, a rule must be added to the state in which the flag should be assigned.

Right-click on the state and select Edit State. Click on the On Entry tab, and click the Add new Business
Action link.

5]

£ State Editor 53
Proceed .
, Edit
Y
[ Do Wark Commegts l b UI Screen Mapping I Mandatory Attributes
State On Entry | On Exit I Assignes | Deadline [Escalation

Proces!  Bysiness Rule (Local business rule to be saved with workf...| |8l
v
Finigh| Mame

Description
Type Action
Scope Loca

Run as privileged [

DPEfaﬁﬂﬂ5|Dependencies|Applies if

- |Add new Business Action |

[ Show Edited State

8. Repeat steps 3 - 5 to edit the rule and add the Current Object and Current Workflow binds.

9. Enter the appropriate JavaScript formula. An example is provided below that will take the value of the

previously stored workflow variable and apply it to the task entering the state.
var inst;

var task;

inst = node.getWorkflowInstance (wf);

task = inst.getTaskByID('Start');

if (inst.getSimpleVariable ('StatusFlagStart')) {

task.setStatusFlagByID(inst.getSimpleVariable ('StatusFlagStart'));
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E] Edit Operation @
~ [Execute JavaSaipt ¥
Binds: @ Binds
Variable name » [Binds to
wf Current Workflow
node Current Object

&

Messages: 7 Messages

\ariable name » |Message » Translations

&

JavaScript: var inst:

rar task:

inst = node.getWorkflowInstance (wL) ;

task = inst.getTaskEvyID('ZStart'):;

if (inst.get3impleVariable ('3tatusFlagitart') )4
task.setitatusFlagEvIDinst.get3impleVariable (' 3tatusFlagitart' ) ) ;

=1 M s L M

'

Edit externally

oo

Save Test JavaScript Cancel

Click Save in the Edit Operation dialog when finished, and close the State Editor using the X button in the
upper right corner.

At this point, rules have been created to capture the desired value for a status flag, and to set it upon entryto a
state. However, in order to make the status flag available for end users to view when working with tasks, additional
steps must be taken.

« Ifthe user will interact with tasks in the workbench, the workbench view must be configured to include the
workflow variable holding the status flag value. Additional information on configuring views is available in the
Views and Mappings for Workflows topic in the Getting Started with STEP Workflows documentation.

« Ifusers will interact with workflows in Web Ul, the appropriate status flag components must be added to the
screen. Additional information on working with status flags in Web Ul is available in the Status Flags in Web
Ul topic in the Web User Interfaces documentation.
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Triggering Workflow Events from Imports

If a workflow is valid for either products, classifications, assets, or entities, it is possible to configure the workflow to
automatically trigger certain transitions if an object in the workflow has an attribute value changed in an import as
long as the event on the transition has the ID of 'sibo.import'. This is helpful in that a user does not have to recheck
any existing items that are already in the desired workflow, nor do they have to take the objects out to be updated,
only to put them back into the workflow again. Instead, the objects already initiated into the workflow will be
updated and then be triggered to move to the next sate, if the event on the transition has the proper ID.

For example, a user has Object A in their desired workflow in the Initial state. The Initial state has an event on the
transition coming out of it with the ID of 'stibo.import' going to State 2. The user updates and imports objects, one
of which is Object A. Due to the setup of the Initial state, Object A is updated, and an event is triggered moving
Object A to State 2.

Condition for Triggering Workflow Events from Imports

To turn on this functionality for a workflow, select the desired workflow in System Setup and check the Listen on
updates from import checkbox on the STEP Workflow Editor tab.

 tep Workiow Eitor | QP R Ty

Mame »| > |Value
»> 1D 11123
» Mame Shipment Order Process
» Revision 0.82 Last edited by USERL on Thu May 26 15:45:15 EDT 2016
» [Initiate automatically [l
» Listen on updates from import
» Use executing user's write privileges E} \ - - -

Activate STEP Workflow whenever an import updates an itemn in the STEP Worldlow

» Disable transitions on terminated Workspaces

» Gtart Condition

Make sure that any events that should occur have the proper ID. Again, the Import Manager can only trigger
events with the ID "stibo.import". Thus to have a transition performed for an object in a workflow when it is
changed in an import, the object must be in a state out of which there is a transition with the Event "stibo.import"
(the "stibo.import" event will not be visible in the STEP Workflow Items editor or on the Object Tasks tab).

Note: Itis important to notice that only changes to attribute values (add, modify, remove) will trigger the
"stibo.import" event. Thus, changing a reference, re-parenting an object or similar will not cause the event.

The image below shows a simple workflow with the functionality turned on.
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First |

stibo import

L
Second () |

To_The_End

The_End

U{

The "stibo.import" event is on the transition from the First state to the Second state and thus, if an objectis in the
First state and an attribute value is changed in an import, the transition will be performed.

When working with events generated by imports, there is a special reserved variable named "modifiedAttributes”
available in JavaScript. This variable will hold a list of IDs of the attributes changed in the import. In looking at the
example above, the variable will be available when leaving the 'First' state (On Exit), on the transition (On
Transition + Condition) and when entering the state to which the transition goes (On Entry on the Second state).

Using this reserved variable a user could for instance add a condition on the transition only allowing the transition if
a specific attribute has been changed and has a value after the import. This could be done with a script as follows:

var attChanged = false;
var modArray = modifiedAttributes.toArray();
for(var 1 = 0; i1 < modArray.length; i++) {
if (modArray[i] == "ID of Attribute") {
attChanged = true;

break;

}
if (attChanged && node.getValue ("ID of Attribute") .getSimplevValue()) {

condition = true;

else {
condition = false;
}

It is optional for users running imports whether or not the import potentially should trigger events. Thus for column
based imports, in the Import Manger on the Advanced Settings page, the checkbox "Trigger STEP Workflow
import events on ltem Updates' controls whether or not events should be triggered.
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E! Import Manager @

Steps Advanced Settings

1. Select Configuration Context .English us ~
2. Select Data Source :
Import Process Template: Importer
3. Select Format i
4, Map Data Match Units By ‘Mame
5, Identify Objects Approve Import Changes [l
6. Identify Destination Auto-Initiate STEP Workflows on Item Creation =
7. Select Business Rules

Trigger STEP Workflow import events on Item Updates [

8. Advanced Settings

Suppress Re-Translations
Auto select Import Mode @
Force Database Import

Force Domain Import

Remowve Options rRemove Un-Mapped Values
Attribute Group >

* | Select Attribute Group(s)

rRemove Un-Mapped References
[7] Classification References

Back Mext | [ Finish |[ Cancel

In XML, the functionality is enabled / disabled using the STEPProductinformation tag attribute
"STEPWorkflowImportEvent" that can be setto "Y" or "N".

Since it is optional for users whether events should be triggered, the functionality is typically used in imports based
on pre-configured import configurations. A use case could be one where an object is in a state waiting for data to
arrive from an external system via an Inbound Integration Endpoint.

Note: Itis only possible to trigger events from imports when running in Domain mode.
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Validate Data in a Workflow

Itis common for workflows to require some basic data validation to ensure that quality standards are met for the
provided data. Data validation can be easily accomplished in a workflow by applying conditions on transitions.

Business conditions will always evaluate to either true or false. In workflows they can be applied on transitions,
and thus determine whether or not a transition can be performed. If a condition evaluates to true, the task may take
the transition. If a condition evaluates to false, the task cannot take the transition and must attempt another
transition or remain in the state until the data has been corrected and the condition evaluates to true.

When using conditions for basic data validation, the transitions are generally applied on user-accessed states, so
that the user sees an error when attempting to submit via a particular transition if the data does not validate. Note
that conditions should not be used to validate that mandatory attributes are populated as that can be done using
the built-in mandatory attribute functionality, described in the Mandatory Attributes and References in
Workflows topic.

Data validation can be carried out using any number of functions and/or JavaScript. Additional information on
more advanced topics can be found in the Business Rules section of the documentation. The below provides a
simple example of data validation using the attribute value comparison function.

The below example will check to ensure that an attribute, List Price, has a value greater than or equal to .99. It
assumes that a workflow has already been created and a transition exists on which the condition can be added.

1. Double-click on the transition, select the Condition tab, then click the Add new Business Condition link.

Start (1)
Proceed Reject
Do Wiork (&)

Proseed E] Transition Editor @

: Edit
Finish ™.
|E'uer1tE Condition I]n Transition|Mandatory .ﬁ.th'ibutesl
Business Rule D h | @J @J

{

Mame

Description

Type Condition
Scope Mone

Run as privieged [

Operations|Dependencies|Applies if

lAdd new Business Condition |

l Show Edited Transition I
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Mame

Description
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Scope Local

Run as privileged [

UPEFEﬁDHS|Dependendeslnpplies if
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2. Click the Edit Operation icon, select Attribute Value Comparison from the dropdown.

Mrue if value for Attribute ™ “null”

(=]
E Edit Operation @
I- Attribute Vzhe ; 'I
| [ [ =] 11

Add new Business Condition

[ Show Edited Transition

[ Save H Cancel

3. Click the ellipsis button ([...)) to select an attribute. Choose an operator from the dropdown, insert a value for

comparison, and click Save.

-

E] Edit Operation

[[Atmibute Vahe Comparison

R

List Price (ListPrice)

(-]

= w

.39

[ Save H Cancel ]

5]

4. Click the [X] in the upper right corner of the Transition Editor to close it, then save and exit the workflow.
Users attempting to submit a task that does not meet the condition will receive an error.
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proceed |[_subme_|

Bewocra =

Value for "List Price™ .50 §" is not greater than or equal =93 *

==

Note that by default, the condition also checks for the presence of a value, returning false when no value is
present.

L !

E] Error Occurred @

Value for "List Price™ “[no walue] ™ is not greater than or equal =99

Lo ]
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Workflow Variables

When working with Workflows there are two different types of variables available of which one comes in two
variants:

JavaScript Variables - Normal JavaScript variables can be declared in business actions and conditions. The
scope of these variables is limited to the action / condition where they are declared and they are only persisted
during the execution of the action / condition.

Workflow Variables - Workflow variables are string variables defined in the Workflow Designer. The variables
are global to the workflow instance and the values are stored on the object-in-workflow relation and thus persisted
as long as this relation remains. Workflow variables come in two flavors, 'bound’ and 'unbound'.

Bound Workflow Variables

A bound workflow variable is bound to a STEP Attribute and gets its validation from the STEP Attribute. Apart
from getting the validation from a STEP Attribute, bound workflow variables also get the corresponding attribute
editors when a user chooses to display them in workbench views (see the Views and Mappings for Workflows
section of the Workflows documentation).

Note: The attributes to bind to must be externally maintained, non-dimension dependent description attributes
and should not be valid for any object types.

Unbound Workflow Variables

When a workflow variable is not bound to an attribute, it is a simple string variable with a default workbench view
editor.

The value of unbound variables can be the result of an expression. In the expression panel, a reserved variable
named 'value' is used. Below a script / expression is shown that will set the value of the variable to be the ID of the
current node. Expressions are re-calculated each time the variable is used.

value = node.getID();

Creating a Workflow Variable

To create a workflow variable press the add icon and select Add Workflow Variable in the 'Workflow
Variables/Attachments' section in the left side of the Designer.
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[

£+ STEP Workflow Designer - 11123

File Edit View
Workflow Properties =]

D 11123
Mame |Shipment Order Process

Workflow Variables/Attachments

T T TR T T

'statusFlag1’ abe
'statusFlag? abe:
'statusFlag3 abe ||
"Who approved? abe 7
"'Who last edited? abe:
'Workflow Attachment’ 8| -

E\ [ [%eml
F\ Add Waorkflow Attachment

’7_ Add Workflow Variable

This will bring up a dialog where the user can enter the ID of the variable and optionally select to bind it to an
'Attribute’ or add an 'Expression'.

£53 Add Workflow Variable [
1D My Variable
Attribute ()
Expression
[ OK ] [ Cancel

As noted in the Business Rules in Workflows section in the Workflows documentation, workflow variables are
manipulated through the WorkflowInstance interface. Thus the value of a workflow variable can be obtained from
a business action as follows:

var valueStoredInVariable = node.getWorkflowInstance
(workflow) .getSimpleVariable ("Variable ID");

And likewise a simple value for a workflow variable could be set with:

node.getWorkflowInstance (workflow) .setSimpleVariable ("Variable ID",
"Value to be set");
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While the above applies to both bound and unbound variables, for bound variables a value object can be obtained.
This can be done with:

var valueObj = node.getWorkflowInstance (workflow) .getValue ("ID of
Attribute the variable is bound to");

Workflow Variables in Use

Consider a user group which consists of 5 users. All of these 5 users have access to a particular workflow, and can
submit a product from the Edit to the Review state. For this workflow, because there is a requirement to identify
which of these 5 users submitted a particular product, a business rule has been set up to save the details to an
attribute. This business action is set on the desired state in the State Editor on the 'On Exit' tab. In this case itis on
the Edit sate.

8 =

E] STEP Worlflow Designer - Business_Action @
File Edit View
i ] i 1= _ - . -
Workfiow Properties = Business_Action (Business_Action) (&) i
D Business_Action
: : Start @
Mame |Business_Action
Waorkflow Variables/Attachments Submit
'assinge’ abe ¥
Edlit (KGR
'Released_by' abe C DO

Feject
Subimit

Rewview

BEE s

Validation errors: i

ﬂ

m

To create this business rule, a workflow variable first needs to be defined, which is 'Released by' for this workflow.
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£+ STEP Workflow Designer - Business_Action
File Edit View
Waorkflow Properties =

D Business_Action

Mame |Business_Action

Warkflow Variables/Attachments

assinge’ abe

Released_by' abe:

Validation errors:

Then a business rule needs to be written to call the workflow variable as mentioned below:

var assigneelID = step.getCurrentUser ().getID();

node.getWorkflowInstance (workflow) .setSimpleVariable ("Variable ID",
assigneelD) ;

Note: In this formula, "Variable ID" should be replaced with the ID of the actual workflow variable for the workflow
in use.

E! State Editor @
Edit
Deadline lation | Comments | Web UL Screen Mapping I Mandatory Attributes
State [ On Entry | On Exit | Assignee
BusinessRule | (acn-03948 1e-3718-4253-af70-32ede 7eB93c4) - [ [Bel [ [
Name E] Edit Operation IEI
Description [ [Exeomte JavaSaipt ¥
Binds: § Binds

T
SYDE Variable name > [Binds to >

o)

pe node Current Object
Run as privileged
privieg workflow Current Workflow
Operations | Dep| step STEP Manager

JavaScripty @

Messages: 7 Messages

Javascripty |Variable name > [Message » [Translations >

\.nga.SCfipt: 1 var assigneelID = step.getCurrentlUser () .getID();

2 node.getWorkflowInstance (workflow) .set3impleVariable ("Released by", assigneell):

Edit externally

Save Test JavaScript Cancel
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With this business action in place, when a product is submitted, the business rule is executed and the user ID of
the user who submitted the product is stored. This is visible in the STEP Workflow Items tab if this was mapped in
the views and mappings View Editor.

STEP Workflow STEP Workflow Items o al

Profile Category Profile || Proof View || Status || State Log || Tashks

= Asset Update ~ Referenced By Images & Documents " Commercial " Tables

@ Business_Action STEP Workflow Items [ Product " Sub Products ” References

=l I Mens T PEO »

D * MT 13400

Filter by Collection Q
Mame * Mens T PBO

Start 2 -

Edit 0 Assigned To * fGroup : User Group

Review 1 Assignes > ﬂf]

Done 4 Deadline >

L

USER23

P —— Released by

For more on setting up views and mappings, see the Views and Mapping for Workflows topic in the
Workflows documentation.

Workflow Variables in Web Ul

Workflow variables are also supported in Web Ul, where they can be added to relevant components using the
Workflow Variable or Workflow Variable Header components. In addition, workflow variables can be added to
submit actions (Submit Action or Submit from Grid Action).
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Web Services for SOAP Requests for Workflows

Complete documentation for Web Services functionality related to workflows can be found in the STEP API
documentation at [system]/sdk or by clicking the STEP APl Documentation button on the STEP Start Page.
This topic provides some basic information and an example of a simple SOAP request, but should not be
considered comprehensive.

The STEP Web Services API contains the following methods related to STEP Workflows:
startWorkflow - Method for starting a Workflow on an Object

triggerWorkflowEvent - Method for triggering a Workflow Event for an Object in a State in a Workflow
deleteWorkflowlnstance - Method for removing an Object from a Workflow. |.e., deleting the instance.

getTasks - Method for retrieving info about which States an Object is in in specified Workflow. For each State
apart from the ID, a STEP url for the Assignee and the time of entering the State will be returned.

initiateltemInStateflow - Legacy version of startWorkflow
triggerStateflowEvent - Legacy version of triggerWorkflowEvent
removeltemFromStateflow - Legacy version of deleteWorkflowlInstance

getltemStatelnfo - Legacy version of getTasks

An example using startWorkflow is below:

<soapenv:Envelope
xmlns:soapeny="http://schemas.xmlsoap.org/soap/envelope/"

xmlns:ns="http://stibo.com/step/ws/step/1.0"
xmlns:nsl="http://stibo.com/step/ws/types/1.0">
<soapenv:Header/>
<soapenv:Body>
<ns:startWorkflowRequest>
<ns:accessContext>
<nsl:userName>[Username]</nsl:userName>
<nsl:password>[Password]</nsl:password>
<!--Optional:-->
<nsl:passwordType></nsl:passwordType>
<!--Optional:-->

<nsl:contextUrl>step://context?id=[Context
ID]</nsl:contextUrl>

<!--Optional:-->
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<nsl:workspaceUrl>step://workspace?id=[Workspace
ID]</nsl:workspaceUrl>

</ns:accessContext>
<ns:nodeURL>step://product?[Node ID]</ns:nodeURL>
<ns:WorkflowID>[Workflow ID]</ns:WorkflowID>
<!--Optional:-->
<ns:message>[Message]</ns:message>
</ns:startWorkflowRequest>
</soapenv:Body>

</soapenv:Envelope>
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Workflow Attachments

While not the only reason, "Workflow Attachments' are typically used for holding files that are necessary for users
handling tasks in states. This could be written instructions, images, data sheets etc. Once the attachmentis in
place, when a user receives or gets a specific task(s), they can access the attachment and follow the specified
instructions / guidelines.

Using workflow attachments a user can attach files to workflow instances. Also, like the workflow variables,
workflow attachments are global to the workflow instance.

Note: Users should be familiar with the navigation to the STEP Workflow Designer and defining the views and
mappings. See Creating a Workflow in the Workflows documentation for more on the workflow designer. Also,
see Views and Mappings for Workflows in the Workflows documentation for additional information on view
and mapping.

Workflow Attachment Configurations

As described in the Configuring Views for Workflows section in the Workflows documentation, the
'WorkflowAttachment' component allows Users to add, open, download and delete workflow attachments through
views.

Attachments are defined in the left pane of the Workflow Designer. To add a workflow attachment:

1. Click on the 'Add Workflow Variables/Attachments' icon, @J and select the option Add Workflow
Attachment.

2. Inthe dialog that appears, enter the ID and click OK.

P

£1 Add Workflow Attachment  [wm]

D |Workflow Attachment

[] Multivalued

I 0K |l Cancel

If multiple attachments are required then check the option for 'Multivalued'.

Note: If a user needs to edit or delete a workflow attachment added in this section, they can click on the edit icon,

@J , or they can click on the remove icon, , to make any necessary changes.
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3. Nextgoto Edit> Edit Workbench Views and Mappings.
4. Inthe View Editor, right-click the view that needs an attachment added to it, and select Add Column >

Component.

F+1 View Editor
Edit

Editar [xm

=

E

g
- view

..... E Mapping :
..... E Mapping :
..... E Mapping :
..... E Mapping :

EI__ I'I'Iewu Trmidi=l Mt I My

EEI-- View: Confirm data
& view: End State

Y

Add Column * Attribute

ID |Initial Data
Attribute Group
Move Down con |1
Aspect
Sort Columns Automatically
Delete Component O

Initiate Data-=Initial Data
Review Data-=R.eview Data
Confirm data-Confirm data
End State-=End State

WL I

5. Under the Component dropdown, select 'Workflow Attachment'. Once selected a dropdown to add an
'Attachment’ will appear. Select the attachment that was just created in step 2. For this example it is called
'Workflow Attachment.'

P

£+1 View Editor
Edit

-

==

..... E Mapp"-lg

..... E Mapp"-lg

=& view: Initial Data Component
Elg Column:Chject (WorkflowLinkedMame) Title
- B Column:Who Approved? (WorkflowVariable)
-.[]T Attribute: Date ("] Read Only
B Column:Workflow Deadiine (WorkflowDeadline)
... & Column:

- View: Review Data Component | WorkflowAttachment
#-& View: Confirm data : 3
=) View: End State ttachment | 4

» Initiate Data-=Initial Data
: Review Data->Review Data Workflow Attachment

----- E Mapping :
----- E Mapping :

[ Mandatory

Confirm data-=Confirm data
End State-=End State

I I

6. Enter atitle and then decide if either 'Read Only', or 'Mandatory' need to be checked before exiting the View
Editor and hitting 'Save and Exit' in the STEP Workflow Designer. Note that neither one of these has to be
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checked. If 'Read Only' is left unchecked then a user can download the attachment and upload files. These files
will be attached to the workflow instance.

Component Returned Value

Read Only If marked as this the add and delete options will be disabled, but users will still be able to open
and download attachments. However, any uploaded files will not be stored in the STEP
database. Instead, they will live in the application server file system in a path specified via the
configuration property 'Install. STEPWorkflowArea'.

Mandatory Tell the user that the attachment is required information.

Attaching a File in a Workflow

Now that the configurations are in place, the steps below show a user how to attach and remove afile.

1. Navigate to the STEP Workflow tab, select the desired workflow, and click on the corresponding state that the
workflow attachment was mapped to in the above steps.
2. Inthe STEP Workflow Items tab, click the ellipsis button (E]) next to the desired product and select the file from
the system that is to be attached.
STEP Workflow STEP Workflow Ttems
Profile Products || References || Referenced By
@ Pen W ._...I flow Two - Object > [Who Approved? * [Date > [Workflow Deadline » |Attachment 1 >|
' Shipment Order Process » Blue and Purple Flashlight [28-apr-2016 P E]
- * Flashlight Bulbs 1 (SPO) Mser L 03-may-2016 [
¥ B D D _|]|> Fiashlight Bulbs 2 (SFO) User 5 07-may-2016 E]
Filter by Collection E] > Fiashiight Bubs 3 (SPO) User2 D39un-2016 E]
M" 7 > Flashlight Bulbs 4 (SPQ) 03-mar-2016 [
zjzﬁ"iwm:: i > Flashlight Bulbs 5 (SP0)  Wser L D5-apr-2016 =]
End State 0 > fray Hat [
. = || * Industrial Hard Hat E]
Omu > Silver Flashlight 28-apr-2016 [
o > bkiHat
@ m:; > Fld Helmet E]
@ Warkflow3
——
E:F-ﬂe Products || References || Referenced By
Ready &= pen Workflow Two i Object > [Who Approved? »> |Date > [Workflow Deadline >Yattachment 1
¢ shipment Order Process > Blue and Purple Flashlight 23-3ug-2016
o B D D > Flashlight Bulbs 1 (SPO) User L 03-may-2016
Filter by Collection || * Flashlight Bulbs 2 (SPO) Wser 5 07-may-2016
Initiate Data 17 > Flashlight Bulbs 3 (SPO) User2 03-jun-2016
Review Data 5 > Flashlight Bulbs 4 (SPO) 03-mar-2016
Confirm data o > Flashlight Bulbs 5 (SP0) ~ Mserl 05-apr-2016
End State 0 > [Gray Hat
@ Workflow = > Industrial Hard Hat
- User Web UL Workflow > ilver Flashlight (28-apr-2016
@ WF_Logic > bkiHat ol 0 skiHat.dsx
@ WF1 > Fki Helmet
@ Workflow3
@ Workflow L
: - proceed 1+ [ sumit_|
Ready -=ntil
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3. Double click on the attachment to open it.

STEP Workflow Items [ Products ” References " Referenced By

- Object > Who Approved? * |Date > Workflow Deadline > |attachment 1 »

» Silver Flashlight 28-apr-2015 M. ()

» 5k Hat ﬁ 8 SkiHat xlsx E]

» 5ki Helmet E
|D|:|u|::||n.=-_-c|ickt|:| open attachment

:Pru::eed i v: Submit

1

4. Toremove the attachment, click on the red 'x' button, E]

It is worth noting that workflow attachments are instance specific, and values will be deleted together with the
instance.

In the public API you can obtain a "WorkflowAttachment' object through the "WorkflowInstance' interface via

'WorkflowlInstance.getAttachmentByID'("Attachment ID") and have various methods available on the returned
object.

Note: The files referenced by attachments are stored on the application server in the directory pointed to by

config property "Instal. STEPWorkflowArea". If you are on a clustered environment, the directory should be on a
shared drive. Workflow attachments are not stored as assets in STEP.
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